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Introduction 

Warrior software Release 8.0 is a third-generation 64 / 32-bit Unicode program. The Warrior software is a 
mature logging environment that stresses ease of use, wide versatility, with a true multi-tasking environment. 
This software can also be used from a desktop to replay, recalculate and print logs from the raw data or 
imported data from other systems such as LAS or LIS data. The Warrior software runs on Windows Operating 
Systems (Currently Windows 7 32 bit or 64 bit or Windows 8 64 bit). Operators need to be familiar with 
Windows and logging.  
 
The Warrior Tool Interface and Power Supply Panel is a new generation logging system. This system utilizes 
the USB Bus (Universal Serial Bus) along with DSP (Digital Signal Processor) technology providing the latest 
signal recovery technology available. This allows the PC to be upgraded independently as newer and faster 
PC's become available. Systems can be configured based on the services required at each site. The operator 
interface remains the same for each configuration, allowing the same look and feel for the operators. 
 
The Warrior Well Logging System consists of a Tool Interface and Power Supply Panel, a computer, a printer 
and optional depth, line speed, line weight panel, and perforating power supply. The tool interface panel 
contains the necessary circuits to interface to most cased hole tools, both analog and digital. The depth 
encoder and line weight interfaces are built into the panel, as is the down hole tool power supply. All functions 
are digitally controlled from the software, with the power supply having a manual control mode. The panel 
incorporates data acquisition functions that interface to the host computer through the industry standard 
Universal Serial Bus (USB). A USB hub is also incorporated inside the panel allowing a single cable 
connection to the host computer. A second monitor may usually be attached to provide a Hoistman's or 
client's display. The system supports most thermal well log plotters and a selection of color printers. 
 
An optional depth, line speed and line weight panel is available. This panel provides independent depth and 
tension measurements when powered from 12 VDC. It connects to the host computer through the USB and 
can be synchronized from the host depth or the host depth may be read from the depth panel.  
 
The Probe Shooting Panel supplied by Scientific Data Systems can be set up with an option USBAUX board 
that allows computer control of the firing circuits so that firing is only allowed at a specified depth. 
 
The Warrior logging system currently consists of the following components: 
Computer – Laptop/Desktop – with monitor, keyboard, and mouse 
Tool Interface and Power Supply (CP/PA/OP/SLAB) 
Plotter (for hard copies) 
Shooting Panel (optional) 
Depth, Line Speed and Line Tension Panel (optional) 
UPS (optional) 
 
It is strongly suggested that the CPU and interface panel be run from an UPS with a capacity of approximately 
1000 VA. Do not attempt to use an on-line type UPS with diesel generators unless the manufacturer 
specifically states that the product is suitable for this application. The switching type UPS seem to work well. 
Loss of data is guarded against by periodic update of the data base files, however, the use of a UPS allows 
the system to be shut down in an orderly manner and may also condition the line power to the system, thus 
eliminating problems due to a noisy power source. 

 This software uses the FreeImage open source image library. See http://freeimage.sourceforge.net for 
details. 

FreeImage is used under the FreeImage Public License, version 1.0  

http://freeimage.sourceforge.net/


  



1 Warrior Software Installation 

1.1 Distribution Media 

The Warrior Data Acquisition Software version 8.0 (XXXXXX) or latest is distributed on one DVD. A  USB 
drive is installed in the panel that contains the distribution software and required licenses for Warrior 8.0 
Software. The software is also downloadable in the form of a single executable file from the web site 
http://www.warriorsystem.com/ under DOWNLOADS. This file should be saved to a temporary directory and 
then run to expand the software into an installation folder.  It also starts the installation process. 
 
It is a fact of life that every computer system will, sooner or later; suffer a failure, such as a disk crash, where 
there is the potential for loss of programs and/or data. This will generally happen at the most inconvenient 
time. The importance of keeping current backups cannot be overemphasized. It is vital that the time be taken 
to keep current backups of all essential programs and data.  
 
All Warrior systems from Scientific Data Systems are shipped with some type of mass storage device, 
(usually a DVD-R/W drive) which can be used for backing up programs and data. The procedure for using 
CD drives varies with the software supplied. Become familiar with the specific software by reading the manual 
or select 'Help' after starting the program. It may be useful to purchase an off the self-CD program to 
standardize all systems.  
 

All files copied from a CD to a hard drive are often written as read only. Some files used 
by the Warrior software will not function properly as read only. To change the attribute, 
use Windows Explorer select the copied files, right click on the files and select properties, 
uncheck the 'Read Only' Attribute and click the apply button.  

 
The warrior system is usually configured for the selection of services to be run by a given client. This 
information is primarily contained in three files, Warrior.ini, Services.ini, and Tools.ini. The Warrior Backup 
utility can do a configuration backup or restore. Most of the user editable files are included in a Configurations 
Backup. A configuration restore can then be done on the computer or a new computer with Warrior software 
installed. In addition, the three primary files are automatically backed up every time the Warrior system is 
used and can be restored from Warrior Backup. See section 8 for a complete discussion of the Warrior 
Backup Utility. 
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1.2 New Installation of Warrior Software.  

Before the installation of the Warrior software we recommend updating the Windows operating system 
through the Internet connection. 
 

Restart the computer and turn OFF the Interface Panel Power supply.  
Do NOT connect the Warrior Interface Panel to the computer via a USB cable before 
installing the Warrior 8.0 Software. This could cause problems in the later installation of 
hardware drivers. 

 
 
The Warrior Data Acquisition Software DVDs are set up to be self-loading on most Windows Operating 
System computers. The Operating system must be any version of Windows 7 32-bit or 64 bit. After a fresh 
restart of the computer, open the CD tray, insert the Warrior Software DVD, and close the tray. The Windows 
Operating System will look for an autorun.inf file on the CD to start the loading procedure. The interactive 
menu shown in figure 1.2.2 should appear. Be sure that the CD player has stopped operating before 
assuming that the autorun file did not execute. There are several reasons that the autorun file may not 
execute. The two most like causes are the operating system may have autorun capability shut off or existing 
software on the computer may not allow software to run directly from the CD. Solutions for these problems 
will be discussed later.  
 
 

 
 
FIG: 1.2.1 CD Start Detected 

 

 
 



 
FIG: 1.2. 2 Interactive Menu 

 
 
 
From the Interactive Menu, click on the Warrior 8 software installation that you wish to perform. The software 
will then do a preload to prepare for installation. 
 



 
FIG: 1.2.3 

 
The Install Shield Wizard will begin. Click on the [Next] button. 
 

 
FIG: 1.2.4 InstallSheild Wizard 

 



 
The folder for installing system files is then shown. The [Browse] button can be used to select an alternate 
folder in which to install the files. It is highly recommended that the default folder be used. Click the [Next>] 
button to continue. 
 

 
FIG: 1.2. 5 Program file folder destination 

 
A summary will be shown of the installation options. Click the [Next>] Button to Begin installation. 
 



 
FIG: 1.2. 6 Setup ready to install 

The Install Shield wizard will now begin the process of installing the Warrior Software onto the computer. 

 
FIG: 1.2.7 Decompress and install the warrior files. 

 
Allow the software to decompress, extract files, and create icons until it is finished.  



 
FIG: 1.2.8 Setup has finished 

Click the [Finish] button. 
 

 
FIG: 1.2.9 Restart Computer 



 
Allow the computer to reboot and finish the installation procedure 
Remove any disk from their drives and click [Finish] to complete setup. 
 
As the computer reboots, before windows starts, the final installation of the Warrior software will begin. There 
will be changes made to the configuration files that indicate what version of software has been installed. The 
Hardlock driver for the software key is installed. This may take some time, allow it to complete the Hardlock 
driver installation. 
 

 
FIG: 1.2.10 

 
As the SDS USB Devices Drivers are installed, you will be asked to accept the license agreement. Click 
[Yes] to continue.  
 

 
FIG: 1.2.11 

 
The interface panel must be turned off and disconnected from the computer before the device’s drivers are 
installed. Click the [Next] button to continue. 
 



 
FIG: 1.2.12 

You will get a window that shows that the devices drivers are installing. Wait for the device driver installation 
to be completed. 

 
FIG: 1.2.13 

When the devices drivers have finished installing, you will be show the confirmation window. Click the 
[Finish] button to proceed. You may notice a black window momentarily flash on the screen as the Warrior 
Event Logger is installed and started. 
 



 
FIG: 1.2.14 

You should now attach the USB cable from the computer to the Interface Panel and then turn on the panel. 
The drivers for the devices should load into Windows and be ready to use in a few minutes. 
 

1.3 Warrior Software Upgrade or Perform new versions. 

Upgrades are released from time to time to distribute new or improved components of the software. 
Upgrades for Warrior Data Acquisition Software version 8.0 or latest is distributed on one DVD. Or the 
software is downloadable in the form of a single executable file from the web site 
http://www.warriorsystem.com/ under DOWNLOADS. This file should be copied to a temporary directory and 
run to expand itself.  To install the Warrior software run the SETUP.EXE.  
 

Restart the computer and turn OFF the Interface Panel Power supply.  
Do NOT connect the Warrior Interface Panel to the computer via a USB cable before 
installing the Warrior 8.0 Software. This could cause problems in the later installation of 
hardware drivers. 

 
To install the update from DVD, Place the new version of Warrior into the CD Drive. It should auto run. If not 
run CD Start from the DVD. When upgrading from an existing installation, the current Warrior system program 
files and configuration files are saved to a backup directory. If problems occur with the new installation, the 
previous installation can be restored entirely. Select Upgrade from Version X.x to Version Y.y, the program 
files will be updated, and existing configuration files will be then retained. 
 

http://www.warriorsystem.com/


 

FIG: 1.3.1 CD_Start.exe found on DVD. 

 
FIG: 1.3.2 Interactive Menu. 

 
From the Interactive Menu, click on the Warrior 8 software installation that you wish to perform. The software 
will then do a preload to prepare for installation. 
 



 
Fig. 1.3.3 Extracting preload files 

You will be asked to do an upgrade or a completely new installation. Click the Upgrade button to retain current 
configuration setting and to upgrade program modules to new version. Click the Complete button to do a new 
installation, over writing any existing program configurations. 

 
Fig. 1.3.4 Choose Upgrade to upgrade software and save current configuration settings. 



 

Fig. 1.3.5 The rest of the installation process is the same as an initial installation. 

1.4  Warrior Shortcut Icon  

Perhaps the easiest way to set up a short cut to a program group is using Windows Program Selection. Click 
on the Windows Start Button. Next, click on All Programs. Find the Warrior 8.0 program group and right click 
on that. Finally, select Send to  -> Desktop (create shortcut) 
 

Fig. 1.4.1 

 



It is recommended that the Warrior group programs be placed as a toolbar on the Windows toolbar. It is 
necessary to first have placed a shortcut to the Warrior program group on the desktop as done in the 
preceding paragraph. To add the Warrior toolbar, right click on a blank area of the Windows Toolbar. Select 
Toolbars  >> then select New Toolbar . . . 

 
 
Fig. 1.4.2 Select Toolbar Folder 

 
The window “New Toolbar – Chose a Folder” window will open. Click on Desktop to view the Desktop folders. 
Click on Warrior 8.0 folder then click the [Select Folder button]. You should now have a Warrior 8.0 toolbar 
for quick access to Warrior programs. 
  



1.5 Key Software Authorization Setup  

A Warrior USB key must be attached to a USB port on the computer or be contained in the interface panel 
attached to a USB port on the computer for the software to operate (unless the demonstration release has 
been installed). In addition, the Warrior 8 key codes for the key being used must be entered the Warrior 
Control Panel for the key to be recognized. 
 
From the Warrior group box, select Control Panel. 

 
FIG: 1.5.1  Select Control Panel  

 
FIG: 1.5.2  Warrior Control Panel  

Click on the Licenses tab. 



 

 
FIG: 1.5.3  Control Panel Licenses 

 
 
Unlike the older Warrior software that required a single access code, Warrior 8.0 software requires multiple 
access codes for the different logging modules that get installed. Although the codes can be manually entered 
by typing the code for each individual license in the code box, the software can now import the codes by 
reading a text file and merging them into any existing codes. Click on the [Import from file] button to browse 
for the import file licenses.ini. With new systems, this file will be located on a USB drive installed in the 
Scientific Data Systems Interface panel. 
 

 
Fig. 1.5.4 Browse for Licenses.ini (normally located on USB drive in interface panel) 



 
The Control Panel will indicate whether the codes were properly imported by showing Import: OK. You can 
now look at each of the different License in the License for: dropdown list. The software will show the code 
for the license type shown. 

 
Fig. 1.5.5 Imported Licenses OK 

1.6 Warrior USB Drivers Setup  

USB Warrior Drivers are now loaded upon the reboot of Windows after the Warrior Software has be installed 
or updated. This if why it is important not to have the Interface panel connected to the computer at that time.  
 
After the computer has finished rebooting, connect the USB cable from the computer to the interface panel 
and then turn the Interface panel on. The drivers for the Warrior devices should now self-install through 
Windows. It is recommended to go to the Windows Device Manager and check to be sure that all devices 
have been properly installed. 
 

1.7 Device Manager 

The device manager checks the connectivity between the Devices (Warrior Panel), USB Connection, and 
the computer. To get to the Windows Device Manager program in Windows 7, Click the Windows start / 
program button (icon) and then right click on the computer. From the list provided, select properties. You 
should be able to access the Device manager from this window. 
Many Users place a shortcut to the Windows Device Manager on the computer desktop. To do this, first click 
on the Windows start / programs button, then click on Control Panel. In the upper right of the Control Panel 
Window, you can select to “view by:” category, large icons, or small icons. Select either the large icons or 
small icons. You should now be able to see the Device Manager Icon in the Window. Right click on the 
Device Manager Icon and select “Create Shortcut”. This will put the Device Manager shortcut and icon on 
the computer desktop. 

 

Fig. 1.7.1 Device Manager Shortcut and Icon 



 

 

FIG: 1.7.2 Device Manager Path 
The normal devices that are connected when attached to a standard interface panel include, but are not 
limited to: 
 2 Generic USB Hubs which are the USB Hub in the Panel 
 SafeNet Inc. Hardlock Key and SafeNet Inc. USB Key are the Warrior Software key 
 Scientific Data Systems CyStdFX1 is the USB44 Board 
 Scientific Data Systems LOGFX-DSP is the DSP Board 
 



1.8 Creating Company Logo for Headings 

For a logo to work correctly in the Warrior Standard headings, it should be twice as wide as it is high and be 
outlined with a heavy dark line. The actual dimensions used are not critical; it is the two to one relationship 
that is important so that the logo will appear in correct proportion when placed in the heading. If the logo is 
not outlined, it will cover the border area of the heading around the logo and make it look unusual. 
 
Place a copy of your existing graphical image file that you wish to use as a logo into the Warrior\Config folder. 
The file can be a .BMP (bitmap image, .JPG (compressed picture file), .WMF (Window meta-file), .EMF 
(Enhanced meta-file), or .LGO (obsolete Warrior logo file). Open the Warrior Heading Editor program. Left 
click the mouse in the Logo area of the heading. You will get an Edit Logo window, as shown in figure 1.8.1. 
Click on [Change] to bring up the logo selection window, The Warrior\Config folder will be shown with all 
available logo selections. Select the logo that you wish to use and click on [Open]. This will be the logo that 
will be used in ALL files until it is changed again. 

FIG: 1.8.1 Edit Logo 

 
The following is an example how to create a company logo for use on headings and log banners. If you do 
not have any existing graphical image for a logo, such as a JPG, TIF, or BMP, you can use most drawing 
program such as Windows Paint to create your LOGO image. Open the graphics program and set the size 
of the image to be twice as wide as it is high. 

 
FIG: 1.8.2 Resize image in Windows paint 

Once you have created your logo, save the file as a .JPG or .BMP to the Warrior\Config folder. You will then 
be able to change the logo in your heading as described above.  
  



 



2 Windows Set Up 

The Warrior Well Data Acquisition System runs in the Microsoft Windows operating system. This gives the 
user many powerful tools and facilities not previously available in an inexpensive logging system. One of the 
principle advantages is that the system is multitasking, meaning that several programs (or tasks) may be 
running on one computer at the same time. Within the Warrior system, for example, several different log plots 
may be displayed independently on the screen and other logs may be directed to plotters. Headings may be 
prepared, and final log presentations set up, all while continuing to acquire data. 
 
Another advantage of the Windows environment is the graphical user interface, which presents the functions 
available in the system in an easy to understand manner (well, fairly easy). While the simple interface makes 
the Warrior easy and fast to operate, the full power of the system can only be realized when an understanding 
of Microsoft Windows itself has been acquired. It is therefore strongly recommended that, after some initial 
experimentation with the system, the Windows User Guide is studied, and the Windows Tutorials run. 
Courses are also available on videotape, and other media, from many sources. 
 

2.1 Windows Printer Setup 

To be able to produce a hardcopy of your data from the Warrior software, a Windows printer must first be 
installed. The Warrior software includes the capability to print  / plot to common plotters while logging but the 
software uses the Windows spooling to buffer the plotter output. Other plotters may be used to plot logs 
through Windows after data recording as stopped. 
 

2.1.1 Windows 7 Printer Installation  
To facilitate this operation a USB Port has been assign on the Interface Panel (rear Plate) and marked 
“Plotter”. It is recommended to use this USB port for your printer connection. With the printer turned off, plug 
in the USB cable or USB to Centronix Printer Adapter cable into the USB port. Make sure that the USB cable 
from the computer to the Interface Panel is properly connected. Turn the Printer On. 
 
Windows will often install printer driver automatically. To see if Windows has installed the printer, click on the 
Windows start button and then click on the Device and Printers selection.  
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Fig. 2.1.1 Windows Start Button and Devices and Printers selection 

Look in the Printers and Faxes section and see if the printer that you have connect has been automatically 
installed. If it hasn’t been, then Windows drivers will have to be installed manually. At this point the 
manufacturer’s drivers must be available. Drivers for black and white plotters normally supplied by Scientific 
Data Systems, such as Printrex and ISYS, are on the Warrior installation DVD. 

 
Fig. 2.1.2 Click on Add a printer 

Place the CD /DVD or other media containing the device drivers in the computer so that they are available 
when required during the printer installation. Click on Add a Printer in the Windows Devices and Printers 
window. 
 



 
Click on the Add a local printer selection 

 
Fig. 2.1.3 Add a local printer 

 
 
Click on the Use existing port selection, then drop down the scroll down printer port list to the right of the 
selection until you find USBxxx (Virtual printer port for USB). There may be several USB virtual printer ports, 
typically the highest numbered one is the last device that was plugged in to a USB Port. After selecting a 
USB port click the [Next] button.  
 

 
Fig. 2.1.4 Use Existing Port 



 
 
The next step is to select the location of the printer driver to be installed.  

Fig. 2.1.5 Click [Have Disk] 

 
The list on the left side of the window are printer manufacturers that Microsoft supports or that have previously 
been installed on the computer. Check the list to see if the manufacturer is in the list. If it is not in the list, click 
on [Have Disk …]. 

Fig. 2.1.6 Plotter Manufacturer Installation disk 

 



Click on the [Browse …] button to locate the drivers for the printer. The Warrior Installation CD contains 
drivers for the plotters that Scientific Data Systems has supplied. 
 

Fig. 2.1.7 Warrior CD 

Click the Look in: drop down list in the Locate File window to find the Warrior Installation CD in the computer 
CD / DVD Drive and double click on it. 

Fig. 2.1.8 Windows Printer Drivers on Warrior DVD 



On the Warrior CD, locate the Windows Printer Drivers folder and double click on it. 

 
Fig. 2.1.9 Printrex Drivers Folder 

 
Select the plotter manufacturer and double click on that folder. 

 
Fig 2.1.10 Windows Drivers information file 



When the proper .inf, or setup information file has been located, click the file and then click on the [Open] 
Button. 
 

 
Fig 2.1.11 Opening Printrex Drivers 

 
This should return you to the Install from Disk window with the folder with the manufacturers files selected. 
Click the [OK] button to continue. 
 

Fig. 2.1.12 Selecting printer 

 
You should now have a drop down list of the manufacturer’s printers. Scroll down the list to find the model of 
the printer that in being installed and click [Next]. 



 

Fig. 2.1.13 Installing Printrex 840 DL/G Plotter 

 
Either enter a new printer name or accept the printer name Windows has assigned by clicking the [Next] 
button. 
 

Fig. 2.1.14 

 



Warrior will not print through a shared printer (Warrior does print through network printers) so select the Do 
not share this printer option and then click [Next]. 
 

 
Fig. 2.1.15 Finish printer installation 

 
If this is the only printer to be used on the computer, click the Set as the default printer check box.  

2.2 Create Shortcut to Device Manager on Desktop  

The Windows Device manager is a useful tool in determining device installation problems. It is suggested 
that a shortcut to the device manager be placed on the Windows desktop. To place the shortcut, click on the 
Windows Start button. Select All Programs. Select Accessories.  Select and Open Windows Explorer. 
Navigate to C:\Windows\system32 and find devmgmt.msc.  Right-click on the file, select Send to -> Desktop 
(create shortcut). Once the file is on the Windows Desktop, right click on the Icon and select Rename. 
Rename this shortcut to Device Manager. 
 

FIG: 2.2.1 Device Manager Icon and renamed Icon 



Double click on the Device Manager Icon to open the Device Manager. Scroll down the list to Universal Serial 
Bus Controllers and click the + sign beside it to expand and see what Universal Serial Bus Devices are 
installed. 

 

FIG: 2.2.2 Device Manager Path 

Typical devices installed for Scientific Data Systems configurations include: 
 
SafeNet Inc. Hardlock Key  Warrior software key 
SafeNet Inc. USB  Key   Warrior software key 
Scientific Data Systems CyStdFX1  USB44 Board 
Scientific Data Systems LOGFX-DSP DSP 
 
Other Devices that also may be seen depending upon the system and peripherals: 
 
Scientific Data Systems CYSTD  Upgrade Panel UPUSBDAC 
Scientific Data Systems CYSIM  Simulator Box 
Scientific Data Systems CyShPnlFX1 Shooting Panel USBAUX 
Scientific Data Systems CyAuxFX1 USBAUX 
Scientific Data Systems CyPipFX1 Pulse Interface Panel 
 
 



2.3 Scientific Data Systems Device Management  

 
The Warrior software installs the Icon Scientific Data Systems Devices in the Windows Control Panel. The 
control panel should be viewed as Large Icons or Small Icons to be able to see the Scientific Data Systems 
Device Manager. Scientific Data Systems devices can be removed and reinstalled from this program. The 
properties window shows all Scientific Data System devices and whether the computer has installed drivers 
and if the devices are currently connected. 
 
 

 

FIG: 2.3.1 Scientific Data Systems Device in the Windows Control Panel 

 
Fig. 2.3.2 Scientific Data Systems Devices 



 



3 Warrior Control Panel  

The Control Panel sets certain global characteristics of the Warrior system. The Warrior Control Panel is 
started from its icon in the Warrior program group or via the Windows Program Menu. Warrior 8.0 now has 
several pages of information to set up system configurations. The pages of the Warrior Control Panel are 
General, Acquisition, Plot, Hot Keys, Licenses, and Depth/ Tension. 

3.1 Control Panel - General  

The General page sets many of the typical settings from the Warrior 7.0 control panel. 
 

. 

 
FIG: 3.0.1 Warrior Control Panel – General page 
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3.1.1  Show Depth as  
 
The option buttons in the upper left set the default depth units for the system. The choices are Feet or Meters. 
 

FIG: 3.1.1 Depth units 

3.1.2  Show Data Units as 

 
The “Show Data Units as” area allows the user to select one of three choices for the data units to be used. 
FIG: 3.1.2 Depth units 

By clicking on the [Edit] button, the user can select the actual units to be used for each of the 3 choices. Note 
that English units do not necessarily mean that they must be English units. This is merely a means to identify 
one of the three units’ choices and to use those units as the defaults during program operation. 

 

FIG: 3.1.3  Unit maps for the 3 data choices 

 

 

3.1.3  Use Language 
The drop down list allows the User to set the language of the user interface for the system. Several choices 
are expected to be available shortly. 
 



 
FIG: 3.1.4 Languages 

3.1.4 Warrior data directory 
This item indicates the current Windows directory for the default storage of Warrior database files. To change 
the folder, click on the [Browse] button and navigate to an existing folder or click on [Make New Folder] to 
create a new folder for data storage.  

 
It is highly recommended to use the default directory of “C:\ProgramData\Warrior\Data”. 
 

 

FIG: 3.1.5  Default Warrior data storage folder 

3.1.5 Setting up Real Time Backup  
If something should happen to corrupt the original database through a faulty merge or recalculation, copies 
of the original passes would still be available. While in acquisition, recording data, at the end of a log pass, 
the data from that pass is copied into the backup database. The User is given three options. The first is to 
make no backups. The next option is to give the User a prompt asking if they want to make a copy of that 
pass. The final option will automatically make the backup without the prompt. The User also has the option 
of using the [Browse] button to select the folder to be used for storing backup databases. 
 

It is highly recommended that real time backup files be created. 
 
 

 

Fig. 3.1.6 Setting real time backup 



 

Fig. 3.1.7 Setting real time backup directory 

3.1.6 Current Warrior Software Version 
The currently installed Warrior Software version is shown on the bottom of the General page in the Warrior 
Control Panel.  

 

Fig. 3.1.8 Current Warrior Software version 



3.2 Control Panel - Acquisition  

The acquistion page of the Warrior control Panel sets up many of the general settings that are used while 
acquiring data. 

 

Fig. 3.2.1 Warrior Control Panel – Acquistion page 

3.2.1 Acquisition system settings  
The Panel Type is read from the Warrior Software key that is stored in the panel and reflects the hardware 
that is currently installed in the panel. This should be grayed out so that the User cannot inadvertently change 
the panel type. If different revisions of boards are installed in the panel, contact Scientific Data Systems for 
directions on how to change the panel type to reflect the board changes.  

 

Fig. 3.2.2 Panel type setting 

3.2.2 Refresh Monitor settings  
The User has control over how often the Waveform windows and numeric windows such as monitoring 
outputs or sensors are refreshed. The default settings for refreshing windows is 1000 msec, or once per 
second. Be aware that while putting a lower value in for these settings will refresh the windows faster, that it 
will also put a lot of overhead computing power on the computer to do this and may slow down the response 
of the computer. 

 

Fig. 3.2.3 Monitor Refresh settings. 



3.2.3 Cable Selection Settings  
The User can specify different cables to be used. This way each cable can have different settings for use as 
in a split drum unit or moving the computer among different units. 

 

Fig. 3.2.4 Cable Selection settings. 

New cables can be added to the drop down list of cable selections by clicking the [Add] button. An “Add new 
Cable Type” window will come up. The User can then type in any description to identify the new cable type. 
When the [OK] button is clicked, the new description will be added to the cable selection drop down list. 

 

Fig. 3.2.5 Entering new cable description. 

Existing cables may be removed from the drop down list by first selecting the cable to be removed and then 
clicking the [Remove] button. A confirmation window will come up to confirm removal of the selected cable. 
Each cable in the drop down list can have its own line resistance setting. To assign a line resistance to a line, 
select the line, enter the line resistance in ohms, and then click the [Set] button to assign that resistance to 
the cable selected.  Line resistance is a User defined value. Most services will have HVOLTA as an output. 
HVOLTA is computed by taking the TCURR output (tool current) and multiplying by the Line resistance value 
and then subtracting this value from the TVOLT output  (tool voltage) to give an apparent head voltage. Note 
that HVOLTA will not be accurate unless the tool voltage and tool current are properly calibrated, and the line 
resistance is the correct value for the line being used. 
It is a given fact the the phisical characteristics of a cable can effect the shape of signals on the cable. By 
adding the SignalType control keyword to a service, different cables can each have different line filter settings 
for that service.The User would be allowed to select a cable type that would then set cetain filter setting for 
specific signal types. This is discussed further in Section 16 
 

3.2.3 Default Font for Gauges 

 

The dropdown list allows the User to select the Windows font that he would like to use for gauges in 

Acquisition. 

 
Fig. 3.2.6 Setting Font for Gauges  

 



3.2.4 Other Acquisition Options  
There are several other options that may be set from the acquisition that would affect how the Warrior 
software would work. 
 
The first option is to show the tool string editor automatically when a service is selected. The tools to be 
included in the tool string are shown when the service is loaded into the software in the tool editor window. 
The tools chosen will affect what outputs are available, what the sensor offsets for each output are, what 
filtering is used on the outputs, and what the calibrations are used for an output. 
 

It is highly recommended that this option be checked and the tool string editor used 
every time the service is started so that the User looks at the tools in the string. 
 
If the “Warn about losing depth if moving” box is checked, the software will issue a warning if the depth is 
changing while a service would be loading. There is a short period of time while the software is loading that 
depth pulses to the panel would be missed. For the typical User in the field, this box should be checked. 
 
The User may select the font that is used in the Acquisition window by clicking the [Edit font] button. This 
brings up a dialog window that allow the font, font style, and size to be selected. The selected font will then 
be used in the Acquistion window.   
 
If a service has been made available for perforating in the Service Editor, then checking the “if perforating 
service . . “  box will have the service pop up a message with the zero point of the tool string when the service 
loads. 
 
By checking the next box, the Acquisition window will always be on top even if other windows are moved 
over it. If the Depth window is selected to always be on top also, then it could cover the acquisition window if 
the depth window is moved over the acquistion window. 
 
The update with max range of data check box changes the start and stop depth of a log pass from the 
encoder depths when the pass was started and stopped to the maximum output depths at the start and at 
the end of a log pass. 
 
The default log depth scale is the number of feet of well log per foot of paper. The standard in the US is 240 
ft of log per foot of paper or 100 foot per 5 inches. 
 
The default log time scale is the number of seconds of log per inch of paper. The default setting of 10 will 
give 10 seconds of log for 1 inch of paper or 120 seconds of log per fool of paper. 
 
The log time rate is the default for the number of data sample to be recorded to the database per second. 
The default rate of 10 works well in most instances. 



 

Fig. 3.2.7 Other option settings for Acquistion 

3.3 Control Panel – Plot 

The plot page of the Warrior Control Panel is used to setup plotters and allow the User to set up many of the 
parameters and functions used by Warrior software in the plotting of logs. 

 

3.3.1 Plotting – Gridline Setup 

 

Fig. 3.3.1  Plotting Setup 

The plotting of horizontal depth gridlines can be set up by adjusting the scale factors for the gridlines. If the 
vertical scale resolution on the plot is less than the maximum compression ratio, and the scale resolution is 
greater than the minimum compression ratio, than the gridline will be plotted. Separate gridline setups can 
be kept for English depth, Metric depth, and a time log.  
In the setup shown in Fig. 3.3.2, the 50 foot depth line will be on the plot unless the scale is less than 12000 
(.1”/100ft). The 10 foot depth line will plot when the scale is less than 2400 (.5”/100ft). The 2 foot depth line 
will only plot when the scale is less than 480 (2.5”/100ft). A 20 scale (60”/100ft ) will not have two foot depth 
lines since they have a minimum range of 25, but it will have 1 foot depth lines since the 20 scale is less than 
the 1.0 foot maximum of 25.  



 
FIG: 3.3.2 Horizontal Gridline Setup 

3.3.2 Plotting – Printer Setup 
There are two different plotting modes that Warrior software can use to plot data. In the Direct Print mode, 
printer drivers contained in the Warrior Software allow real time printing while acquiring data and use only the 
Windows spooling function. In Windows mode, the Warrior software prints the data through the Windows 
installed printer drivers. Windows mode should not be used for real time printing. 
For good quality color prints, or to print to a printer that is not in the list of supported Direct Print mode printers, 
select the option “Enable printing through Windows printer".  If you have that option checked, then when you 
print from Warrior, you will see either (Direct) or (Windows) label for each printer in the list of printers to print 
to. 
 
Direct to Printer 
Printers supported for Direct printing by Warrior, also have Windows drivers, so when a Direct 
Printer is installed; the Windows driver must be installed as well for printer spooling. When selecting a printer 
name, as would be done during a printer selection in Windows programs, Warrior can use the port properties 
you set up for that printer through the standard Windows printer setup, so the port name doesn't have to be 
specified in two different places. When a Windows name is specified, then the Port Name doesn't need to be 
changed in Warrior, as it will use the same port that is set up through your standard Windows printer setup. 
When using Direct printing, settings, such as media type, plot speed, etc., are all controlled by Warrior 
software directly, not by the Windows printer driver. 
 
Printers supported by Warrior Software for monochrome printing Direct: 
Printrex 820 and 820 DL and the 840 DL/G or 843 DL/G and 920 ( www.printrex.com ) 
ISys V8.5 or V8.5e ( www.isys-group.com ) 
 
Printers  supported by Warrior Software for color printing Direct: 
Epson Stylus Color 900 
Epson Stylus Color 1520 
Epson Stylus Color 3000 
Epson Stylus Color C60, C80, C82, C84 
HP DesignJet 750C, 1050C 
HP LaserJet 5L 
 
In addition, PDF and image (TIFF) file can also be made directly. 
 

file:///C:/Users/gregboutkan/Desktop/www.printrex.com
file:///C:/Users/gregboutkan/Desktop/www.isys-group.com


 
Fig. 3.3.3 Warrior Control panel Printer Setup 

 
Printing through Windows Printing 
While logging, it is possible to print to a Windows printer. However, printing hardcopy of your pass that you 
are currently logging is not possible do to Windows printing full pages at a time. SDS cannot guarantee that 
all printers will work properly for making prints from Warrior, therefore a list of tested printers that are able to 
make continuous prints, is available. The Windows printing options are settings that may change from one 
printer to the next. However, most of the settings are set by SDS, so they should not be changed. Some 
printers place a large gap at the start of a print, so a print gap is added during start of print, so the first fan 
fold can be skipped, and a distance can be added to get the <fold here> to come out in the right place. 
When using Windows printing, settings, such as media type, plot speed, etc., are all controlled by the 
Windows printer driver. 
 

3.3.3 Plotting – Installing a Direct Warrior Printer 
From the Warrior Control Panel, click the Plot tab. From the plot sheet, click on the [Printer Setup] button. 
From the Installed Printers window, select the [Install] button at the bottom of the page for a list of printers 
supported by Warrior for direct printing while logging.  
 



 

Fig. 3.3.4 Warrior Installed Printers Setup 

 

 

FIG: 3.3.5 Install Printer 

Open the Drop- down list to view the list of printers. Note that there is a scroll bar to the side of the list to scroll 
up and down to view all the selectable printers. 
 



 

FIG: 3.3.6 Install Printer 

In this example we will select Printrex for the Printrex 840 DL/G. 

 

FIG: 3.3.7 Install Printer 

Click the [Install] button to select the printer shown for installation.  

 

FIG: 3.3.8 Printrex 820/840 Plotter Configuration 

The Plotter Configuration window for the plotter selected will now open. In this example, the Media can be 
paper or film. Depending upon the media selected, the plotter will run at either the paper speed or the film 
speed. The sensitivity setting controls the heat selection for the thermal paper or film that is installed. A low 
sensitivity will increase the heat setting. For fan fold printing, set the printer page height to twice the size of 
one fan fold page. 



Some of the Windows printers may require a value to be entered for the “Gap to start of print”.  Having a non-
zero value will cause the printer to advance the paper that distance, so the first fan fold page may be blank 
in order to position the print head to the proper place. 
Select [Save] to save the plotter configuration. 
One physical plotter in a system can be installed under different names and each installation can then have 
different configuration settings and/or printer calibrations. To install multiple configurations for the same 
physical plotter, start the installation by clicking the [Install] on the lower portion of the screen. Find and select 
the plotter in the drop- down list. If that plotter name already exists in the list of installed plotters, you will be 
given the option of entering a new name. Click the [Rename] button to continue to the configuration window 
for that plotter name. 

 

Fig. 3.3.9 Entering Second plotter name for existing plotter 

Once the plotter has been selected and installed, the plotter used for windows spooling needs to be selected. 
This plotter must already have been installed in windows as discussed in section 2.1. 

 

FIG: 3.3.10 Installed Printers 

Select the Drop-down list for the Name of this printer as seen by Windows printers and select the Windows 
installed printer. If no plotter is selected, you will get the plotter may be off-line error message when you try 
to print from Warrior. 



 

FIG: 3.3.11 Installed Printers 

Select [Save Changes] to save the installed plotter and its configuration settings. 

3.3.4 Printing to PDF 
Warrior supports direct printing to PDF files through its own driver. Before creating a PDF output, determine 
what the customer intends to do with the file and configure the PDF configuration options accordingly. If it is 
intended only to view the PDF on the screen, then the driver should be set to Continuous Viewable Image 
and Color. If the customer intends to print the PDF, then it should be set to Continuous Printable Image and 
Color or Monochrome, depending on the printer being used. In addition, it may be important to set the page 
size to match the page size of the customer's printer; otherwise gaps between pages can appear. 
Furthermore, there is a tradeoff between file size and quality. The higher the dpi setting, the better the quality 
normally, but the file size is larger. Some experimentation may be required with the customer to produce 
optimal results. This is also true for the selected compression mode. For most situations, FLATE compression 
works well. 
 

3.3.5 Printing to TIFF 
Warrior also supports direct printing to TIFF files through its own driver. Again, determine what the file is 
intended for and configure the driver accordingly. Note that the driver supports TIFF single continuous pages 
of longer than 90 inches. However, many TIFF applications (including Warrior fax) do not support this, so 
before increasing the maximum page length make sure that the customer can read such files. 
 

3.3.6 Windows Printing 
Check “Enable printing through Windows printer.” When this box is checked, either a (Direct) or (Windows) 
label for each available printer is shown when printing from Warrior.  
COLOR PRINTING NOTICE:  You will always get better color prints printing through a Windows color printer.  
None of the direct color printers were designed for printing continuous log prints.  Unless you require color 
printing while logging, we recommend you use one of the Windows printers and not use Direct printing to a 
color printer. 
There are several settings that need to be set to achieve a quality print using Windows printers. By clicking 
on [Printing Help] you can read further about settings.  



 

 Fig. 3.3.12 Printing Help 

If you click on the Supported Windows Printers, a list of printers will drop down. If you click on one of the listed 
printers, settings for Windows printing from Warrior will be shown. In addition, suggested settings for the 
Windows printer properties will be listed. 

 

Fig. 3.3.13 Supported Windows Printers 

Source Resolution: If it takes a long time to print to your Windows printer, try setting this to a lower value.  
The default is 1.  A lower value may degrade the print quality, so test with your printer to find the optimal 
setting.  You may be able to use a higher Windows printer resolution ( 600 or 720 dpi ) and use a Source 
Resolution of 1/2 or 1/3 and still get a quality print.  



3.3.7 Finding Printer  
We recommend connect the Printer/Plotter in the same USB port but if you do not know which port to use, 
you can find the USB port where the printer is connected. This will work for printers that print only through 
Windows or for printers that use the Windows spooler for direct printing through Warrior. 

 

FIG: 3.3.14 Installed Printers 

Select on the Drop-down the Printer that you wish to find what USB port it is attached to. In this case  Printrex 
840DL/G. 

 

FIG: 3.3.15 Installed Printers 

Click on the [Find this Printer on USB port] button. The find printer dialog box will come up. At time, it is 
important to disconnect any plotter that is not the plotter that you are trying to locate. A sample test page will 
be sent to the plotter and if the plotter is not the correct plotter being tested it may generate large amounts of 
wasted paper. 



 

FIG: 3.3.16 Find Printer 

Select [Yes] to start the test. Several USB ports may be tested before what the software thinks is the correct 
port is found. 

 

FIG: 3.3.17 Testing Printer 

If the test print comes out, select [Yes]. The software will automatically set the Windows printer to the shown 
port. The confirmation that the printer is connected to USB002 is then shown. Select [OK] to continue. 

 

FIG: 3.3.18 Printer Found 

If you received the message shown in Fig. 3.3.7 and the test print did not come out and it did not come out 
after the rest of the USB ports have been tested, then it is possible that something may be wrong with that 
port. One common problem is that there may be prints in the print queue that are ahead of the test print. To 
check this, check the Windows Devices and Printers and check the status of the printer and make sure there 
is nothing pending. 
Once the setup and configuration of the Windows printers has been completed, If Windows printers are not 
to be used, uncheck the Enable printing through Windows printer check box. On the left side, again select 
the Warrior printer name drop down list and select the default printer and the Window printer that it will use 
for Windows spooling. Check the Default check box to save it as the default printer when printing through 
Warrior. 
Before leaving the Printer Setup, click the [Save Changes] button and then the [Close] button. 
 



 

FIG: 3.3.19 Installed Printers 

 

FIG: 3.3.20 Installed Printers 

 

FIG: 3.3.21 Installed Printers 



 

 

3.3.8 Plotting – Options 

 

FIG: 3.3.22 Other plotting options 

If the Monitor USB port while printing is checked, then if the software does not receive a response from the 
plotter within the time that is specified, a prompt to try other USB ports will be shown. It is highly 
recommended that this box be checked. 
Some plotters that are connected to the computer via  parallel port may require that the status of the plotter 
not be checked. This is only for specific plotters such as an older Gulton that are connected to a parallel port 
and not a USB port. 
The default heading that is used in the Heading Editor may be selected by click the [Browse] button. All the 
headings in the C:\ProgramData\Warrior\Format\ folder will be shown. The User can select any heading and 
install it as the default by clicking the [OK] button. Similarly, the default log banner may be selected by its 
[Browse] button. 

 

3.3.9 Plotting – Service Company 
The text that is entered in this field will appear in LAS files as the Service Company Name. 

 

Fig. 3.3.23 

3.4 Control Panel – Hot Keys / Shortcuts 

This page allows the User to change the “Hot Keys” for certain Warrior functions such as using F9 to start an 
“Action – Record Up” from the Acquisition window. There is also an option to have the software create and 
place short cuts for the Warrior\Config\ folder and the current Warrior Data folder in the Favorites section of 
Windows Explorer. 



 

FIG: 3.4. Hot Key setup 

3.5 Control Panel - Licenses 

The first functionality of this section of the Warrior Control Panel is to show the key number of the Warrior 
Software key that is attached to the computer, either directly or through the USB hub in the interface panel. 
This is shown in the Key serial #: window as #Uxxxx, where the xxxx is the key. If no key is currently seen by 
the software, you will see “NOKEY” in the window. 

 
FIG: 3.5.1 Warrior Key License Codes 



Unlike previous versions of Warrior Software that required a single license code, the Warrior 8 software has 
a different code for each of the software module types. In the “License for:” drop down list is the list of available 
Warrior Software licenses. When a license type has been selected, the “Code:” window will show the license 
code for the key serial # that is shown. If no license has been entered the code will be blank. The User has 
the option of hand entering the 16 digit hexadecimal code for a license and saving it, much like previous 
version of Warrior. Due to the number of codes that must be entered correctly for all the software permissions, 
the User can now import multiple codes for multiple software keys at the same time by clicking on the [Import 
from File] button and selecting the proper license file supplied by Scientific Data Systems. 

3.6 Control Panel – Depth / Tension 

 

FIG: 3.6.1 Warrior Control Panel - Depth / Tension 

The input section of the Depth / Tension page of the Warrior Control panel allows the User to specify the 
signal input used for both Depth and Tension. At the present time, depth can come from the Interface panel 
encoder input or from the ASEP Smart Monitor. Tension can come from the interface tension input, line load 
module input (AUX1 BNC ), or the ASEP Smart Monitor. 

 

FIG: 3.6.2 Depth and Tension input selection 



There are several other options for displaying the depth window. The depth may be displayed with 1 decimal 
point (0.0, normally used when depth is in feet), or with 2 decimal points (0.00, used when depth is in meters).  
The normal refresh rate of the depth window is 500 milliseconds. This can be changed by the User to be 
updated more or less often. 
The “Make depth window always on top of other windows” check box will force the depth window to always 
be on top no matter what its position is. 
The software normally shows speed as a negative value when logging up (depth decreasing). By checking 
the “Speed is positive when logging up” box, the value will be positive as depth decreases. 

 

FIG: 3.6.3 Depth display options 

 

 



 

4 Acquisition 

Acquisition is the main logging or data acquisition subset of the Warrior system. It acquires data from the 
hardware I/O devices, stores the raw data in the Warrior database and provides all the normal well logging 
functionality. When necessary, it also automatically starts other Warrior programs to perform additional 
functions in an integrated manner. In the Warrior System group, choose the Acquisition icon. (Double-click 
the icon,).  Note SDS sets up the software to display a Warrior System group on the desktop. However, the 
program group is also available via the Start button. 
 

 
FIG: 4.1 Acquisition  
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Never switch off or disconnect a panel if Acquisition is running; always exit Acquisition 
first. Unpredictable results may occur if communication is lost with a panel during an 
Acquisition session.  

 
Warrior is sensitive to USB devices being disconnected while it is running. USB devices can disconnect 
automatically when a computer goes into standby, so it is recommended that all standby/sleep/hibernate 
functions on the computer are disabled when using Warrior, not forgetting that closing the lid on laptop 
computers often puts them into standby as well. 

4.1 Acquisition – Depth Control 

 
When Acquisition is started, the Warrior Logging System Acquisition menu box will appear, along with the 
depth display. The Depth window displays the current depth and the line speed and has a [Control] button 
that causes the Depth Control window to be displayed. 

 
FIG: 4.2 Depth Display 

Click on the [Control] button of the Depth window or hit Enter when the Depth window is active. 
The Depth Control window appears as shown in Fig: 4.3. Enter the current depth in the New Depth field 
and click on [Apply] (or use the keyboard Enter key).  

 

FIG: 4.3 Apply to Set Depth 

 

FIG: 4.4 Depth reset 



 

The Depth Panel setting should normally be left at None; it is only used when there is a Scientific Data 
Systems stand-alone depth panel attached to the system. Refer to Depth Panel manual for settings. The 
Scientific Data Systems Depth, Tension, and Line Speed panel is connected via a USB port, select USB, if 
there is not panel available select None option. 

 

FIG: 4.5 Depth Panel Type 

To configure the Depth Control, click on the [Config] button to access the Parameters and Alarms menu. 

 

FIG: 4.6 Depth Control Configurations. 

The depth control box may be displayed at any time by clicking the Control button of the depth display; 
however, the New Depth, Correction, Encoder Resolution and the Wheel Size parameters may not be 
changed while logging.  
The Depth Configuration window enables configuration of the depth from an encoder input. The depth 
simulator that was available in previous versions of Warrior is no longer implemented since this was basically 
the same as a time drive log.  
The measuring wheel correction, the encoder characteristics, nominal wheel size (distance per encoder 
revolution), encoder direction, and speed direction are entered from this dialog box. 



Parameters for the Scientific Data Systems Depth, Tension, and Line Speed panel (if it installed) may also 
be entered or read by clicking the [Get] button.  
 
 

 

FIG: 4.7 Depth Configuration window 

If the system has a Scientific Data Systems USBAUX device attached to the shooting panel, the tolerance 
range for enabling of firing the panel may be adjusted in the Perf stop depth range. 
The [Alarms] button brings up the Warrior Alarms edit window. This allows the User to set the values, and 
tolerance for differential alarms, and to active the alarm by checking the On/Off box for that alarm. When the 
alarm is activated, the computer will normally beep through the speaker. By clicking on the three dots browse 
button to the right of the Sound file name for each alarm the User can elect to play back a .WAV file for the 
alarm warning. Under the Differential Alarms section are two depth alarms that have editable name fields. 
These can be used for alarms such as Packer, Seating Nipple, etc. 
 



 
FIG: 4.8 Edit Warrior Alarms window 

By clicking on the [Hoist] button in the Depth Control window, the Warrior System  Hoistman’s Display 
will come up. The Hoistman’s Display contains depth and gauges for Depth, Line Tension, and Line Speed. 
The scales for each of the gauges may be individually scaled by right clicking on the gauge. 

 

FIG: 4.9 Click [Hoist] for Hoistman’s Display 

 

FIG: 4.10 Warrior System Hoistman’s Display 



4.2 Acquisition - File 

The following options can be selected in File: 
Select Dataset, Load variables, About, Exit, Close All. 

 
FIG: 4.11 Acquisition File Options. 

4.2.1 Select Dataset 
The Warrior well log database can (optionally) contain data from many wells, and within each well, data from 
many log passes. Each log pass is stored in a dataset. The dataset contains not only log data, but also other 
information about the logs, e.g. calibration and tool data. 

 

FIG: 4.12 Select Dataset.  

The system requires a Windows compliant file name to be defined for the database file within which the data 
is to be stored. The structure of the Warrior log database allows datasets to be defined by field, well, run and 
pass. The user may optionally choose to insert in the various fields of the Select Dataset window, 
abbreviations of the actual field and well names. The run number and pass may also be entered, or they may 
be used to identify some other features of the dataset. 
As an example, when running production logging, multiple passes are normally made, and can be difficult to 
identify later, if the dataset definition is left with the default entries. Another approach is to use the run field to 
identify the tool being run, e.g. field/well/temperature/pass1. The pass number will automatically increment 
every time a log is started. 
If desired, modify the remaining fields to reflect the actual well and log information. 
Click on OK or hit ENTER. 

 
FIG: 4.13 Select Dataset  

Enter a compliant file name in the Select Database field 
If desired, modify the remaining fields to reflect the actual well and log information. 
Click on OK or hit ENTER. 



 

FIG: 4.14 Dataset Values  

 

The file names may contain only the following characters: 
        Numbers (0,1-9)  
        Letters (A-Z, a-z)  
        Blank (Theoretically you can have spaces)  
        ASCII characters greater than 127  

Lengths of the file names are limited to 255 characters (260 for full paths). 
Special characters are not allowed: $ % '  @ ~ ` ! ( ) ^ &  + , ; = [ ]  
 
  
The user may choose to store all data from a field in one file, or only the data from one log pass, or any 
intermediate level depending on the requirements. The usual procedure is to store all the data from one job 
in one file. In this way it is simple to back up the data to another directory before leaving the well site.  
Data may be merged into a single log file, or split into several files using the Merge program, to be described 
elsewhere. 
 

4.2.2 Load variables 
 
This option allows you to load Zoned Variables from previous database passes. This is particularly useful 
when repeating runs but creating a new database. Load Variables from the other Dataset, enabling depth 
dependent parameters associated with the selected service to be zoned and values to be set. 
 

 
FIG: 4.15 Load Variables  



 

FIG: 4.16 Load Dataset Values 

 

 
FIG: 4.17 Dataset Values run1/pass1 

4.2.3 About 
Shows the Software version installed in your computer 

 

FIG: 4.18 Select About 



 

 

 

 

FIG: 4.19 Show the Version Warrior Software 

 

4.2.4 Exit 
Closes the program in the standard Windows manner. Exit the acquisition window. 
 

4.2.5 Close All 
Closes all windows that have been opened in a Warrior Acquisition session. 
 

4.3 Acquisition - Service 

In the Warrior acquisition window click on Service and select the desired  service from the drop down 
box.  The services can be customized using 'Edit Logging Service Details', in Warrior Utilities. 
None is typically the service that is loaded by default when the Acquisition module starts. Usually the None 
Service contains no tools (except the tool STD that is a standard “tool” that should be included in every 
service). It will display depth, and you can monitor line tension and speed. 

 

FIG: 4.3.1 Select Service 



When any other service is selected by clicking on it, the tool string editor will appear.  The importance of 
examining the tool string for the correct serial number and placement for each tool cannot be emphasized 
enough. Length, and sensor offsets will be calculated and calibrations for the selected tool serial numbers 
will be loaded. If the tool string is not correct than sensor offsets will not be correct. If the correct serial number 
is not selected, then the calibrations for the desired tool will not be used. The tool string editor will be 
discussed in further detail in the Acquisition -> Edit -> Tool String section 

 
FIG: 4.3.2 Tool String Editor 

 

After the service has been loaded, the selected service or service title will be listed on the service line in the 
acquisition window. 
 

 

FIG: 4.3.2 Warrior Logging System 



4.4 Acquisition - Action 

 

FIG: 4.4.1 Acquisition – Action - Power Control 

4.4.1 Power Control 
Select Power Control from the Action menu. The Power Control window appears as shown below. 
Select the Enable box. 
Note: Tool voltage and tool current must be calibrated. 

 
FIG: 4.4.2 Power Control 



 
FIG: 4.4.3 TCURR Outputs 

When the Tool Current (TCURR) is less of 10 mA for a Time period more than 10 seconds, the tool power 
supply relay is set to the power disabled position. 
The Tool Current Open set point value (10mA) is set in wproperties.ini along with several other default values. 
These values can be controlled in each individual service by adding controls in the Service Editor. 

 
FIG: 4.4.4 Open Line Warning 

 
The Service Editor allows the User to adjust many of these power control values in each specific service. 
This is done by adding a Control through a Control Key Word and a value. 
  
NoMonitor= True to completely disable power monitoring) 
External= True will allow monitoring (if TVOLT and/or TCURR are measured), but only pop-up message; no 
cutoff 
SoftPowerControl=No. If Yes, then the power control slider bars will be enabled in the service 
 
Numeric entries: 
OverCurrent= Maximum allowable TCURR milliamps, 0 = disable over current monitoring. 
OverVoltage= Maximum allowable TVOLT volts, 0 = disable over voltage monitoring. 
OverDissipation= Maximum allowable TVOLT/TCURR watts, 0 = disable over dissipation monitoring. 
ShortVoltage= Minimum TVOLT volts that must be reached before the ShortCurrent value exceeds it set 
limit. 
ShortCurrent= Maximum TCURR milliamps for short-circuit detection before ShortVoltage is reached. 0 = 
disable short monitoring 
OpenCurrent= Minimum TCURR milliamps, 0=disable OpenCurrent monitoring. 
OpenTime= Maximum time interval for open-line detection, either 0 = disable OpenCurrent  monitoring 
defaulted to 10 milliamp and 15 seconds. 
 
Text entries: 
ActionOnTrip= ‘None’ will cause the system to do nothing when a power “error” is detected. 'Cut off’ will 
cause the system to disable power with no message. 'Warn' will provide the User with a message that there 
has been a power “error.  ‘Cut off and warn’ will disable tool power and provide the User with a message why 
the power was disabled.  
 



 

 
FIG: 4.4.5 Add Controls 

 
 

 
FIG: 4.4.6 Power Control 

When the Warrior system is invoked or the service is changed, the tool power supply relay is set to the power 
disabled position. Clicking the Enable button sets the relay to the enabled position and allows tool power to 
be applied to the wireline. Clicking Disable disconnects the power supply from the line and connects the line 
input to chassis ground. 



The user may choose to have the Power Control box remain open whenever an action is taken by selecting 
Keep this box. Otherwise the box will close when any action is taken. 
In order to Enable the  software Power Control,  go to Services Editor, select the service,  ADD control, select 
SoftPowerControl , and Save . 
 

 
FIG: 4.4.7 Services Editor 

 
FIG: 4.4.8 Controls 

The Acquisition software module monitors the output current and voltage, and the power dissipation within 
the tool power supply. It checks for over voltage, over current, excessive power dissipation and short circuit 
conditions. If any fault condition is detected the power supply will be disconnected from the line and a warning 
message displayed. 
 



 
FIG: 4.4.9 Line Enable  

The Polarity section of the window controls the polarity of the line voltage with respect to ground. Clicking 
the appropriate button, causing the polarity relay to switch, may change the polarity. In order to switch the 
polarity of the power supply from the Power Control window the Interface Panel Polarity Switch must be in 
the Auto position. 
The line power can also be controlled from Power Control window. Entering a percentage of the line power 
into the relevant textbox and clicking on the Apply button can adjust the level. 
You can also use the scroll bars as an alternative. 
For a few tools, the line power needs to be ramped up gradually before reaching its maximum. You can enter 
a Ramp Rate in Volts per second in the textbox provided to protect these tools. The ramp rate must be a 
non-zero value for the soft power controls to function. 
 

4.4.2 Caliper Control 
This function is for Open Hole tools to Open and Close the Caliper. 
 

4.4.3 Relay Control 
The relay control is for opened Hole tools to switch the down tool from log mode to Calibration Mode or 
reference Mode. 
 

4.4.4 Calibrate 
Invokes calibration procedures for tools in the service. 
Note that in order to record a post survey calibration a log pass must be generated after performing the 
calibration. In order to include the post survey calibration in the Plot Job this log pass must be selected when 
selecting the post survey calibration. 
 

4.4.5 Verify 
Invokes verification procedures for various tools in the service. 
Note that in order to record post survey verification a log pass must be generated after performing the 
verification. In order to include the post survey verification in the Plot Job this log pass must be selected when 
selecting the post survey verification. 
 

4.4.6 Plot Cal Report 
Allow you to print out all the calibrations information for all the tools in the current string. 
Print out the calibration report at the end of the Log. 
 



4.4.7 Record Up 
The plot may be paused by using the Pause button and  terminated by reselecting Unpause. The plot may 
be paused at any time and the scroll bar, used to move back through the log to any zone of interest. When 
moving the scroll bar, the actual log depth, corresponding to the scroll bar position, is indicated in a box in 
the center of the log plot window. A popup window opens by right clicking on the plot, displaying all the curve's 
values (Log readings) at the mouse position. 

 

FIG: 4.4.10 Record Up GR/CCL/TEMP 



 

FIG: 4.4.11 Options 

 
FIG: 4.4.12 Tool Position 

This option show the tool position 
 

 



FIG: 4.4.13 Tool Position ON/OFF 

4.4.8 Record Down 
Starts logging down. 
 

4.4.9 Record on Time 
Sets record on time reference mode. You will be prompted for the sampling rate in samples per second for 
fast sampling; or seconds per sample for slow sampling. 
 

4.4.10 Replay 
Replays data from current database. 
 

4.4.11 Independent Replay 
Replays data from any database. 
 

4.4.12 Depth Shift 
Makes a linear shift to the depth reference on a data file. 
This feature is intended to provide a rapid tie-in capability by applying a linear depth shift to a dataset. Once 
a section of log has been made and is displayed on the screen, select Depth Shift from the Action menu. 
The window shown in Fig:4.4.15 below appears. Or Apply Linear Depth Shift function is also available from 
the Utilities program in the Warrior shortcut folder. 

 

FIG: 4.4.14 Depth Shift 



 

FIG: 4.4.15 Down Hole Depth Shift 100 ft.  

The database and pass are defaulted to those of the last logged section. The Feet or Meters selection is 
defaulted to that set in the Control Panel. 
Enter the required depth shift for the file and click Apply. Note that a positive number, entered here, 
increases the overall depth of the file. The screen plot of the file is now automatically redrawn, reflecting the 
applied depth shift 

 

FIG: 4.4.16 Set Depth Shift 100 ft. 

Add 100 Ft. 

 

FIG: 4.4.17 Up Hole Depth Shift -100 ft  

Subtract 100 Ft. 



 

FIG: 4.4.18 Set Depth Shift -100 ft  

The current encoder depth will be automatically updated when the Shift current Encoder Depth also box 
is selected. This is the default when the depth shift is run from Acquisition. 
Note also that the shift may be made while logging; and that the encoder depth and log display will update 
accordingly. This facility may be used to apply a linear depth shift to log data, other than the current database. 
This can be achieved by using the Select Data button to bring up a file selection box. Ensure that the Shift 
current Encoder Depth also box is not selected, unless it is required to update the system depth. 

 

4.4.13 Preview Up 
Allows viewing of the log on screen (Interactive Plot) or hardcopy without permanently recording data to disk. 
 

4.4.14 Preview Down 
Allows viewing of the log on screen (Interactive Plot) or hardcopy without permanently recording data to disk. 
 

4.4.15 Preview on Time 
Allows viewing of the log on screen (Interactive Plot) or hardcopy without permanently recording data to disk. 
 

In Preview mode, data is being recorded in a special database called Preview. db. When 
the last program attached to Preview. dB is closed this database is automatically 
deleted. 
There is no way to recover Preview. dB once it has deleted. 

 

4.5 Acquisition - Edit 

4.5.1 Edit - Tool String 
The tool string editor will appear.  The correct serial number and placement for each tool should be verified.  
Select save, depth offsets will be calculated and calibrations for the selected tool serial numbers will be 
loaded. 
The Tool String Editor allows a tool string to be built from within the constraints of the selected service. Tools 
of the correct model may be selected by serial number and placed in the required physical position in the tool 
string. A tool string diagram is presented on the screen and may also be included in the hardcopy output by 
including in the plot job. Once the tool string has been assembled, the sensor offsets are automatically 
calculated using information stored in a tools database. 
Note that a service will include one or more tools. The tools, which are included in a service, are defined in 
the services.ini file. Only those tools defined in the services.ini file may be entered the tool string with the tool 
String Editor. 



 

FIG: 4.5.1 Select Tool String  

Select the required service and select Tool String from the Edit menu. The Tool String Editor will appear 
with the last saved tool string configuration. 
 

4.5.1.1 Remove Tools in the string 
To remove a tool from the string Mouse Right click on the tool section and select Remove. 

 

FIG: 4.5.2 Remove Tool  

Other way is with Remove button and select the tool(s) to be removed using the >>> button(s) at the left of 
the tool string diagram. Note that, in the diagram below, the >>> buttons are now positioned at the center 
point of tools rather than at tool joints as in the above diagram. 
 



 

FIG: 4.5.3 Remove Tool  

 

4.5.1.2 Add Tools in the string 
To add tools to the string, click on the tool to be added and drag it into position in the tool string. A line on the 
drawing will indicate where the tool will be inserted. You can also click on any tool and drag to a new position 
in the string. To edit the properties of the tool, right click on the tool and select Properties to bring up the tool 
editor for that tool. 

 

FIG: 4.5.4 Add Tool  

The second option is to double click a selected tool. This will add the tool to the top or bottom of the string 
depending up Tool String Editor options. Another option to Add is select the too with the mouse Left click, 
then Mouse Left Click Over Add Button.  Once a tool has been selected the point at which it is to be inserted 
in the tool string is defined using the >>> buttons which appear to the left of the tool diagram. 
 



 

FIG: 4.5.5Add Tool  

 

4.5.1.3 Change Tool 
To change to another tool of the same type, right click on the tool and select Change to see a list of the serial 
numbers of available tools that can replace the one in the string. 
  

 

FIG: 4.5.6 Change Tool  

4.5.1.4 Tool Properties 
Mouse Right Click over the tool and select Properties. This will bring up the Tools Editor. The Tools Editor is 
used to create tools and to modify the physical properties of the tools used by the Warrior Software. This 
includes length, diameter, software modules used for logging, sensor offset, default filters, and software 
specific settings. The Tools editor will be discussed in further detail in the Utilities – Edit Logging Tool Details 
section of this manual.  
 
When editing has been completed, the tool string information is saved using the Save button. At this point, 
the service will be reloaded as the current status; and other parameters of the tool string may have changed. 
 
 



 

FIG: 4.5.7 Tool Properties 

 

FIG: 4.5.8 Tool Model Properties  

 

4.5.1.7 Variable Length Items 
To change the length of a variable length item, right click on the item and select Length from the pulldown 
menu. 
 

4.5.1.8 Options 
When clicking on the Options button, a few options appear below the tool tree diagram. 
These include the sensor offsets, where to break diagrams of long tools and the scale factor of the diagrams. 
  
For long tools, select the Break item option and then enter a break length. You may have to toggle the Break 
item checkbox to update to a new break length. This will draw any tool that is longer than the break length 
with a break in the middle so you can fit more objects in a smaller area. 
 



Choose a different Scale Factor to display the diagram at a greater resolution. 
The Show offsets checkbox displays all the sensor names in the tool string and their offsets. 
 

4.5.1.9 Print 
Any tool diagram will print to fit on one page. When another scale factor than <auto> is selected, two print 
choices are available. You can print to fit on one page, or you can print to scale. If you print to scale, the 
image may span multiple pages. 

 
FIG: 4.5.9 SAVE and Exit 

 

4.5.2 Edit – Variables 

 
The Variables Editor is invoked from the Acquisition Edit menu or from Warrior shortcut folder, double-click 
the Utilities icon. The Utilities menu box will appear, Click on the Edit Variables in a Dataset button.  It is 
used to enter and edit zoned Parameters for use by the logging system. When first invoked it appears like 
the window shown below in Fig. 4.5.32. Displays the Variable (parameter) editor window, enabling depth 
dependent parameters associated with the selected service to be zoned and values to be set. 
 
 

 

FIG: 4.5.10 Variables  

A file selection dialog box appears. Select the required database, followed by the log pass (dataset). The 
Variable Editor is displayed with the variables that were active during the logging session. 
In this case the well is shown as one zone from top to bottom. To define a new zone, press the Zones 
Button and a window will appear as shown below. 



 

FIG: 4.5.11 Add Zones 

 

FIG: 4.5.12 Set a New Zone 

Here boundaries may be inserted, and their positions changed, e.g. inserting a new change at 
1000ft results in two zones, one from the top to 1000, and one from 1000 to the bottom. 
Note: if the variable editor is started from the acquisition module when logging, then by selecting the 
Pick from Log checkbox, the depth of zone changes can be selected by clicking on the appropriate depth 
on the interactive plot. 

 
FIG: 4.5.13 Edit values and accept 

To change the value of the variable in a zone, TAB to or click on the variable and enter the New value. When 
all entries have been made Accept the changes and Close the editor. 
 



 

FIG: 4.5.14 Insert New Zone  

 

FIG: 4.5.15 Undo Zone 

 

FIG: 4.5.16 Accept and Close 

4.5.3 Edit - Heading 
Edit – Headings invokes the Warrior Heading Editor. This will be discussed in detail in the Heading Editor 
Section 

4.5.4 Edit – Master Log Format  
Edit – Master Log Format invokes the Warrior Format Editor. This will be discussed in detail in Format Editor 
Section 

4.5.5 Edit – Plot Job  
Edit – Plot Job invokes the Warrior Plot Job Editor. This will be discussed in detail in the Plot Job Editor 
Section. 
 



4.5.6 Edit - Sensors 
Brings up the Edit Sensor window. Once a service has been selected, the Edit Sensors window may be 
displayed and information concerning the individual sensors, associated with the service, may be edited. This 
information normally consists of the hardware source of the sensor (Device and Channel number), the depth 
offset of the sensor from tool zero reference, and the sampling rate. 
The information contained in Edit Sensors is derived from the current service and current tool string 
information. For example, sensor depth offsets are derived from the selected tool string and the information 
is contained in the tools database. The default sample rates and device channel assignments are derived 
from the services.ini file. 
The default device and channel settings, and the default sample rates are contained in the services.ini file. 
The default depth offsets are derived from tool information contained in the tools.ini file. 
Although the information in Edit Sensors is normally derived automatically from the information contained 
within the system, it may sometimes be necessary to modify or review a setting. 

 

FIG: 4.5.17 Edit Sensors 

Select Sensors from the Edit menu. The Edit Sensors window appears as shown below. 



 

 

FIG: 4.5.18 Edit 

Highlight one or more sensors and select Edit or double-click on a sensor item. The Edit Sensors dialog box 
will be displayed for editing as shown in Fig: 4.5.39. The acquisition device may be selected with the Device 
box. There are several acquisition devices supported within the Warrior system. Do not change this entry 
unless you know what you are doing. The channel of the device, from which the sensor is to be read, is 
selected by editing the Channel box. Do not change this entry unless you know what you are doing. 
The number of samples per foot to be recorded is entered in the Rate box. The maximum sample rate for a 
sensor is generally limited to the maximum rate set for the acquisition device acquiring the data. This 
maximum rate is set in the services.ini file.  
The physical depth offset of the sensor from tool zero is entered in the Offset box. Note that the value to be 
entered in Offset is the physical depth offset, as the system automatically compensates for any lags 
introduced by filtering. 



 
The change made in Edit Sensors will remain in effect until the service is reloaded; when 
the sensor parameters are returned to their default values. Sensors should not be edited 
during logging. Note that sensor cannot be edited while logging. 

 

4.5.7 Edit - Calibrations 
Warrior allows editing of sensor calibrations. The Warrior system supports many types of calibrated tool 
response. The calibration parameters may be derived from manual entries, or from calibration procedures, 
performed by the system itself. Some calibration parameters can be edited from Edit/ 
Calibrations. 

 

FIG: 4.5.19 Calibrations 

Select Calibrations from the Edit menu and double-click on the sensor to be edited. Alternatively, click once 
and select and Edit/Edit Selections. 
The tool type, serial number, calibration name and calibration type are displayed, but cannot be edited. The 
various calibration parameters can be edited and saved either permanently (with the Perm button) or 
temporarily (with the Temp button). See Fig: 4.5.20. 
OLE_LinkFig4 

Warrior stores calibrations internally in English units. When editing calibrations in this 
dialog, the reference values must always be entered in English units. 
Changes made and saved temporarily stay in effect until the service is reloaded, so 

when the calibration parameters are returned to their normal permanent values. Note that calibrations can 
be changed while logging. 



 

FIG: 4.5.20 Edit Calibrations 

4.5.8 Edit - Filters 
The Filters option displays filter settings and allows them to be edited. Four types of filter options are currently 
available in the Warrior system. 
 

 

FIG: 4.5.21 Filters 



These are: 
SQUARE is a simple average of the sensor value over the filter interval selected. 
GAUSSIAN is a weighted average, where the weights, applied to each sample over the interval, take the 
form of a Gaussian distribution. The filter interval is in feet, when recording in depth, and in seconds, when 
recording in time. 
TRIANGLE is another weighted average that accentuates peaks like the Gaussian filter. The Triangle filter 
is more extreme than the Gaussian. 
USER is a user-defined filter but is currently not implemented. 
Select Filters from the Edit menu and double-click (or single-click and Edit/Edit Selections) on the sensor, 
whose filter is to be edited. 
 

 

FIG: 4.5.22 Edit Filters 

The tool type and current filter parameters are displayed for the sensor selected. Typing over the parameter, 
shown in the Interval box, may change the interval. The filter type can be changed by means of the radio 
buttons. 
Note that changes, made here, stay in effect until the service is reloaded, so when the filter parameters are 
returned to their default values. Default filter settings are contained in the tools file as part of the tool model 
information. Filters cannot be edited while logging. 
 

4.5.9 Edit - Tool Configuration 
 

 



FIG: 4.5.23 Tool Configuration 

4.5.9.1 STD Tool Configuration 
The STD tool is normally in every service. The line resistance used to calculate HVOLTA (Head Voltage 
Apparent) can be edited from here. 

 

FIG: 4.5.24 Set Line Resistance 

4.5.9.2 CCL Control 
The CCL software produces 2 outputs: 
 
CCL Casing Collar Locator 
CCLRT Real Time Casing Collar Locator 
 
The real time output bypasses the normal sampling queues so that changes can be seen immediately. The 
CCL software incorporates a facility to affect a shift of the CCL curve, as is sometimes required when running 
perforating services. The collar log may also be “filtered” in such a way as to remove noise from the baseline 
of the curve while still allowing collar signals above a certain threshold to be displayed. 
When in Acquisition mode, and with a collar tool in the string, the CCL Control box may be displayed with 
Edit/Tool Configuration/CCL. 

 

FIG: 4.5.25 CCL Control 

Shift  - CCL 
Bring up the CCL Control box as described above. 
Set the amount of shift required in the Step Size dialog. The value entered here should reflect the actual 
scale set for the log. For example, if the log is scaled at 1 volt per track and it is required to shift the curve 10 
(small) divisions, enter a value of 0.1. 
Clicking the Left or Right buttons produces the shift and the cumulative amount of shift applied appears in 
the Current Total box. Note that [<<Left] changes the CCL output by a negative value and [Right>>] changes 
the CCL by a positive value so that left and right only apply is the CCL plot is scaled with a negative value on 
the left and a positive value on the right. 



 
Threshold -  CCL 
Invoke the CCL Control box and set the Threshold Enabled. Click on Setup and adjust the threshold settings 
as required. 
The Positive and Negative Thresholds are set in the same units as the collar log output curve. Any collar 
curve signal smaller in amplitude than the threshold settings will be suppressed to a value of zero. Any signal 
greater than the threshold levels will be recorded as its true value. 
 

 
FIG: 4.5.26 CCL Thresholds 

Clamp - CCL 
The Positive and Negative Clamps cut the signal at the set point value. Any collar curve signal bigger in 
amplitude than the clamp settings will be set to clamp value. 
 

 
FIG: 4.5.27 CCL Clamp Limits 

Baseline Normalization - CCL 



Invoke the CCL Control box and set the Baseline Normalization Enabled. Click on Setup and adjust the cycle 
length (must be greater than 0) and the offset settings as required. 
The system will attempt to correct a CCL baseline to a value of zero and then recheck it every cycle length. 
 

 

FIG: 4.5.28 CCL Baseline Zeroing Setup 
Select Setup, and type in Cycle Length  2  left in Zero Current/Starting Offset. 
Click over OK 
Check on the Enable box, and Click on Setup, you find the new value in Current/Starting Offset 
 

 

FIG: 4.5.29 CCL Baseline Zeroing Setup 

4.5.10 Edit - Device Configuration 
 



 

FIG: 4.5.30 Edit - Device Configuration 

 

Base Configuration 
Depending upon the panel type, the base device may be one of several different devices. The most common 
device is the CYSTD used in the standard interface panel. In most cases the card type will be read from the 
panel and need not be changed. 

 

FIG: 4.5.31 CYSTD configuration 

 
Do not change any settings here, unless you know what you are doing. 
 

 
DSP Configuration 
The current Scientific Data Systems Warrior Interface panel has no User controllable device settings. 
  
 
SDSTIP and CBL1D Programmable Filters and Gain Controls 
Most line signals, other than low frequency CCL signals, are filtered and amplified through the CBL1D board 
of the Scientific Data Systems, Inc. Tool Interface Panel. There is a single input to the CBL1D Board from 
the ANASW board, but it has three separate outputs, commonly referred to as Sync, Sonic, and AUX. Each 



of these outputs has separate gain controls and programmable variable filter controls. Which sliders and 
filters are available are controlled by settings in the SDSTIP device in the service and saved in Services.ini? 
Each of the Sync, Sonic, and AUX output channels has a programmable attenuator that is controlled through 
the software by a slider bar in the panel controls. This is necessary to keep the signals from saturating during 
later stages of filtering and amplification. During normal operation, these are all that is necessary in a service 
to control the signal gains.  

 
FIG: 4.5.32 Panel Controls 

Each of the three channels also has a variable filter that can be set or adjusted. It is not normally necessary 
to adjust these filters once a service has initially been set up on a logging unit. Access for  
adjustment of these filters is obtained through the Acquisition Software by selecting Edit -> Device 
Configuration -> SDSTIP. 
 

 

FIG: 4.5.33 Device Configuration 

 

 



 

FIG: 4.5.34 SDSTIP for older CBL1D boards and for Revision 13 and newer 

Each of the output channels has its own Gain, Q, Corner  or Center Frequency, and whether it has a Band 
Pass or High Pass output. In addition to this, the Sonic channel has a pre-filter to keep the initial input 
attenuator from saturating. This pre-filter is turned off with a 0 value and is turned on with a value of 8. No 
other values will work. You will get no sonic signal with any value other than 0 or 8. 
The Sonic and Aux channels will normally be set  to filter a pulse signal, so they will usually have a High Pass 
filter with as low a corner frequency as possible. The gain for these channels should be set so that the slider 
bar gain control has a good setting for the service at near mid-range. 
The Sonic channel will normally be looking at acoustic signals in the 20000 hertz range and should be 
selected as a Band Pass filter. 
The Q of the filters is related to the how much frequency change is needed to attenuate the signal by 3DB. 
The larger the number, the less change from the Fc is needed to attenuate the signal. 
The CBL1D Revision 13 and newer boards no longer have the programmable filter on the AUX channel. 
Instead, it has a set of 3 equalization filters in series. Any combination of the equalization’s filters may be 
selected from none, to any one, to any combination of two, to all three filters. 
 
The following Internet link gives simple explanations of filters and their characteristics. 
http://en.wikipedia.org/wiki/Electronic_filter#Multipole_types 
 
The different hardware revisions of the CBL1D board require that the correct panel type be set in the Warrior 

Control Panel for the CBL1D board to respond to slider bar and filter settings. Revisions 
R1 through R4 will normally have a panel type that ends with the letter a (CPFA). As of 
this date, Revisions R5 and higher will have panel types that end with a B, C, D or E 

(CPFB – CPFE). 
If the service has a Signal type Control Keyword, the filter settings may change depending upon the Cable 
Selection in the Warrior control Panel. This is discussed in further detail Section 16 – Cable Types and Filter 
Settings. 

4.6 Acquisition - Monitor 

Once a service has been selected, various data monitors are available to the operator as shown in Fig. 4.6.1 
below. 
 
 

http://en.wikipedia.org/wiki/Electronic_filter#Multipole_types


 

FIG: 4.6.1 Monitor Sensors 

4.6.1 Monitor - Sensors 
The sensors for the selected service are displayed along with the values of their current readings. 
The sensor monitor is used to monitor `raw' data. Select Monitor Sensors from the Edit menu. The 
Sensor Monitor will be displayed. The sensor monitor is updated at the refresh rate set in the Warrior Control 
Panel. 

 
 

FIG: 4.6.2 Sensors 

4.6.2 Monitor - Outputs 
The outputs for the selected service are displayed along with the value of their current readings in engineering 
units. Select Monitor /Outputs from the menu. The Outputs monitor is displayed as shown in Fig: 4.6.3. 
When in a logging mode, e.g. Record Up, the readings are updated at each depth sample. When not in 
logging mode, the outputs are updated at the frequency set in the Control Panel. 
 



 
 

FIG: 4.6.3 Outputs 

 
Monitor  - Outputs - Gauges 
Another function of monitor output is the ability to add a meter to a service. With the Monitor – Output window 
open, right click on any output in the list. You will be given a choice of 4 types of gauges to use. They are 
Angular Gauge, Histogram Gauge, Bar Gauge, and Numeric Gauge. The gauge will remain on the windows 
desktop until closed. However, the next time the service is reloaded the gauge will return to the windows 



desktop. To permanently remove gauge from the service, Monitor – Outputs again, right click on the gauge 
that you want to remove from the service and choose the Delete Gauge option. 

 
FIG: 4.6.4 Outputs – Adding / Deleting a gauge to a service. 

The properties of the gauge can be modified by right clicking on the gauge. 

 
FIG: 4.6.5 Changing the properties of a gauge 

 



 
FIG: 4.6.6 Gauge properties 

 

 
FIG: 4.6.7 Examples of various Gauge types available. 



 
 
Monitor - Sample Queues 
Monitors the status of the internal Warrior sample queues. 
 

4.6.3 Monitor – Tools 
Some tools may have special monitor windows, such as bond tools. The window will be used to monitor and 
setup measurement parameters for those tools. 
 

 

FIG: 4.6.8 Monitor Tools 

 

FIG: 4.6.9 Monitor CS8SCBL 



4.6.4 Monitor - Devices 
Displays the raw data readings of the selected device, channels, irrespective of whether channels are being 
used for the current service. 
 

 

FIG: 4.6.10 Monitor Devices 

 

Monitor – Devices - Base  
If the base device is the CYSTD, the 16 possible analog inputs and 4 counter channels will be shown. Note 
the several of the channels are named for their inputs. 

 



FIG: 4.6.11 Base (CYSTD) Values 

Monitor – Devices – DSP 
Depending upon the DSP script used in the service, the DSP monitor may show a variety of different things 

  

 

FIG: 4.6.12 Example DSP monitors.  

Monitor – Devices – LOGSVC 
The LOGSVC device is a software device used for processing depth and line speed. 

4.6.5 Monitor – Hoistman’s Display 
 

The Hoistman’s display can be loaded by clicking on Monitor / Hostman’s Display or the Hoist button in the 
Depth Control window. Activating the popup menu can configure the view and scales. Do this by right 
clicking on the display and selecting the required menu option. Sound alerts for various conditions can also 
be configured here if a suitable sound card and speaker are available. 
Note that in multi-monitor systems, the Hoistman's display can be positioned on a second monitor close to 
the winchman. 
 

 



FIG: 4.6.13 Monitor Hoistman’s Display  

 

FIG: 4.6.14 Hoistman’s Display 

Click Config. 
 

 

FIG: 4.6.15 Set up Depth Configuration 

Right click over the gauge to select Gauge Properties 
 



 

FIG: 4.6.16 Set Gauge Properties 

  



 



5 Heading Editor 

The Heading Editor allows the log heading information to be added to a blank heading of pre-existing format. 
There are several different versions of default headings that can be produced using Warrior. 
The Heading Editor may be started from several different locations including its icon in the Warrior program 
group, the Acquisition module under the Edit -> Heading, and  Interactive Plot under Edit -> Log Heading. 
.  

 

FIG: 5.1 Heading Editor in Warrior Program Group 

Section 

5 



 
FIG: 5.2 Select Heading from Acquisition -> Edit 

 

FIG: 5.3 Select Heading from Interactive Plot  -> Edit 

Headings are saved within and retrieved from Warrior databases. Headings generated during a logging 
operation, are normally saved in the same database as the log data for that job. When the Heading Editor is 
started, a blank heading appears. Headings can be filled out at any time during the job and saved. If the 
heading is only partially completed, it can be saved and reopened at later time and remaining information 
entered. It should then be saved again. 



 

FIG: 5.4 Blank Heading (STDCased) 
The default heading format is set from the Warrior Control panel – Plot page. In addition, the heading format 
may be changed for the current heading by clicking on File -> Select Format in the Heading Editor. 

  

FIG: 5.5 Selecting heading format 

 



From the Heading Editor File menu, either a new heading can be created, or a pre-existing heading may be 
selected for editing. In addition, the actual format of the header may be selected from the predefined formats 
in the system by using Select Format.... Once a heading has been selected, fields may be chosen for editing 
by using the TAB key, or by pointing with the mouse to move around the heading. When a field has been 
selected, a dialog box appears, and the appropriate information may be entered. 

 

FIG: 5.6 Heading Data Field for the Log Title 

Headings are saved within and retrieved from Warrior databases. Headings generated during a logging 
operation are normally saved alongside the log data for that job. 
The description of the text to be typed in the field normally appears above the dialog entry, and the cursor is 
positioned for immediate text entry. When the text entry is complete, hit Enter to close the dialog window and 
move to the next field. Alternatively move to the OK button by using the TAB key or the mouse, and then hit 
Enter or click with the mouse. Then either hit the Enter key to open the next dialog window or click with the 
mouse to move to and open a new dialog window. 
 

 

FIG: 5.7 Enter single line of information 

Fields which have multiple lines are completed using a slightly different dialog box as shown in Fig. 5.8. Use 
the TAB key or the mouse to move to the text entry box and enter the required text. Pressing the Enter key 
while in the text field will add a new line of text. 
 



 

FIG: 5.8 Multiple line Entry – Click in field to Type Log Name 

 
Do not hit Enter within the text entry box unless you wish to move to a new line within 
the current field, as for example, if multiple lines of text were to be entered in the 
Comments field. 

 
When the text is complete use the TAB or mouse to move to the OK button and exit the dialog box as normal. 
 
The User can Save the heading by clicking File -> Save. It may be necessary to select a database file to 
save the heading into. If so, be sure to select the database where you will be recording log passes. 

 
FIG: 5.9 Saving Heading 

If no heading has been saved in the database, the software will use heading1 as the default heading name. 
Normally if you are only going to be plotting one log, the default need not be changed. The default name can 
be changed by backspacing out the “heading1” or highlighting the “heading1” and replacing it by typing. 



 
FIG: 5.10 Saving Heading – heading1 as default name 

 
 

 
FIG: 5.11 Saving Heading – changing heading name 

To save the modified heading under a different name use Save As from the File menu and enter a new 
name for the heading. The original heading will remain in the system under the original name.  
.11 Type the new Heading name File 

5.1 Heading Logo 

The logo accepts formats  * .lgo, .*.wmf, *.emf, *.bmp, *.jpg. The file must be in Warrior\Config. 
In a Warrior standard heading, it should have the ratio 1 high by 2 wide to keep the proportionality with respect 
the original one.  
To change or remove the Logo, just Mouse Left click on Logo Box. 
 



 

FIG: 5.12 Edit Logo 

 
FIG: 5.13 Select the new Logo 

 

5.2 Heading File Creation 

Warrior creates headings by reading a text file that has a .hdg extension. The contents of these files can be 
viewed by using Windows Notepad. There are several different heading styles that are supplied with the 



Warrior software (stdcased, stdopen, and greytest). The purpose of this document is to supply the information 
need for the user to write his own .hdg text files. 
--------------------------- 
The first two lines of the file define the physical size of the heading in inches as plotted. The width of the 
heading is the length of the plot from the plotter. The height is the width of the heading, with 8.25 being the 
standard API log width. 
Width 10 
Height 8.25 
--------------------------- 
You must define panels to make the separate sections of the heading. Pictures, text, text edit fields, and 
panels may then be placed in the panels. Two pairs of x,y coordinates define the location of a panel as a 
percentage (0 to 100) of the current panel. The contents of the panel are enclosed in curly brackets. 
Panel x1, y1, x2, y2 
{ 
Panel Contents 
} 
--------------------------- 
The Border statement defines the thickness of the panel edge. The larger the integer N, the thicker the border 
will become. 
Border N 
--------------------------- 
The Font statement defines the font size of any text that is printed within a panel. The larger the integer N, 
the larger the font size. 
Font N 
Both the Font and the Border statement control the effects of the panel that they are in and all panels that 
are included in that panel, unless the included panel contains Font or Border statements, which are then 
used for that panel and any panels that it might include. 
--------------------------- 
A picture may be placed within a panel. The location of the picture is defined by two sets of x and y 
coordinates as a percentage of the current panel. The name of the picture must be declared under the 
heading section of Warrior.ini. 
Picture x1, y1, x2, y2 {NAME} 
--------------------------- 
Text may be placed within a panel. The location of the text is defined by two sets of x and y coordinates as a 
percentage of the current panel. Previous font statements determine the size of the text. The orientation of 
the text is determined by a four-letter code - OTHV. The O is the orientation of the text, the T is the type of 
text, the H is the horizontal centering, and the V is the vertical centering. Text strings that are larger than the 
area specified may have unpredictable results. They might be truncated or extend outside of the defined 
area. Multiple line text will automatically wrap at a word boundary if the text exceeds the area length. 
O  H - Horizontal Text 
V - Vertical Text 
T  S - Single line of Text 
M - Multiple line of text 
H  L - Left justify for horizontal text, Bottom justify for vertical text  
C – Center Text horizontally 
V  T - Top justify for horizontal text, Left justify for vertical text 
C – Center Text vertically 
TextOTHV x1, y1, x2, y2 "TEXT" 
--------------------------- 
An editable field may be placed within a panel. The location of the field is defined by two sets of x and y 
coordinates as a percentage of the current panel. Previous font statements determine the size of the text. 
The orientation of the text is determined by the same four-letter code - OTHV that is used with text. A hint 
name for the field is enclosed within curly brackets. A hint line is then added (normally at the end of the file) 
that will give a hint text to the user when he clicks on the field. 
 



EditOTHV 0,0,100,100 {Hint Name} 
hint "Hint Text" {Hint Name} 
 
--------------------------- 
 
The following examples are the only commands that are in *.HDG and *.WLB files for headings and well log 
banners. 
 
Width 10 
Height 8.25 
Panel x1, y1, x2, y2 {Panel Contents} 
Border N 
Font N 
FontfaceN “style” 
Picture x1, y1, x2, y2 {NAME} 
TextOTHV x1, y1, x2, y2 "TEXT" 
EditOTHV 0,0,100,100 {Hint Name} 
hint "Hint Text" {Hint Name} 
Comments 
 
 

5.3 Headings LOG Banners File Creations 

In addition to heading files (*.HDG), well log banners (*.WLB) use the same form of text file but when printed, 
the orientation is rotated 90 degrees. Thus, a heading has a height of 8.25 inches and a banner has a width 
of 8.25 inches. 
Pipe Tally Tables (*.WRF) also use a similar format with some variance. The mode of entering user 
information is quite different. 
Comments may be placed anywhere in the file. Comments normally have // as the first two printable 
characters on a line.  
 

5.4 Pipe Tally Tables 

Pipe Tally Tables have a few additional commands and the mode that Edit text commands gets their data is 
different. The edit text fields are pre-defined rather than defined by the Hint Command and are filled from 
editing the heading information of the pipe tally table, editing the grading of the settings, and from processing 
the log. The predefined fields are as follows: 
 
{CONAME} – Company Name from Edit – Heading Information 
{WELLNAME} – Well Name from Edit – Heading Information 
{FLDNAME} – Field Name from Edit – Heading Information 
{COUNTY} – County from Edit – Heading Information 
{STATE} – State from Edit – Heading Information 
{DATE} – Date from Edit – Heading Information 
{COMMENT} – Comments from Edit – Heading Information 
{RANGE1} through {RANGE6} – Maximum of six grading ranges from editing 
Settings - Grading 
{SYMBOL1} through {SYMBOL6} – Maximum of six grading ranges from 
editing Settings – Grading 
{GRADECNT1} through {GRADECNT6} – Count of the number of joints of 
that grading acquired from Scan Minimum Wall Log 
{RWBC_LVAL} – Bar Chart Left Value from RWBC_LEFT of Warrior.ini 
{RWVC_RVAL} – Bar Chart Right Value from RWBC_RIGHT of Warrior.ini 



{RWUNIT} – Units of curve from Scan Minimum Wall Log 
{NOX} – Number of Joint X from Scan Minimum Wall Log 
{DEPX} – Top Depth of Joint X from Scan Minimum Wall Log 
{LENX} – Length of Joint X from Scan Minimum Wall Log 
{RWX} – Remaining Wall of Joint X from Scan Minimum Wall Log 
{PLXX} – Percentage Loss of Joint X from Scan Minimum Wall Log 
{PLFX} – Percentage Left of Joint X (100-PLXX) 
{RWBCX} – Remaining Wall Bar Code of Joint X for Bar Charts 
{GRX} – Grade Symbol of Joint X from Range and Symbols above and scan 
There are three addition command that are used to create *.WRF pipe tally tables. 
 
They are as follows: 
 
Recount N 
This line must be in the first 512 characters of the WRF file (normally place just after the Width and Height 
commands). It is a count of the number of joints to be shown on each sheet as the file is printed. 
 
barchart x1,y1,x2,y2 {RWCBZ} 
Charts bar code for Joint Z on RWBC_left to RWBC_right Scale 
 
The Bar graphic default can be changed from by editing the Wproperties file.  
Open Wproperties with notepad and search for [Heading] if the line BarChartCode is not present add it an 
select a grayscale for the output. 
 
[Heading] 
BarChartCode= 
 

0 white  
1 light gray 
2 gray (default) 
3 dark gray 
4 black 

 
editHSCCB 0,0,100,100 {GRZ} 
Prints Grade symbol for Joint Z horizontal centered both vertically and horizontally on a colored background. 
The color of the background is defined in Warrior.ini [Heading] section. 
BkColorMap=grade1,{color1},grade2,{color2}, etc. 
Where grade {x} is the symbol for a grade and color {x} is R, G, B set 
 



6 Format Editor 

The Format Editor allows the creation and editing of the log presentation or format files. The output of the 
format editor are files of the type *.prs which are subsequently used to control all aspects of plotting acquired 
data. The Format Editor may be started in three different ways: From its icon in the Warrior program group, 
from the Edit menu of the Acquisition or Recalculation modules, or from the Action menu of Interactive Plot. 
In addition, double-clicking in the scales area of the Interactive Plot window will also start the Format Editor. 
When started from the Warrior program group the Format Editor window will open with no presentation 
available for edit. Any presentation that is opened from there will be opened in Master Format mode so that 
any changes that are made will be permanent. If started from the Acquisition or Recalculation the Master 
copy of the presentation as declared in the current logging service will be opened. For Interactive Plot 
modules, the log format currently being used will be presented.  
  
 

 
FIG: 6.1 Select Format Editor from Warrior program group 
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FIG: 6.2 Select Format Editor from the Acquisition window 

When the Format Editor is opened from the Acquisition or Recalculation window, the format specified in the 
current service in the services.ini file is opened in the Master Format mode. Any changes that are made will 
be permanent to that Master Format. If a private copy of a presentation using that format has been saved to 
a database, no changes will be made to the private copy. 
 

 FIG: 6.3 Select Format Editor from the Interactive Plot window 

The Format Editor can be opened from three different places in the Interactive Plot window. If you click Edit 
-> Log Format…, Click on the second icon on the Presentation Plot screen, or double click on the log scales, 
the Format Editor will open to the current presentation format. 
 
When the Format Editor is invoked from Interactive Plot, changing the log format and saving it causes the 
active screen plots to be re-plotted with the new format. Note that many screen plots may be overlaid on 
each other at any one time. If a large number a plot are present, a noticeable delay will occur while all are re-
plotted. 
 
Before going any further we should discuss the difference between a Private Copy of a presentation and a 
Master Copy of a presentation. The Master Copy of a presentation is a file kept in the Warrior\Format folder. 
When a log pass is started from Acquistion, normally a copy of this file is placed into the Warrior database. 
This becomes the private copy that will be edited any time the format editor is opened from the interactive 
plot. Whether the private copy is used in a service or not is controlled by the service. In the Service Editor, 
there is a box “Use private copy of a presentation for all logs from this service”. If this box is checked then the 



private copy will be placed in the database. Otherwise, the will be no private copy and the master copy will 
be used at all times. It is recommended that the “Use private copy of presentation for all logs from this service” 
box be checked in all services. 

 
FIG: 6.4 Selecting Private copy of presentation in the Service Editor 

 
When Format Editor is opened from the Warrior Program group, no presentation is shown. To edit a 
presentation, you must first select a presentation and open it. To do this, click on the [Open] button. Or build 
a presentation from the beginning, including the grid layout. 
 

 
FIG: 6.5 Open Format 

This will display a file selection window showing all the presentation files, currently available, within the 
system. The operator can select the presentation file to be edited. Note that all presentation files are to be 
found in the \warrior\format directory and have a prs extension. 



 
 
FIG: 6.6 Select Presentation Format to be Edited 

From the Acquisition or Recalculation modules select Edit -> Master Log Format. The log format specified in 
the currently selected service will be presented. Note that when the master presentation is edited, if a private 
copy of the presentation has been created in the dataset, changes will not be made to the private copy.  

 
 
FIG: 6.7 Select Master Log Format 

6.1  Editing a Log Format 

The Format Editor provides the User a means to graphical display data. Any data or variables in a pass, 
either recorded or imported from external data, can be displayed using one of a few different layout 
presentations, or the User can create his own layouts. Fig. 6.8 below shows a sample presentation for a 
radial bond log. 



 
FIG: 6.8 Example presentation 

6.1.1  Editing a Data Item 
To edit the plotting parameters of an existing curve, click on the curve shown and then click the [Change] 
button. Optionally, if you double click the curve it will also open the Define Data Item dialog window for curve 
editing. 

 
Fig. 6.9 Define Data Item dialog window for curve editing. 

The DB Item should be a valid Warrior Data Mnumonic or Warrior Variable but the software does not check 
to see if the entered DB Item is valid. If the DB Item does not exist in the current pass, the software sets up 
the DB Item named to be plotted but no curves or curve label are shown in the plot.  



If the Format Editor is invoked from a Presentation Plot there will be a [Current Pass] button under the DB 
Item entry box. Clicking on the [Current Pass] button will show a list of all of the plottable  items in the current 
pass. The [Quick Pick List] provides a list of commonly used DB items, but is by no means a complete list of 
possible DB items. 

 
Fig. 6.10 Partial list of Data Items from a log pass 

There are three basic types of DB items that can be plotted. The most common is a data item that is usally 
an output. Any of the log variables may be plotted as a variable. The list type would be an array of curves or 
the same type such as caliper arms or sector amplitudes. 

 
Fig. 6.11 DB Item Types 

 
The curve may be put into any track that is defined in the current grid layout as shown at the bottom of the 
window. Note that the track numbers do not necessarily conform to any API standard. The track number can 
be changed by typing in the track# window or by using the scroll bar buttons next to the window. The 
presentation may use any of the predefined  layouts or the User may edit or build his own layouts, as will be 
discussed later. 
 



 
 

 
Fig. 6.12 Assigning curves to a track 

The presentation type to be plotted will depend upon the data that has been selected. Most data and variables 
will be plotted using a curve or a Tabular list of the data. Waveform data will normally be presented using a 
Variable Density or Signature. 
Pattern strips represent the values using a color pattern. Certain items such as Well Objects are plotted as a 
graphic strip. Caliper arrays can be plotted as a 3D image. Caliper cross sections and other items would be 
plotted as potato plots. 
 

 
Fig. 6.13 Presentation types 

6.1.1.1  Plotting Data Item as a curve 
When a data item or variable is plotted as a curve, there are several other options besides the track and the 
scale values. These options include the color of the line, the thickness, and the dash pattern.  
The curve may also be plotted logarithmically between the scale values (Note that curves are plotted 
regardless of the grid layout that is in that track).  
The Wrap option allows a curve to re-enter the track from the opposite side if it has exceeded the scale value.  
Zonable scales allows the user to set the scales to different values through different depth intervals on the 
log pass.  The values and depths are entered through the “Edit -> Zoned Scale Changes …” option in 
Interactive Plot. 



 
Fig. 6.14 Curve Style Options 

6.1.1.2  Plotting Data Item as a Tabular Value 
Scalar database items and variables may also be plotted as tabular data. The track is selected from the Grid 
Layout as before, but in this case the scales are not used. The color chosen will be the color that the tabular 
text is printed. The tabular data can be plotted in the left, middle, or right position of the selected track. The 
number of decimal places to be shown can be selected. If the data is plotted by interval, the interval between 
samples shown on the log can be selected. If the data is plotted by data, the delta change of the data can be 
selected, with the data being displayed whenever the amount of change has been reached. As with plotting 
a curve, the label may be changed from the Warrior mnemonic and whether the label and units are shown 
on the scale inserts can be selected. The Range, like the scales, is not used in this instance. 

 
Fig. 6.15 Tabular Listing Style Options 
 
6.1.1.3  Plotting Waveform Data Item as a Variable Density 



Database items that are digitized waveforms can be plotted as either a Variable Density or as a Signature. 
The track is selected from the grid layout in the normal manner. The left and right scales are the sample times 
in microseconds. If scale values are selected that are out of the digitized range of the data item, then the 
maximum digitized value is used. 
When waveforms are plotted as a variable density, normally the Percentage of the waveform windows 
maximum size is used. The Percentage of Black level and White Level set the levels to change to the last 
shades of the color map. As an example, if the color map had black, white, and three shades of gray between 
them, and the percentages were both set to 40%, then when the signal height gets greater than 40% or 1.0 
volts positive the signal will be black, between 40% and 20% the first shade of gray, between 20% and -20% 
the second shade of gray, between -20% and -40% the third shade of gray, and at greater than -40%, or 1 
volt negative signal, will be white. The percentages should be kept approximately equal if a small number of 
different shades are in the color map to keep the baseline in the middle shade. Note that by lowering the 
percentages, this in effect increases the contrast of the signal, making very small signals visible. 
Constructed waveforms made from array of data, such as sector maps made from the individual sector 
amplitude data, may also be plotted as a variable density. In this case, if Specific Values is chosen, then the 
calibrated output value of the data is used to set the upper and lower limits. If we use limits of 10MV and 
60MV and a map with black and white and three grays, then when a sector amplitude is less than 10MV, that 
section of the map will be black. When a sector amplitude is between 10 and 23.3, the first shade of gray will 
be shown. When a sector amplitude is between 23.3 and 36.6, the second shade of gray will be shown. 
When a sector amplitude is  between 36.6 and 60, the third shade of gray will be shown. And when a sector 
amplitude is greater than 60MV, that section of the map will be white. 
In addition to the options for labeling the scale insert as before, the User has the option to show the mapping 
in the insert or not. 

 
Fig. 6.16 Waveform Variable Density Style Options 

 
6.1.1.4  Plotting Waveform Data Item as a Signature 
Waveform data can also be plotted as a signature. The scales are the time in microseconds of the waveform 
capture as with a variable density and are limited by the actual time of the capture. 
The User has the options of scaling the relative height of the waveform in the presentation and the interval of 
how often the curve is plotted. The interval is in the units of the log, feet or meters. The positive portion or the 
negative portion of the waveform can be selected for shading. The waveforms can also be presented using 
a logarithmic gain and / or with waveform maximum readings all normalized to the same value. The position 
of the waveform in the track can be shifted by entering a Vertical Skew value in the depth units. 



  
Fig. 6.17 Waveform Signature Style Options 

 
6.1.1.5  Plotting Data Item as a Pattern Strip 
Data item may also be plotted as a pattern strip. Rather than plotting a curve, the data is shown as a band, 
or strip that changes shades or colors to indicate relative value across the whole width of the track that it is 
plotted in. The left and right values are the maximum extents of the color map used for shading. The last 
colors of the color map are used if the scale values are exceeded. An example of a bond amplitude curve 
used to indicate good bonding or poor bonding is shown in the figure below. 
It is possible for the shading to be composed of one of the 25 different shading patterns that Warrior Software 
uses for the shading of logs. However, at the present time this requires hand editing of the color map in the 
Warrior.INI file. If this should be needed,  contact Scientific Data Systems for further instructions. 



 
Fig. 6.18 Plotting Pattern Strip  
 

Fig. 6.19 Example Plotted Pattern Strips for Amplitude data 

6.1.1.6  Plotting a Graphic Strip 
Graphic strips are used to plot well objects created by the Well Object Editor. These are normally created by 
using Edit -> Well Sketch. The allows the User to create a Well Sketch containing perforations, plug, packers, 



tubing, etc. and placing them in any defined track in the grid layout. The DB Item selected to be plotted is 
WELLOBJ. 

 
Fig. 6.20 Plotting a Graphic Strip 

 

6.1.1.7  Plotting a Image 3D 
A graphical 3-dimensional image can be plotted in the specified track. This is usually a representation of 
something like the casing taken from the readings of a multi-fingered caliper log. The software allows you to 
represent any array data as a 3D presentation, there is a Non-Caliper checkbox that should be checked if 
the array is not caliper data. The left and right scale values are not used in this instance, the scale values 
shown are taken from the image properties. Click on the [Image Properties] button to open the image 
properties dialog. 
By clicking on the [Edit Variables] button, the Casing O.D. and Casing I.D. will be updated. These variables 
are what set the shown left and right scale values of the presentation. 
 

 
Fig. 6.21 Plotting a 3D Image 



 
 Fig. 6.22 Plotting a 3D Image – Image Properties 

6.1.1.8  Plotting a Potato Plot 
A potato plot is used to plot a graphical image such as a cross-section diagram from a multi-fingered caliper 
or a dip meter histogram. As with a 3-D image the image is placed in the appropriate track, but the scales 
have no relevance. 

 
Fig. 6.23 Plotting a Potato Plot 



 
Fig. 6.24 Potato Plot Presentation options 

6.1.1.9  Plotting a List Item 
By selecting the List data type, the user may plot a list of curve that are sequentially numbered and have the 
same prefix ( caliper arms – R0, R1, . . . and Sector Amplitudes – AMPS1, AMPS2, … as examples) as a 
single presentation entry. 
The track # needs to be a valid grid track as before. The scales values should be selected as if a single curve 
were to be plotted in the track.  
 



 
Fig. 6.25 Plot a List of Curves 

 
When you click on the [Curve List Properties] button the Curve List Editor dialog window will come up. 

 
Fig. 6.26 Plot a List of Curves Properties 

 
By clicking on a curve name or mnuemonic, the list of related curve names will be shown with the * appended 
as a wild card character(s). The style for thickness, dash pattern, color, and other selections are chosen as 
normal with the expection that the selected style (exceot for color) applies to all of the curves. Every nth curve 
may be selected to have a differnet color other than the base color selected in the style.  
The offset between each curve can be entered to separate the curves in the presentation. The offset has 
several effects. As an example, let us say that the original left and right scale values are 0.0 and 10.0, and 
we use and offset of 1.0. Each time an additional curve is picked up the presentation changes by the amount 
of the offset. When the first curve is added, the overall track scaling changes to 0.0 to 11.0, with the first curve 
plotted from 0.0 to 10.0, while the second curve is moved or by the the offset of 1.0 and then plotted from 1.0 
to 10.0 making the total track width of 11. When the second curve is picked up, the effective grid scale 
changes to 0.0 to 12.0 to accomadate the additional 1.0 offset of that curve. This continues untill all of the 
curves that are chosen are picked up by the presentation. Although each curve is plotted to the left and right 



scal values specified, the overall scales of the grid itself are the scale width plus the number of curves minus 
one times the curve offset. 
 
 

6.2  Format Editor - Grid Layout 

 
The grids or mattes that are used in the Warrior Software are extremely flexible. 20 different styles of tracks 
may be placed anywhere on the page. The layout is not a fixed width so that when the plot is printed it will fit 
on whatever width paper is used in the plotter from narrow 1 track plotters up to 17” or wider plotters. 
To choose a different layout, click on “Layout” and the available list of grid layouts will drop down. Click on 
any of the layouts available, and that layout will then be shown at the bottom of the Format Editor window. 
When the new layout is chosen, the track numbers as shown in the format editor may change significantly. 
This may cause many of the data items plotted as curves to lose their assigned tracks. It is a good idea to 
check at least one curve as this will show where all the curves would be plotted. 

 
Fig. 6.27 List of grid layouts available 

 

6.2.1  Format Editor - Grid Layout Editor 
Even with the supplied list of grid layouts, it would be impossible to have a list long enough to accommodate 
all the possibilities of layouts the might be desired. To this end, the User can create and save his own grid 
layouts. At the bottom of the layouts list is the Edit Layout option. Click on Edit Layout to bring up the Layout 
Grid Editor.  
There are two modes that the Layout Grid Editor can be entered. The first is a custom mode that allows the 
grid layout in the existing presentation to be edited. This mode is entered by as soon as the Format Editor is 



opened clicking on “Layout -> Edit Layout”. The second mode allows you to edit the Master Layouts list that 
shows all the available layouts. This allow the User to Rename layouts,  delete layouts, change the order of 
the list by moving the layouts, and to copy an existing layout and giving the copy a name thereby creating a 
new layout.  

Fig. 6.28 Layout Grid Editor 

 

6.2.1.1  Layout Grid Editor - Editing tracks 
 
The width of the layout goes from 0 on the left to 100 on the right. When the log is plotted, the presentation 
will cover the width of the plotter regardless of the plotter width. Each track can be specified to be any width 
and be placed in any position on the page. When the track is highlighted in the Tracks column any of the 
existing grid styles may be applied to that track. 

 



Fig. 6.29 Editing an existing layout 

Tracks may be added or removed from the layout by clicking on Track -> Add ( or -> Delete). By clicking on 
the [Redraw grid] button, the grid track changes that have been made. 
 

 
Fig. 6.30 Adding or Deleting Tracks  

 

6.2.1.2  Layout Grid Editor - Editing List of Layouts 
 
By clicking on Grid Layout, the User can edit the list of displayed grid layouts.

 
Fig. 6.31 Editing the list of grid layouts 

 
By clicking on “Rename”, the current name of the grid selected will be shown. By typing the new name of the 
grid in the box and selecting [OK] the grid will be renamed. 

 
Fig. 6.32 Renaming a grid layout 

 
If “Delete” is selected, a verification window will open to confirm the deletion and to prevent accidental 
deletions. If [Yes] is clicked, the selected layout will be deleted from the list. 



 
Fig 6.33 Deleting a Grid Layout 

 
If “Copy” is selected, a window will open that the User can type a name for the new layout that will be 
generated when the existing layout selected is copied. This new layout will then appear at the end of the 
current list of layouts. 

 
Fig. 6.34 Enter new title for copy of existing layout 

If “Move” is selected, the User will be allowed to move the selected layout to any position in the list of layouts. 
The “Move Grid Layout to” window will open. By selecting a position in the list, the currently selected layout 
will be moved to that position and all layouts from that position will be moved down. 

 
Fig. 6.35 Moving a Layout in the list of Layouts 

6.3  Format Editor – Object 

By selecting “Object” from the Format Editor the User has several options. The first is “Add Data”. This is the 
same as clicking the [Add] button and allows the User to add information to the presentation. If an item has 
been selected, the “Change Current Selection” and “Remove Current Selection” choices have the same 
effect as the [Change] and [Remove] buttons.  
 



 
Fig. 6.36 Object Selection of Format Editor 

The “Select Data or Shading” Selection allows the User to select any item that has been added to the 
presentation showing the DB Item type and the Warrior mnemonic. If it is shading, the left and right 
boundaries will be shown. Once selected the item may be changed or removed. 
 

 
Fig. 6.37 Selecting Data or Shading 

 

6.3.1  Format Editor – Object – Add Shading 
 

Shading may be added to a Warrior Format presentation by selecting “Object -> Add Shading”. The left and 
right boundaries may be any plotted curve or a constant value of a curve to set the position in the track where 
the curve is plotted. 



 

Fig. 6.38 Adding Shading 

In the example shown in Fig. 6.38, the left boundary is set to a constant of 10 in the GR track, so if the GR 
scales were 0 to 100 then the shading would occur from 1 division in the GR track on the left to the GR curve 
on the right. 

Be aware that it is the position of the curve in the track that is being shaded, not the 
value of the database item. The use of wrapped curves may cause unexpected results 
when shading. As an example, if you have a GR from 0 to 100 as a curve and you 
wish to shade from a GR constant value of 100 to the curve, you will get no shading 

since the GR has to wrap to get to the greater than 100 value. To shade something like an off scale Gamma 
Ray, a second instance of the GR data item should be added (the user may want to use different lettering to 
identify the curve, such as Gr or gr)  to the plot with the appropriate off scale left and right values with no wrap 
and then shade that curve from a constant that is the left boundary to the curve as the right boundary. 
There are 25 different styles of shading that can be used. Note that there is a horizontal scroll bar to provide 
access to all the different patterns available. The color of the shading can be selected by clicking on the drop 
down list labeled as “Foreground:” If “See Through” is not checked, then the shading will cover all the 
presentation behind it. If “See Through” is checked, then grid lines and curves will show through behind the 
shading pattern. A label may be used to identify the shading in the format editor. Not that the label does not 
show on the plot itself unless it is selected in the Options, as discussed shortly. 

6.4  Format Editor – Color Maps 
 

Color maps are used to present variable density, 3D Images, and some pattern strips in Warrior. Each printing 
device and the screen can have its own presentation for a color map. If no presentation is available for the 



device, the software interprets the screen presentation and uses it for the device. The User can create and/or 
edit his own color maps by clicking on “Color Maps -> Edit” from the Format Editor. 

 

Fig. 6.39 Edit Color Maps 

 
Fig. 6.40 Color Map Editor 

6.4.1  Format Editor – Color Maps – Creating and Editing 
 
To create a new color map, first click on the device or screen that you want to create the color map for. Then 
click the [New] button to ensure a new map. Now click the [Add] button to bring up the Windows color palette. 
You can select any color and /or adjust the settings for the color. When you click [OK], that color will be added 
to your color map. You can continue adding colors, with each additional color placed to the right of the existing 
ones. 



 
Fig. 6.41 Windows color palette 

At any time, on new or existing color maps, if you click on a color and click [Change], that color can be edited 
again to replace the existing color.  
Similarly, by clicking on a color and clicking the [Remove] button, that color can be removed from the color 
map. Care should be taken when doing this as the [Remove] button will give the option to remove the color 
map if no color has been selected for removal.  
The [Reverse] button allows the User to reverse the order of the colors shown in the color map. 
The [Blend] button can function in two different ways. If the “count” box has a number in it, then clicking on 
[Blend] will cause that many new shades blended between the existing colors to be inserted between every 
pair of colors. If no count is in the box, the colors will be blended to a maximum of 256 different shades of 
colors. 
Clicking the [Save] button will save any changes made to existing color maps (same as . The [Save As …] 
button will allow the User to save the color map with a new name that will then appear in the colormaps list. 
[Close] will close the color map editor reminding the User of any unsaved changes.  



 

 

Fig. 6.42 Blending colors in color map 

6.4.2  Restoring Color Maps from other systems 
The Warrior 8 software now allow for the transferring of color maps between systems. On the system that 
has the color maps that you wish to use, go to Warrior Backup and do a backup to a file. Transfer the file to 
the system that you want to put the color maps on, and then run Warrior Backup on it.  



 

Fig. 6.43 Using Warrior Backup to backup files from a system 

Go to the Restore page and use the [Browse] button to select the file. Click the [Advanced >>] button to see 
a list of the files in the backup file. Uncheck the uppermost check box to un-select all files in the backup. This 
prevents doing a complete restore from the first system. Click on the [+] beside configuration. Click on the [+] 



beside Color Maps. You should now see the list of color maps from the first system. Check the box beside 
each color map that you wish to restore. 

 



Fig. 6.44 Restoring Color Maps 

6.5  Format Editor – Options 

The options that are available in the Format Editor are to show a tool image on the side of the presentation 
during logging passes. To show the shading labels in interactive plot and on prints, like what is shown in the 
format editor. Bore Hole Image presentations can be attached to a presentation format so that when the 
presentation is called up the borehole image presentation also come up provided valid data values are 
available. 

 

Fig. 6. 45 Format Editor Options 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

 



 

 

 

 

7 Interactive Plot 

Interactive plot is used for the viewing and optional plotting of acquired data either recorded as depth or time. 
Interactive plot is normally started from Acquisition by clicking on Action -> Record Up, or optionally Record 
Down or Record on Time. How the data is presented is initially controlled by the presentation that has been 
selected for each separate service. Note that even if interactive plot is closed that data continues to be 
acquired and recorded until the Action -> Stop command is invoked from acquisition.  
 

Section 
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Fig. 7.1 Starting Interactive Plot from acquisition 

 

Multiple instances of Interactive plot may be opened at the same time showing the same data with different 
presentations or with different passes of data even if they are not from the same database. To start an 
addition instance of Interactive plot from Acquisition, click on Action -> Replay or optionally Independent 
Replay. Replay will allow the user to view any previously recorded pass within the current database open in 
Acquisition, while Independent Replay allows the User to select a different database and open any pass 
within that database. 



 
Fig. 7.2 Invoking additional instances of Interactive Plot from Acquisition. 

 
Independent Replay functions the same as if Interactive Plot were started from the Warrior Software group. 

 
Fig. 7.3 Starting Interactive Plot from the Warrior Software group 

7.1.1  Interactive Plot – File Selection – Select Dataset 

 
If Interactive Plot is started from the Acquisition window the data will normally be immediately displayed on 
the screen. When Interactive Plot is started from the Warrior Software group no presentation is shown 
because the data to be displayed has not yet been selected. To select the data, click on File -> Select Dataset 
. . . The User can then select a database file and then select a pass from that file. At that point, the data may 
still not be displayed on the screen.  



 
Fig. 7.4 Interactive Plot File Selection 

 
To display the data, click on Action -> Screen Plot or click on the monitor icon (third from left).  

 
Fig. 7.5 Displaying selected data 

 

7.1.2  Interactive Plot – File Selection – ASCII Data 
  
ASCII data files can be imported into a Warrior database by selecting the File -> Import ASCII Files … 
selection. The existing database that has been selected can be written to an LAS file by selecting the File -> 
Export to LAS … option.  
Refer to the Database Utilities section 13.x.x 
 

7.1.3  Interactive Plot – File Selection – Exit 
 
The current active Interactive plot may be closed by click on File -> Exit. All Interactive plots that are open 
many be closed by click on File -> Kill ALL Interactive Plots. 
 
 
 

7.2  Interactive Plot – Options 

 
The Options selection of Interactive Plot allows the User to change the presentation of the current database 
pass selected. These options include the start and stop depths of the presentation regardless of the range of 
the acquired data. The format presentation file used to present curve data can be chosen. There is the option 
to add more than one presentation. If this is selected each presentation will appear as a tab in interactive 
plot. The vertical scale of a log pass can be set to certain standard values.  The depth can be shown as either 
English Units of feet or Metric units of meters regardless of the units that depth was set at when the log was 
acquired. The data displayed can be shown as English units, Metric Units, or a mix of User defined Units 
regardless of the default unit selection shown in the Warrior Control panel for acquiring data. The scrolling 



rate of the data can be selected so that if the plot screen is updated it will scroll quickly in the fast speed and 
more slowly in the normal speed.  
If the check box – “Use private copy of presentation with this log” is checked than any changes made to the 
format presentation will only affect the passes in the current database that is being used. If the box is not 
checked, then any changes to the format presentation will be written to the presentation file that is saved in 
Warrior\Format folder and will be in effect when a new database is used. 

 
Fig. 7.6 Interactive Plot – Plot Options 

7.3  Interactive Plot – Edit 

Edit from Interactive Plot allows some addition features to be added to a log pass and invokes some 
programs that can be accessed elsewhere.  
 

7.3.1  Interactive Plot – Edit – Log Format 

 
The Log Format selection will open the Format Editor with the presentation for the current pass. If the pass 
is using a Private Copy of the presentation, it will be the private copy that is being edited. See section 6 for 
more detail on the Format Editor. 
 

 
Fig. 7.7 Interactive Plot – Edit selections 



7.3.2  Interactive Plot – Edit – Annotations 
 
The Warrior software allows the user to place annotations or text on the plot. By clicking on any of the text 
shown in the three windows, the text selected will be placed in the bottom text box. The User can also type 
any text that he wants into the text box. 
When the text has been entered in the text box, click the first icon, that looks like an arrow with an ab (<ab). 

 
Fig. 7.8 Annotate Window 

 
Now move the cursor across to the plot. You will see an arrow with abc. Position the tip of the arrow on the 
plot where you want the arrow of the annotation to be and then left click. If you right click, the direction of the 
arrow will rotate through left, up, right, down, and then two modes with no arrow. If the <ab icon in the 
Annotate window is active (shaded dark), every left mouse click will add another annotation to the plot. To 
change text, move to the annotate window, change text, move back to the plot, right click to set arrow direction 
and then left click to add the next annotation. 
 
Once placed on the plot, annotations positions can be changed, or the annotation can be removed. In the 
annotate window, select the <ab icon so that it is not active (all icons have the same shading). Move the 
cursor back to the plot and click on the desired annotation. When selected it will show as black with white 
text (it may be necessary to pause the plot to be able to select the annotation). You can now right click to 
change arrow orientation and then left click to move it to a new position. To remove the annotation, check 
that the <ab icon is not active and then select the annotation. In the annotate window choose “Action -> 
Delete Selected Annotation (DEL)”. Once selected, the annotation can also be removed by clicking on the 
Delete key on the keyboard. 
 
There three groups of default annotations shown in the annotate window. The first group are text that appears 
in the annotate window no matter what is plotted. The second group is Warrior database mnemonics for all 
the Database items that are in the presentation. The third group contains “translations” for the mnemonics in 
the second window and all the labels that are used on the curves.  
The list of curves in the first group can be edited and the translations can be changed. Click on “File -> Edit 
Default Annotation Text” to open the file Warrior\config\annotate.ini. 
 



 
Fig. 7.9 Annotate File selection 

The [Always] group must be a sequential number list that contains the text that the  User wants. The order 
can be rearranged, and items added if the list remains sequentially numbered. 
The [Translations] group allows for common labels to be shown for Warrior mnemonics used in the 
presentation. For example, if GR is in the current presentation, the translation “Gamma Ray” will show up in 
the third window of the annotate window. 

 
Fig. 7.10 Annotate.ini file 

The second icon in the annotate window allows the user to place a graphical image onto the plot. The third 
icon is for vertical text but is currently not functional. The fourth icon will place a horizontal bar on the plot. 
The fifth icon has no function. The graphical image and the bar are placed and removed in the same manner 
as text. 
 

Annotations are place at a depth and horizontal position on the plot. This mean that if 
the presentation is changed, the pass is depth shifted, scales changed, or anything 



that would affect the position of the curve data, annotations are not moved and do not necessarily point to 
the curve that they originally pointed at. 
 

7.3.3  Interactive Plot – Edit – Log Banner 
 
Log Banners are additions that can be attached to a log pass. The banners may be placed at the top and / 
or bottom of the log pass. Click in the area where the text will appear and type in the desired text. When 
finished, click on File -> Save and then File -> Exit. 

 
Fig. 7.11 Edit Log Banner 

 

 
Fig. 7.12 Entering text in log banner 

 
Log Banners are very similar to headings in that they are a text file with a .WLB extension that the User can 
easily edit. There are several variations that are supplied with the Warrior software. To select a different style, 
click on File -> Select Format. The Select Banner Format window will open shown the banners that are 
available in the Warrior\Format folder. 
 



 
Fig. 7.13 Log Banner File Selections 

 
Once the banner has been saved and the banner editor closed, the banner does not appear on the screen. 
However, when the log pass is printed through Interactive Plot or as part of a Plot Job, the banners will be 
included as part of that pass. 
 
7.3.4  Interactive Plot – Edit – Well Sketch 
 
The Well Object Editor allows the user to show certain well objects on the plot that would represent a well 
bore configuration. These objects include but are not limited to strings of casing and tubing, plugs, packers, 
and nipples. To be able to see the well objects once they have been configured, the presentation must contain 
WELLOBJ as a Graphic Strip. 
Any track may be used, but the graphic strip will cover the width of the track regardless of the left and right 
values used. 
 

 
Fig. 7.14 WELLOBJ plotted as Graphic Strip 



 
It is not necessary but if the wellbore gets complicated with multiple strings of casing, the first thing to do is to 
go to the Settings selection and set the “Width of Diagram” to the well bore size. This way all casing sizes 
can be entered as the dimensional values that they are. Measurement units for Depth and Object size can 
also be set from here. 
 
 
 

 

 
 
Fig. 7.15 Well Object Editor Menu and Toolbar and Settings 

 
The object that an icon represents can be identified by holding the mouse cursor on the icon. To demonstrate 
the well sketch, we will do an example. We will start by going to settings and setting the width of the diagram 
to 8.625 to represent a 8 5/8” well bore. Next, we will click on the Casing Icon. 

 
Fig. 7.16 Identifying Icons 

 
The first string of Casing that we will put in will be 7” surface casing from surface down to 105 feet. Enter the 
depth interval from 0-105, and the width of object as 7 inches. Notice that the Horizontal positions are 
automatically adjusted to fit the diagram and casing size. Click [OK] to save that string of casing.  
The next string will be 5 ½” casing from surface down to 1600 feet. On this string we are going to check “Yes” 
to the show bond. If the dataset being presented has bond curves, it will use the BONDIX to show shading 
as a representation of bonded pipe. 
The last string of casing will be put in as a liner from 1550 -1850 and will be 4 ½”. We will also show bonding 
on this string. 



 
Fig. 7.17 Entering casing depths for stings of casing 



 
Now let’s put a bridge plug and packer into our well. We want to put a plug at 1800’. We could type in 1800, 
but the problem with a single depth entry for plugs and packer is that it centers the image at the depth. So, if 
you want the top of the plug or packer to be at a depth, you need to put in a zone (usually 4’ or 5’ looks good 
even if the plug is not that long) in this case 1800-1805. At the same time, we will enter an annotation “Plug 
@ 1800’”. 

 
Fig 7.18 Showing a plug in 4 ½” Casing at 1800’ and packer in 5 ½” at 1550” 

 
The next thing that we want is some tubing in our well from surface to 1620’. To make the picture look 
esthetically pleasing, the tubing should fit the hole in our packer. The hole in the packer is 1/3 the width of the 
packer. Since we set the packer in 5 ½ the tubing should be 1.84. If we are at it, let’s put a seating nipple in 
the tubing at 1565” 



 
 
Fig. 7.19 Tubing to fit 5 ½” Packer and seating nipple at 1565’ 

 
The last thing that we want to do to our well sketch is to add some perforations. Zones are entered by top 
depth, a hyphen (or minus sign), and bottom depth. Multiple zones can be entered by separating each zone 
with a space or comma. Single shots can be entered by putting just the single depth. In the example below 
we have zones from 1630-1640, 1650-1655, and 1660-1667 with a single shot at 1683.  
Use the left% and Right% to position the perforations. The default is 0 and 20. In this example, that puts the 
perforations into the area where the bond index is shaded and makes them difficult to see. Since the 4 ½” 
casing starts at 17.9%, I started the perforations at 18% and kept them 20% wide. This puts them inside the 
edge of the 4 ½” Casing. 
 
Just as an example, I have also added some squeezed perforations, that use a slightly different image than 
normal perforations, from 1630-1680. I positioned these at -20% to 0% to show that well sketch images do 
not have to remain in the track that the WELLOBJ image is place. Any percentage can be used, but it is 
based on the track that the WELLOBJ image was placed in. 



 

 
Fig. 7.20 Entering Perforations 

 
Annotations that are adding from the well object will always be placed in the middle of the object. Should you 
want to move the annotation, you would need to “Edit -> Annotations” from Interactive Plot and then move 
them. 
 
Well Sketches are kept by runs. So, every pass in a run of a dataset will have the same well sketch. If the 
User want to have different sketches, they must be entered in a pass on a different run number. 
(/field/well/run1/pass1  and /field/well/run1/pass2  would have the same well sketch while 
/field/well/run2/pass3 could have a different well sketch) .  
 
It is possible for the User to create their own well objects to be used in a well sketch, but it is outside of the 
scope of this document. If this need  



 
Fig. 7.21 Well Sketch example image 

 

7.3.5  Interactive Plot – Edit – Log Heading 
 
Clicking on “Edit -> Log Heading” from Interactive Plot invokes the Heading Editor. See Section 5 for a 
discussion of the Heading editor. 
 
 

7.3.6  Interactive Plot – Edit – Multi-File Plot Job 
 

Clicking on “Edit -> Multi-File Plot Job” from Interactive Plot invokes the Plot Job Editor. See Section 9 for a 
discussion of the Plot Job Editor. 
 

7.3.7  Interactive Plot – Edit – Zoned Scale Changes 
 



Zone scale changes allow the User to display curves with different scales in different parts of a pass and to 
shut the curve off if desired. If the current presentation does not have any curves that have been enabled for 
zone scale changes, a warning will come up to notify the User. If the [Yes] button is clicked, the Format Editor 
will open with the current presentation. 

 

Fig. 7.22 Zone Scale change invoked with no zoned scale curves 

With the Format Editor open, click on the curve that you wish to have the zoned scale changes, then click 
[Change]. Check the box for Zonable Scales, then click [OK]. Save the presentation in the Format Editor and 
Exit. 

 

Fig. 7.23 Setting up Zoned Scale changes in Format Editor 

Now when Edit -> Zoned Scale Changes is selected, the zoned scales window for the pass will come up with 
any zonable curves show. In this case GR and LTEN are shown, each with a left scale value and a right 
scale value. The only zone that is shown is from the top of the pass to the bottom of the pass. To create new 
zones, click on the [Zones] button. We are going to put in a zone change at 1750, type 1750 into the “Insert 
a new change “ box and have that selected. For illustration purposes, we also want to put a zone change in 
at 1700. 



 

Fig. 7.24 Zoneable Scales 

Now we need to edit the scales in the different zones. From 1750 to bottom, we will leave them unchanged. 
From 1700 to 1750, we will make it 0 on the left and 100 on the right. From top to 1700, we will set both left 
and right values to 0 to turn off the curves. Once the scales have been edited, click the [Accept] button to 
complete the changes. Click [Close] to close the Zoned Scales window. 



 

Fig. 7.25 Scales changed on zones 

Zoned scale changes do not automatically refresh the Interactive Plot to show the changes. To refresh the 
screen the User could reselect the log pass but more common is to do “Action -> Screen Plot” twice or click 
the Screen Plot Icon twice. Fig. 7.27 show the same log pass before and after the scale changes that we 
have done in this example. 

 

Fig. 7.26 Refreshing the screen with Screen Plot 



Fig. 7.27 Pass before and after zoned scale changes 

7.3.8  Interactive Plot – Edit – Gridline Setup 
 

Edit -> Gridline Setup from Interactive Plot invokes the Gridline Setup editor to allow the User to control at 
what plot scaling the different horizontal (Depth / Time) grid lines appear. If the vertical scale resolution on 
the plot is less than the maximum compression ratio, and the scale resolution is greater than the minimum 
compression ratio, than the gridline will be plotted. Separate gridline setups can be kept for English depth, 
Metric depth, and a time log. 



 

Fig. 7.28 Gridline Setup 

7.3.8  Interactive Plot – Edit – Correlation Curves 
 

Selecting correlation curves allows you to plot a curve(s) within a pass in a database into all other passes of 
the database. You will be given the option to select a curve or curves. Highlight the curve and select add.  
Once the curve has been added to the list of correlation curves, click on the selected Correlation curve.  
There are two radio buttons. The first one, “Always show in original track with original scales “, will place the 
curve in the same track as the pass it originated in, with the scales as shown above it. This is the standard 
correlation mode. The second radio button “Only show when another curve by the same name is plotted, 
show with the same name and scales as the named curve” will plot the selected curve only if it exists in the 
pass to be plotted, it will use the same scales and track as the current pass but will apply the color selected.  
 



 

Fig. 7.29 Setup of correlation curves 

If the displayed pas is depth shifted, the data in the pass will be shifted as usual but the correlation curve 
displayed will show the depth from its original pass and not be shifted. 
There are now some additional options in Interactive plot. The default setting for correlation curves is to show 
the correlation curve, but do not plot the correlation curve in any hard copies (or PDF and TIFF). There are 
options to both display and print the correlation curves and to hide the correlation curves. 

 

Fig. 7.30 New options for correlation curves 

7.3.9  Interactive Plot – Action – Screen Plot 
After a pass in a database has been selected, Action -> Screen Plot will display the pass on the screen. It 
may also be used to refresh the screen plot by selecting it twice. The first selection of Action -> Screen Plot 
will clear the 



plot from the screen. The second selection will once again display the plot on the screen. Clicking on the 
Monitor Icon will have the same effect as Action -> Screen Plot. 

 

Fig. 7.31 Action -> Screen Plot and Screen Plot Icon 

7.3.10  Interactive Plot – Action – Print 
 

By clicking on the Plotter Icon or Selecting Action -> Print, the Start Plot Window will open. Printing may be 
started at any time, if it is direct printing (normal mode using Warrior Printer Drivers and not through 
Windows). Even though the screen may have acquired data for a considerable length of time, the plotter will 
start at the beginning of the plot and print the log until it has caught up. Any changes made to the presentation 
while plotting may have unexpected results on the hardcopy. 

 

Fig. 7.32 Action-> Print and Print Icon 

 
The User has the option of selecting which of the installed printers to send the hard copy to by clicking the 
dropdown installed printers list. There is a check box to set the currently selected printer as the default printer 
so that it will be shown when the Start Plot window is opened. 



 

Fig. 7.33 Installed printer list 

The User has the option to print multiple copies of the current plot by increasing the copy count. Most printers 
have some selectable settings that can be configured through the Warrior Software by selecting the [Setup] 
button. Due to the variety of plotters and settings, we will not cover the possible settings at this time. The [Top 
of Form] and [Advance] buttons will perform those functions when clicked. The [Calibrate] button allows the 
user to adjust the vertical scaling of the plot, so the matte length meets required specifications (i.e. 5 inches 
of plot per 100 feet of well). 

 

Fig. 7.34 Calibration of printer 

For the “Required Distance”, enter the distance that you want between two points on the plot. For the 
“Measured Distance” enter the distance that is measured between those two points. The further apart that 
the two points are the more accurately (relatively) you will be able to measure the distance. As an example, 
if you want a plot that is 5”/100 ft., you might choose to measure 300 ft. which would make your required 
distance 15 inches. Then if you measure it and it is 14 and 15/16 of an inch, your measured distance would 
be 14.9375. When the values have been entered, click the [Calibrate] button. The new calibration will then 
be shown. This value should be somewhat close to 1.00. If it considerably different, it may be necessary to 
remove printer scaling calibrations and start over by making a new plot. To remove plotter calibrations, click 
the [Undo Calibration] button. This will set the plotter calibration back to 1.00. 

 

Fig. 7.35 New plotter calibration saved 



7.3.11  Interactive Plot – Tools – Depth Shift a Curve 
 
The Warrior Software can depth shift a single curve in a dataset while keeping all the other curves at their 
current depths. It should be noted that while this feature does exist it should not be a general practice to need 
to do this. Tool offsets should be adjusted to ensure that curves are on depth. Depth Shifts to a data item or 
curve can be done in Interactive Plot or Database Utilities. 
The first step is to select the data or curve to shift. Click the [Select Data] button to bring up a list of data items 
in the database. Be aware that all data in the database will be shown, not just the data from the current pass 
that is displayed if you are in Interactive plot. Find and select the curve and click [OK]. Now enter the amount 
of shift with negative amounts shifting up hole. If the “Shift current Encoder Depth also” is checked, the 
encoder depth will also be moved by that amount when the [Apply] button is clicked. If you are in Interactive 
Plot, the screen will be refreshed with the curve shifted. 
No records are maintained of which curves have been shifted or by what amount. It is a good idea to make 
a backup of the database before doing depth shifts in case of operator mistakes. 

 

Fig. 7.36 Depth Shift a Curve 



7.3.11  Interactive Plot – Tools – Depth Shift a Whole Pass 
 

The Depth Shift Icon or Tools -> Depth Shift a Whole Pass can be used to depth shift a pass to put it on 
depth with other logs or passes. This can also be done from Database Utilities. If done from Interactive Plot, 
the current pass displayed will be selected as the pass to depth shift. If the check box “Shift current Encoder 
Depth also” is checked, the amount of shift will also be applied to the encoder. Enter the amount that you 
wish to shift the pass in feet or meters and click [Apply]. The Interactive plot will refresh the screen with the 
shifted pass and the encoder depth will be adjusted at that time. 

 

Fig. 7.37 Depth Shift a Whole Pass 

7.3.12  Interactive Plot – Tools – Run TVD/Merge Program 
 

Clicking on Tool -> Run TVD/Merge Program from Interactive Plot will open the Warrior Merge Program. 
See section 11 for information on the use of the Warrior Merge program. 

7.3.13  Interactive Plot – Tools – Create an Alias 
 

Creating an alias allows the User to display data in a presentation from a different pass in the same database. 
It does not create a copy of the original data but simply shows the data as being in the pass while it exists 
elsewhere.  
Use the [<<Browse] button to select the pass that contains the original data. That data item will then be 
displayed in both the existing data item name and the New Name fields. The New Name field must now be 
edited to show the pass and curve name that you wish to present. This normally will consist of changing the 
pass number and often changing the curve mnemonic since two curves of the same name cannot exist in a 
given pass. Verification of the creation of the alias will be shown at the bottom of the window. Note that when 
the alias is created that it will need to be in the presentation to be displayed and if it is in the presentation the 
screen may need to be refreshed before it is displayed. 



 

Fig. 7.38 Creating an Alias of GR from Pass1 as GR_1 in pass2 

7.3.14  Interactive Plot – Tools – Run AutoMerge Utility 
 
The AutoMerge Utility allows the User to merge data items of the same name from multiple passes within a 
database into a new pass and automatically gives each of the data items a new name. This is very useful 
when several passes have been run over the same interval and you wish to see all the passes on one plot. 
The new output pass will automatically be named ./././merge1, but this may be edited. The User may use the 
[<<Browse] button to select a presentation to use on the pass that is created. 



 

Fig. 7.39 AutoMerge Utility 

 
There are a variety of naming methods that may be used for the curve names. A list of some choices and 
the resulting name for a GR from pass2 are: 
Original pass name    GRpass2 
Original pass number  GR2 
Run number and first pass letter GR2p 
Run number and pass number  GRr1p2 

 

Fig. 7.40 Curve rename options in automerge utility 

 

7.3.14  Interactive Plot – Pause / Unpause 
 
The Pause selection is used to keep the display from scrolling so that data may be examined, annotations 
added to the pass, etc. If the pass has been paused, the selection will change to Unpause and can be used 
to allow the display to once again scroll.  
  



 



8 Warrior Backup  

 
Every computer system will, sooner or later, suffer a failure, like a disk crash, where potential loss of programs 
and/or data is possible. This will generally happen at the most inconvenient time. The importance of 
keeping current backups cannot be overemphasized. It is vital that current backups are kept of all 
essential programs and data. 
The warrior system is usually configured for the selection of services to be run by a given client. This 
information is primarily contained in three files, namely wproperties.ini, services.ini, and tools.ini.  A copy of 
all your customized files can be backed up to USB Memory/Hard disk by using “ Configuration 
Backup/Restore” utility. 

 

FIG: 8.1 Select Configuration Backup/Restore. 
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FIG: 8.2 Select Backup, Restore or Restore Critical Files 

 

8.1 Backup 

The first tab is used to Backup all you customized files including but not limited to Logo, Services, Depth 
offsets, calibrations, serial numbers and licenses.  With the “ wbu “ file generated here you can recover all of 
these or take it on a USB drive to another computer and restore it to the same configuration as the current 
system. In the Backup to windows you can browse to where you want the backup stored. The comment line 
lets you add a comment to the file to more easily identify the purpose of the backup. The advanced option 
allows you select files to include or exclude from the backup, use this option with caution as selecting files 
other than the defaults may cause the backup file to either skip important files or over write critical software 
files. To begin the backup, you will need to click on the begin button. Once completed a “ Backup completed” 
will be displayed as a status. 
 



 

 FIG: 8.3 Restore  

8.2 Restore 

The restore tab can be used to restore a previously backed up system to its working state or copy relevant 
files to a new system. The restore from line lets you browse to the desired “ wbu “ file. Once selected the 
system will read through the file to ensure it is not damaged” this can take some time depending on the 
system “. Once it reads through the file you will need to click the begin button. Once completed a text dialog 
will show all the files restored.  

 

FIG: 8.4 Restore results 

This tab has an advanced button as well, the same precautions should be observed, by selecting anything 
other than the defaults you may cause system instability. 
 

 



8.3 Restore Critical Files 
 

The third tab “ Restore Critical Files “ allows you to restore only the critical system configurations. These files 
are saved every time acquisition is started if there is a check mark in the “ Do automatic critical backups “ 
radio button. By clicking on any of the dated files under Critical backup dates the system will show which 
critical files were backed up. 

 

FIG: 8.5 Restore Critical Files 

It is generally better to do a “Restore”  than a “Restore Critical Files” critical files, Restore Critical Files is a 
more specific and advanced option.  
 

 



9 Plot Job Editor  

The Plot Job Editor is a program module, which enables the operator to assemble the various components 
(heading, log sections, etc.) of a well log into its final presentation. The resultant plot job information is saved 
in a well log database, usually alongside the log data. The Presentation Plot program uses the plot job 
information to create the graphical output to a plotter or other graphics device (fax file, etc.).  
The Plot Job Editor is started from its icon in the Warrior group, the Presentation Plot File menu, or the 
Acquisition module Edit menu.  
Double click on the program group icon, the Acquisition Edit menu or the Presentation Plot File menu 
 
 

 
FIG: 9.1Select Plot Job Editor 
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FIG: 9.2 Select Plot Job 

9.1 Select File 

 

FIG: 9.3 File Menu 

The menu functions are as follows: 
 

9.1.1 New 
If a plot job is currently selected, New clears the editor for a new plot job.  
 

9.1.2 Open 
Displays the file selection window to allow the operator to select the database file containing the plot job to 
be edited. Note that plot job information is stored in the Warrior database file at the run level. 
 

9.1.3 Save 
After creating or editing the plot job it may be saved within a Warrior database file 



 

9.1.4 Save As 
Allows a plot job to be edited and subsequently saved to new location with a different name. 
 

9.1.5 Screen Preview 
Starts Screen Preview of the selected plot job, see section 6 in the  manual  on Presentation Plot. 
 

9.1.6 Hardcopy 
Displays a list of the plotters supported on the logging system. Selection of one of the plotters causes the plot 
job to be output to the hardcopy device (plotter). 
 

9.1.7 Exit 
Closes the Plot Job Editor 

9.2 Start the Plot Job Editor. 

When the selection of the items is complete the plot job data is saved in the Warrior database. 
If the Plot Job editor is invoked from within the Acquisition module the database path and name are set to be 
those of the current database. If invoked from elsewhere the full path must be entered by the user. (LEAVE 
NO ASTERISKS / WILDCARDS) The blank plot job appears as shown above. 
 

9.2.1 Change 
Changes plot job to be edited. 
 

9.2.2 Remove 
Removes the selected file from the plot job. 
 

9.2.3 Add 
To create a new plot job, start with the Add button 
 

 

FIG: 9.4 Add File 

Add Displays the selection box containing types of files, which may be included in the plot job. 
 



 

FIG: 9.5 Select the File to add 

Selecting a database file causes a list of plot jobs stored within the database to be displayed. 
 

 

FIG: 9.6 Select Database 



 

FIG: 9.7 Select Plot Job 

 

FIG: 9.8 Select Heading 

Typically, a log heading would be the first file to appear in the plot job. Click on Heading and, because 
headings are stored in the log databases, the database selection window is displayed. Select the database 
where the required heading is stored. A list of the headings stored in that database is displayed 



 

FIG: 9.9 Select Database  

Select the required heading by double clicking or highlighting and the OK button. The heading appears as 
an icon at the start of the plot job sequence, as shown below. 

 

FIG: 9.10 Select Plot Job Input 



 

FIG: 9.11 Add Heading 

 

 

FIG: 9.12 Add Heading, Log Pass, Tool String, and Calibration Report 

Other files may be added as required in the order they are to appear on the final log presentation. 
To add a log section, click on Single Log Pass and a list of the log passes in the currently selected database 
is displayed.  



Selecting Multiple Log Passes allows the operator to select for inclusion the plot job several log passes at the 
same time. This is useful when there are many passes to be included, as with production logging.  
Other items from the type list may be added as required. Tool string diagrams and calibration reports are 
stored at the pass level, therefore when adding an item of these types, a list of the log passes is presented. 
In this way the items to be presented on log print are defined together with the order in which they are to 
appear. Each item appears as an icon as shown below. 
 

 

FIG: 9.13 Save 

Note that the plot job contains information concerning which files are to be plotted, in which order, and with 
what presentation. It does not contain the files themselves, therefore the files may be modified e.g. by adding 
annotations, without the need to recreate or modify the plot job itself. 
Selecting External PRN file allows the inclusion within the plot job of plot or print output from any Windows 
application. It is necessary that the material to be added to the plot job have been previously printed to a PRN 
file from the application. See Windows Help - Print to a file for details on how to do this. 
Upon completion of the plot job sequence the job may be plotted by choosing the Hardcopy option from the 
file menu. Alternatively, the Presentation Plot program may be started from the Warrior program group 
(particularly if a Screen Preview is required). 

 

FIG: 9.14 Select Screen Preview 



 

FIG: 9.15 Heading 



 

FIG: 9.16 Log Pass 



 

FIG: 9.17 Tool String Add  



 

FIG: 9.18Calibration Report 



 

 

10 Recalculation 

The recalculation mode allows log data to be recalculated or relogged from raw data. Calibrations and other 
acquisition parameters, such as filters and depth offsets, may be changed. The data monitors used during 
actual logging are available to the operator during recalculation. 
Double-click the Recalculation icon in the Warrior group and a menu box like that of Acquisition will appear. 
In this case though, Service and Action are disabled (appear feint on the menu bar). The Edit and Monitor 
menus are identical to those of Acquisition. 
 

 
FIG: 10.1 Recalculation 
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10.1 File 

The following option can be select in File: 
Select Dataset, About, Exit, Close All. 
 

10.1.1 Select Dataset 
The Warrior well log database can (optionally) contain data from many wells, and within each well, data from 
many log passes. Each log pass is stored in a dataset. The dataset contains not only log data, but also other 
information about the logs, e.g. calibration and tool data 

 

FIG: 10.2 Select Dataset 

 
Choose the Select Dataset option from the File menu. A dialog box will appear as shown below. 
The software includes a database named cbldem.db that may be used for the purpose of demonstrating the 
Recalculation mode. Select the dataset as shown below. 
 

 
FIG: 10.3 Select Database 

The Recalculation Output is the destination pass (or dataset) of the recalculated data. It may be named 
anything you like. If this pass already exists in the database when Recalculation. Is invoked, the software will 
give an error message and a new Recalculation Output should be selected. 
Allowing the system to give a default name to the recalculated output will cause it to be named x.1, where x 
is the name of the original pass. Repeated passes through Recalculation. Will cause an incrementing number 
to be attached to the Recalculation. Output. In this case pass1.2, pass1.3 etc. 



When recalculating, for example, pass 1.1 to 1.2, upon selecting 1.1 as the base pass the system will still 
indicate 1.1 as the output pass. It will however create a new pass 1.2 

 

FIG: 10.4 Select Pass Name and Set recalculated Output 

When OK is selected the software reads information from the log database and displays the Recalculation 
Control dialog box, as shown below. 

10.2 Recalculation Control 

 

FIG: 10.5 Recalculated Control 

The Recalculation Control allows setting of Start, Stop and Pause depths. It also enables setting of the Step 
size. The Step size is the log interval that Recalculation attempts to recalculate during its share of the CPU 
time and functions effectively as a speed control. 
Recalculation may be run in three modes. 
 

10.2.1 Run single step 
Select a step size. This may be as small as a single sample. 
Click the Single Step radio button. The log plot will appear on the left of the screen.  
Successive clicks on the Step button will cause the pass to be recalculated step by step. 
 

 10.2.2 Run variable speed 
Select a step size.  
Click the Variable Speed radio button. The log will appear on the left of the screen and will scroll at a rate that 
may be varied by the scroll bar in the Recalculation dialog box. Increasing the step size also increases the 
recalculation rate. 
 



 10.2.3 Run maximum speed 
Select a step size. 
Click the Maximum Speed radio button. The log will appear on the left of the screen and scroll at its maximum 
rate. It is likely that the recalculation will complete quickly, but that the log on the screen will lag. 
 

10.2.4 Pause Recalculation 
Click once on the QUIT button causes the Recalculation to pause. 
 

 10.2.5 Quit Recalculation. 
Click twice on the QUIT button. 
 

10.3 Load Variables 

The Load Variable is invoked from the Recalculation File menu. It is used to Load variables from the 
database. 
Load Variables the other Dataset, enabling depth dependent parameters associated with the selected service 
to be zoned and values to be set. 
 

 

FIG: 10.6 Load Variables 

10.4 Monitor 

The Monitor option in recalculation has the same properties that Monitor in acquisition. (See Section 4.6) 

 

FIG: 10.7 Monitor Options 



 
FIG: 10.8 Step Control 

10.5 Edit 

The Edit option in recalculation has the same properties that Edit in acquisition. ( See Section 4.5 ). 
Change parameters as required. These may include: 
Tool String, Variables, Heading, Master Log Format, Plot Job, Sensors, Tool Configuration, Device 
Configuration, depth offsets, input channels, curve filters, calibrations, sonic amplitude gate settings. 
 

 

FIG: 10.9 Edit Options 

 



 

FIG: 10.10 Acoustic Signal Control Off 

 

FIG: 10.11 Acoustic Signal Control set ON  



 

FIG: 10.12 Thresholds and Gate Control ON 

 

FIG: 10.13 Gate control Set ON 



 

FIG: 10.14 Edit GR Calibrations 

 

FIG: 10.15 GR Curve Before and After the Recalculation 



 

11 Merge/Splice, TVD Merge/Splice 

The Wizard, Merge, Splice and TVD module allows data from one or more database files to be manipulated 
in the depth domain and output to one or more destination files. Data may be depth adjusted and correlated, 
curves from multiple runs spliced together, outputs renamed etc. The module also includes the capability to 
calculate True Vertical Depth (TVD) from directional survey data and generate log data referenced to TVD 
for subsequent plotting and other operations. Most of the Merge program operations may be accomplished 
with only one pass through the data. 
Double-click the Merge icon in the Warrior group 
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FIG: 11.1 Warrior Group 

11.1 Wizard 

The Wizard option is easy way to do Merge two Passes, Splice, Replace and Add curves 

11.1.1 Merge two Passes 
Double-click the Merge two Passes option. 



 

FIG: 11.2 Wizard/Merge two passes option.  

Set the Base Pass as Upper Pass or Lower Pass and select the Database 

 

FIG: 11.2 Merge two Passes set the Base Pass as Upper Pass 

Select the Input pass to merge from the Database 



 

FIG: 11.3 Select Input pass for Merge 

Select the Pass from the database to set as Lower Pass 

 

FIG: 11.4 Select Pass as Lower Pass 

Select the Pass from another Database 



 

FIG: 11.5 Select pass from the Database 

The software by default created a pass (Merge1). 
Set the depth to start the Merge1 (Splice the curves), Define the log interval and set the presentation. 
 

 

FIG: 11.6 Merge two passes 

Double-click the Process bar 



 

FIG: 11.7 Start the Process 

Processing the Merge 1 

 

FIG: 11.8 Processing 

Select Interactive Plot in the warrior group 

 

FIG: 11.9 Select Database from interactive plot 

Screen plot the Merge1 check the Merge the curves (Splice) at 200 FT. 



 

FIG: 11.10 Screen Plot Merge1 

 

 

11.2.2 Merge two Passes (Add Curves) 

 

FIG: 11.11 Select Add/Replace a curve 



 

FIG: 11.12 Select the Base Pass  

 

FIG: 11.13 Select to add curve 



 

FIG: 11.14 Select the curve 

 

FIG: 11.15 Select the curve in log Data Inputs 



 

FIG: 11.16 Modified input Curve 

 

FIG: 11.17 Add Curve and Process 

 

FIG: 11.18 Processing 



 

FIG: 11.19 Interactive Plot select pass 

 

FIG: 11.20 Plot the Pass 



 

11.2.3 Merge two Passes (Replace curve) 

 

FIG: 11.21 Select Curve from the database 

 



FIG: 11.22 Process 

 
FIG: 11.23 Select the database to keep the curve 

 

 

FIG: 11.24 Plot the pass with the new curve that replaced the old ones. 

11.2 Merge 

Double-click the Merge icon in the Warrior group. The Merge Splice TVD window will appear as shown below. 



 
FIG: 11.25 Log data Inputs  

The Merge module interface consists of six independent windows within the main Merge window. Any or all 
the windows may be displayed at the same time.  
Note that if you lose a window by inadvertently or deliberately closing it, you can get them all back by clicking 
Window/Open All in the main menu bar.  
The main Merge menu box contains several pull down menus and selection options, which control the 
operation and set up of the Merge sub-system. The pulls down menu functions are as follows: 
 

11.2.1 File 

11.2.1.1 Select Input Log Data.  
Selecting this option brings the Log Data Input window to the foreground. Data items e.g. curves, are 
selected from their source database(s) and dataset(s) and displayed as a scrolled list in the Log Data Input 
Window. Within the Log Data Input window several processing parameters are set. 
 

11.2.1.2 Detail Selected Inputs 
Selecting this option brings the Input Details window to the foreground. This window displays detailed 
information concerning the data items selected for processing. 
 

11.2.1.3 Select Output Path/File 
Selecting this option brings the Output Definition window to the foreground. This allows definition of the 
database and dataset to which the processed data is to be output. A default presentation, with start and stop 
depths, may be associated with the output database in this dialog also. Note that Browse buttons are 
available so that existing databases and presentation files may be easily selected. 
 

11.2.2 Corrections 

11.2.2.1 Enter Depth Tie Ins 
Selecting this option brings the Depth Correction Tie Ins window to the foreground. Processing parameters 
for data depth corrections are entered in this window.  



11.2.2.2 Enter Directional Data 
Selecting this option brings the Directional Survey Stations window to the foreground. Entry of directional 
survey data for TVD calculations is made in this window. 
 

11.2.3 Processing 

11.2.3.1 Process Commands. 
Selecting this option brings the Process Control window to the foreground. Three selections may be made 
in this window. The type of processing to be performed, if the processing is to be done as a foreground or 
background task, and to the default depth units are to change. 
 

11.2.3.2 Windows 
Conventional Windows commands for manipulating windows on the screen 

11.3 Merge data items (curves) from two (or more) log   passes 

If the Log Data Inputs window is not active, click on Select Input Log Data ...... under the File menu. The 
Log Data Input window appears in the foreground. Clicking the Add button brings up a file selection box 
where an existing log database may be selected in the usual way. 
Once a database is selected the contents in terms of runs, passes, curves etc. are displayed as a scrolled 
list, as shown below. 
 

   

FIG: 11.26 Select Curve from the database 

Select the curves and other items, present in this list that you wish to merge. When all the required curves 
present in the current database have been selected click OK and the selected items are passed to the Log 
Data Inputs list as shown below. 



 
FIG: 11.27 Log Data Inputs 

 
In the same way (Add etc.) curves and other data items may be selected from other databases until all the 
required curves are present in the Log Data Inputs window. 
From within the Log Data Inputs window, details of the processing parameters for the individual data items 
are set. The processing parameters which may be adjusted are the depth range, the name of the output 
curve and the application (or otherwise) of depth corrections.  
Select one or more curves from the input list by highlighting them in the normal way. Note that Change button 
is now activated. 
Clicking the Change button brings up the Modify Input Item dialog as shown below.  
 

 
 
FIG: 11.28 Modify input item 

If a group of curves was selected, the Input Dataset is shown as Multiple because several curves have been 
selected. If a single curve is selected the actual name of the curve us presented. 
The depth range of the output curve(s) may be set as desired or left as the initial range. The name of the 
output curve may be changed only if a single curve was selected. 
If depth corrections are to be applied the Apply Depth Correction box must be checked and depth correction 
tie-in points entered (see below). 
Note that currently only one set of curves may be depth corrected per pass through the data. If you wish to 
correct more than one curve (or group of curves), where one curve (or group) has different depth corrections 
than the others, then tie-in points must be entered for the first group, the merge process run and then the 
second curve (or group) selected, the second group of tie-ins entered, and a second merge process run. 
Detailed information on all data items in the Log Data window is present in the Input Details window. 



11.4 Access detailed information on data items 

Select Detail Selected Inputs from the File menu. A new window is generated as shown below. A variety of 
information is shown about all the curves selected for processing. The horizontal and vertical scroll bars are 
used to access all the available information. 
 

 
FIG: 11.29 Input Details 

11.5 Enter depth tie in points 

Select Enter Depth Tie Ins.... bringing up the Depth Correction Tie Ins dialog as shown below. 
 

 
FIG: 11.30 Depth Correction Tie Ins 

Depth tie in points may be entered from the keyboard by first clicking the Add button to obtain the window 
shown below 
 

 
 FIG: 11.31 Add Tie-in 



Enter the current log depth in the Measured Depth box, and the depth to which you wish to move those log 
points in the Actual Depth box. Click OK and the points appear in the scrolled list. The Add Tie-in window 
continues for entry of the next tie-in point. When all tie-in points have been entered, click Cancel. 
The log interval below the lowest tie-in point will be linearly shifted up or down, and by an amount 
corresponding to the lowest tie-in values. 
The log interval above the highest tie-in point will be linearly shifted up or down, and by an amount 
corresponding to the highest tie-in values. 
The log data between tie-in points will be linearly stretched or squeezed according to the tie-in values. 
Note that if only one tie-in point is entered then all the log data will be linearly shifted up (or down) according 
to the tie-in values. The same result may be achieved much more quickly by using the Apply Linear Shift to 
a Dataset or Apply Linear Shift to a Data Item functions in the Utilities package. 
Tie-in points mat be read from and written to a file using the Put and Get buttons. Points may be changed or 
removed using the corresponding buttons. 
Once the changes have been made to the input data, it is necessary to indicate where the merged data is to 
be written. 

11.6 Select the output path or file name. 

Choose Select Output File/Path from the File menu. The dialog box shown below appears. The output 
database and dataset are typed in from the keyboard, or an existing database is selected using the Browse 
button. 
Note that it is usually quicker to select an existing dataset with the Browse button and then modify its name 
and/or dataset path, than to type in all the fields from scratch. 
A default presentation file may be attached to the output dataset with a depth range defined in this dialog.  
The Browse button may be used to select an existing presentation file from those in the system. 
 

           

FIG: 11.32 Output definitions 

The final step in merging the data is to define the processing operation, the processing mode and the depth 
units (if other than default).  

11.7 Select processing options and start processing 

Select Process Commands bringing up the Process Control Window as shown below. 
 



 
FIG: 11.33 Process Control 

Select the Copy / Splice / Merge Log Data to process the data with optional depth corrections. Select Copy 
Log Data with TVD Correction to generate a new set of log data with depth referenced to TVD calculated 
from the directional survey data. Select Calculate TVD Report to generate an ASCII directional report. 
Process in Foreground causes the processing to take place in Windows foreground mode, whilst Process in 
Background allows processing to take place whilst other tasks, such as logging, are active. 

11.8 Splice a curve 

Select first input database as described above. Select the first section of input curve to be spliced from the 
Select Data Items window, then select the second and so on until all the original curves from which the spliced 
curve is to be assembled are present in the Log Data Inputs window. The original curves may originate from 
one or more databases.  
Select the first curve and input depth range of this curve to be used in the spliced curve e.g. 1200, 1300. 
Select the second input curve and set its range e.g. 1300, 1400. Select the third input curve. 
When all the sections have been defined go to Output Definition and define where the new curve is to be 
written, as described above. Process Control select the Copy / Merge...option and click Begin. 

11.9 Enter Directional Survey Data 

Select Enter Directional Data. bringing up the Directional Survey Stations window as shown below. The 
depth, borehole inclination, and azimuth are entered in a manner like the depth tie in data. The Add, Change, 
Remove, Get, Put and Close buttons are used in the same manner as previously described for Depth 
Correction. 

 
FIG: 11.34 Directional Survey Stations 



Once the data items have been selected, the destination file chosen and the processing parameters defined, 
the Processing menu or Process Control window may be selected to initiate processing of the data as 
previously described. 
The Window menu functions are identical to those found in any Windows application, allowing the individual 
windows e.g. Process Control, Log Data Inputs etc., to be tiled, cascaded, etc., as shown below.  

 
FIG: 11.35 Process Control 

Note that the interface to the Merge program may be customized by the user in terms of window sizes and 
layout. The layout in existence at the time the program is closed will be brought back the next time the 
program is run. 
  



 

 

 

 

12 Database Utilities 

The Utilities icon in the Warrior Program Group allows access to several programs, some with general, and 
some with more specific, applications. 
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FIG: 12.0.1 Warrior Program Group  

The warrior Utilities has six groups: 
 
1) Data Export 
2) Interpretation Tools 
3) Setup Tools 
4) Depth Correction 
5) Data Management 
6) Data Import 
 
Clicking on the icon Utilities gives a menu list as shown below. 
 

 
FIG: 12.0.2 Warrior Utilities 

12.1 Data Export 

Unlike previous versions of Warrior, Warrior 8 now has a single program to export both LAS and LIS files, 
although the Warrior Utilities still shows them as being separate utilities. Depending upon which utility is 
selected, the export format for that type will be selected upon entering the export utility, although it can be 
changed within the utility. 



12.1.1 LAS LIS Data Exporter 

 
FIG: 12.1.1 Export LAS Format 

 

12.1.2 Warrior Data Exporter 
 
This program will export to LIS, DLIS, LAS2, LAS3 and CSV for LIS the destination can be a file or a tape.  
The first step is to select the format output with the Format button.   



 
FIG: 12.1.2 Data Exporter 

 
 
Clicking on the Format button to select the appropriate export option. 
Once you have chosen the format type, select the Data button 
 
After Export to LAS2 Format has been selected, the following window will open with LAS selected as the 
export format. The next step is to click on the Data Button to select the data to export. 
 



 
Fig. 12.1.3 Select Data to Export 

A heading and log passes can be added from the Build Export File List window. Warrior 8 now uses an export 
template with the extention .AET to identify which curves are to be exported and sample rates for the export. 
The first time that you export a file, you may not have any templates. Just cancel that dialog window to set to 
default template and you can create and save a template later. Click the Done button after heading and all 
log passes have been selected. 

 
Fig. 12.1.4 Export File List 



 

 
Fig. 12.1.5 Pass selected with no template selected 

 
The default destination for the LAS file that is created is normally C:\ProgramData\Warrior\Data\ but the User 
may use the [<<Browse] button to select a different destination. Be sure to give a proper Windows file name 
for the output. 

 
Fig. 12.1.6 File Base Name 

 



 
 
 
Once the Format and Data has been selected go to the Details Tab. 
 
 
 
The Available list just shows whether that curve is on the current dataset.  From this dialog, you can make 
your own template that will contain the curves that you want to export.  For LAS you can rearrange the order 
of the curves to be exported in the order that they are listed.  If you want GR to be exported first, then click 
on GR and drag to the top of the list. 
 

 
Fig. 12.1.7 Details Tab 

 
 
You can double click on a curve to change the output mnemonic, API Code, or the sample rate. 
 



 
Fig. 12.1.8 Edit Item Window 

 
 
You can right click on a selection of curves to bring up a context menu – from there you can toggle the curve 
output on or off.  Right click to bring up context menu. 
 

 
 
Fig. 12.1.9 Selecting Curves 

 
Once you are satisfied, you can make your own template by selecting Save As… 



 

 
Fig. 12.1.10 Saving Template 

 
 
LIS export templates have the extension ‘iet’, and LAS export templates have the extension ‘aet’. 
 
The next time you start an export, you can select the template you made. 
 
  



12.1.3 LAS Options 
 

 
Fig. 12.1.11 LAS Options 

 
There are two radio buttons on the LAS options tab . 
Smallest Size generates the most compact LAS compatible file, it is best suited for email. 
Best Readability generates a LAS with a more intuitive header for opening in a text editor such as notepad. 
There are also five check boxes. 
Force Wrap Mode (80 col )  will generate a LAS that is wrapped at 80 colums, this makes it eiser to read in 
a text editor but may be less compatible with other intperetation software. 
Cheveron Format this will generate a LAS that folows the Chevron specific LAS format. 
 Output all Parameters as Curves this will treat all paraneters from the pass as data and output it as 
LAS data 
 No Curve Wrap, ( Non Standard LAS)   
 Multiple Passes Create Multiple LAS Files this will generate a separate LAS for each pass sellected 
if checked. 
 Use Data From heading if available the wil use heading data in theLAS header if it is present in the 
selected data.l    
 
 

12.1.4 LAS and LIS Mnemonics 
 
The LAS Mnemonics will be the default mnemonics that are loaded without using a template.  For example, 
if you have set up your mnemonic for LSPD to be SPED: 
The LIS Mnemonics will refer to the same list. 
 



 
Fig. 12.1.12 LAS, LIS Mnemonics 

 
 
Then when you select a pass to be exported, the default name for the output mnemonic will be SPED.  That 
can be overwritten if you use a template file: 
 

 
Fig. 12.1.13 LAS, LIS Mnemonics 



 

12.1.5 LAS and LIS Excludes 
 
Any output listed in the excludes list will not show up to be exported. 

 
Fig. 12.1.14 LAS, LIS Excludes 

 

12.1.6 Heading data to LAS 
 

 
Fig. 12.1.15 Heading to LAS 

 
 
The first column is the name of the heading item as saved in Warrior.  Those names are defined in your 
heading format file (*.hdg).  The Mnemonic is how that item will show up in the LAS file: 
 
Mnemonic.           Name from heading information: Description 
 
The heading data to LIS will work in a similar manner. 
 
 



 
 
 

12.1.7 Comment data to LAS 
 
If your heading has some longer data you want to display in the LAS file, then add the name to this section.  
LAS specifications are limited to 255 characters per line.  This allows multiple lines of data to be shown – 
each line < 255 characters.  The result will end up in a LAS section labeled as ~Other Information. 
 
 
12.1.8 Exporting to LAS3 
 
Exporting to LAS3 is like LAS2 except that you have the option to export waveform data and raw data. 
 

 
FIG: 12.1.16 LAS3 Details 

 

 

 

 

 

 

 

 



 

 

LAS3 has its own options selection, that function similarly to LAS2. 

 

FIG: 12.1.17 LAS3 Details 

 

  



 
 
 
12.1.9 Exporting to LIS and DLIS 
 
 
 

 
FIG: 12.1.18 LIS Data Exporter 

LIS has three destination formats, tap, nti, img and .dlis. 
 TAP is a tape compatible format. 
 NTI and IMG are image formats. 
 DLIS is a Digital LIS format. 
 There are three different tape image file types that can be selected by clicking on the [Destination] 
button when writing LIS files. .IMG files are raw image files. .NTI files are compressed disk image files. .TAP 
a tape images that were originally use for the Commodore 64 computer. In addition, if the computer you are 
using has a tape drive installed, it will be shown as a destination. 
 Consult with your client or computing center to select the most compatible format to their needs. 



 
FIG: 12.1.19 LIS Data Exporter 
 
Selecting the LIS data to export is done in a similar manner to LAS data. The main difference is that the 
Template that is used is an .LET file rather than an .AET file. 

 
FIG: 12.1.20 Select DATA to Build the LIS File 

 
 



 
FIG: 12.1.21 LIS Options 

 
The LIS Options has three check boxes. 
 
WellCAD Compatible (use nti or tap format) This will generate a Well CAD software compatible LIS 
 
Combine Heading data with log pass will generate a LIS with both Heading and log data. 
 
Heading data as KEY/VALU pairs ( LIS standard ) unless otherwise instructed use this selection for LIS 
generation. 
 
There are three heading options. The consult your customer for the appropriate standard.  
 
The LIS Mnemonics, LIS Excludes, and Heading data to LIS are the same as they are for LAS. 
 
The Comment data to LIS will take longer comments from your heading and export them to a comment 
section in the LIS file ( LIS logical record type 232 ). 
 
The Change Output Units allows you to select a specific Warrior unit and asign a text string to it. From the 
menu you can choose to add delete or edit your asignments. All the Warrior units will appear in a pull down 
menu ad your output unit will be a free for text. 
In the example the pull down unit was degF and the text asigned was degC. 



 
 

FIG: 12.1.22 LIS Change output units. 

 

12.1.10 Export to ODBC compatible Database 
 
The Export ODBC Compatible Database and Import ODBC into Warrior use the same program and either 
menu option may be selected. The computer exporting or importing must have Microsoft Office installed in 
order to use this option. 
 
This program will export data for Excel, Access and other ODBC compatible databases.  The limit for 
exporting data is 255 data points per sample.  A normal curve is one data point, but a waveform will be many 
more points for each sample.  You will see a message in the progress window that the column count has 
exceeded if you exceed that amount. In order to export to an ODBC format, you must have Microsoft Office 
installed. 



 
FIG: 12.1.23 Export to CSV comma separated values 

 

CSV export opens the same program as LIS and LAS exporter, ODBC export has be discontinued because 
the underlying software from Microsoft Office is discontinued. By exporting to CSV, you can easily manipulate 
your data in Excel. 
There is an options tab specific to CSV. 



  
FIG: 12.1.24 CSV Options 

 
 

12.1.11 Extract Pass(es) to New Database. 
 
The Extract Pass(es) to a New Database Utility allow the User to selectively copy passes from an existing 
database to a new one. 

 
FIG: 12.1.25 Extract Pass(es) to New Database 

 



 
FIG: 12.1.26 Select Database 

  

 
FIG: 12.1.27 Select Pass(es)  

 
 

You will be first asked to select the database and the pass / passes that you want extracted. Hold {CTRL} to 
select multiple passes. Then you will be asked for the copy target where the extracted passes will be sent. 



 
FIG: 12.1.28 Copy Target 

 
FIG: 12.1.29 Packing 

 

Depending upon the amount of data being copied, you will see a progress showing each item being copied 
into the new database. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 

12.1.12 Export via Internet 

 

 
Before you can start sending data you must ensure that the sending computer’s firewall has been properly 
configured. 
 
Log into your local NETWORK ROUTER, and OPEN the defualt port 19500 and forward it to the specific Lan 
IP of the exporting computer. 
 
 Then start the server software on the sending computer. 
It is found under Database Utilities. 
 

 
 



You should receive a Windows pop-up, from the Windows Firewall regarding Warrior’s 
WDBaseTCPServer. Click on allow access. 
 

 
 
If you do not receive the pop-up, Windows Defender Firewall may have already blocked the 
WDBaseTCPServer. To check this open the Windows Defender Firewall by typing Windows Defender 
Firewall with Advance Security in the Windows Search box. Check to make sure that WDBaseTCPServer 
is allowed through the firewall. 
 

 
 
 
 
Once the Server is open you will need to select the database you plan to use. To do this click on the Add 
Database to List button. You can send completed passes or passes in progress. Those choices are made 
on the receiving side. 
 
 



 
 
 
 

Once you have selected a Database you will have the option to use a password, if you do not wish to use 
one just click on OK. 

 
That is all that is required on the sending side. 
 
On the receiving computer go to Database utilities and select Import Via Internet. 
 



 
 
 
 
 
 
 
 

The first thing you will need to enter is either an IP address or DNS name server. This is the most difficult 
part of the setup. You may need to contact someone from IT. To find this information. They may request the 
TCP port number located on the lower right of the screen. 
 



 
 
 

Once connected you will see a list of available Databases on the host computer. Select the desired Database 
by clicking on it. It will then be highlighted in blue. 
 

 
 
 
 
 
 
 

Next thing you will be prompted for is the password entered earlier on the host computer. 
 



 
 
 

At this point you can transfer a completed pass or if you select New you will receive any passes updated 
after you have made this choice. In this way you can receive a current pass as it is being acquired. 
  

 
 

I have chosen specific for this example. Once selected I am prompted to select which pass or passes I wish 
to receive. Once again clicking on a choice will highlight it in blue. Once you are satisfied with your choice 
click OK. 



 
 

After clicking OK the next window will display the transmission status. This window will close once completed, 
it will remain open until you click cancel if you have selected New as it waits for new data. 

 
 



12.2 Interpretation Tools 

12.2.1 Mathpack 
See section 15 
 

12.2.2 XY Plot 
A cross plot will consist of one or more curves. Each curve will be created by plotting  database 
items against depth or time or from one database item against another database item. 
 

 
FIG: 12.2.1 XY Plot 

Select a database to work with.  
 

 
Fig: 12.2.2 Database selection 

 
 



 
If you have an existing format file (.xpt) you can open it at this time. 
 

 
Fig:12.2.4 Curve Setup 

 
Select New from the menu, if you have not loaded an existing (.xpt) file.  
Select Add Curve to create each curve. Each curve name will increment by 1 as you add curves. Select 
Delete Curve to delete the selected curve from the plot. 
To set up the cross plot you must first select what will be plotted on each axis. If depth or time is selected to 
plot on the x-axis, then no item will be selected to plot on the x-axis. Next select what database item(s) to plot 
by selecting the X - Axis or Y - Axis buttons. If you want to plot one database 
item vs. another, the items do not have to come from the same pass, but they must both be recorded on 
depth or both be recorded on time. Also, the items must have an overlapping depth or time interval to plot 
from. 
Once the plot setup is complete select the OK button, and the plot will start. The scaling will be done 
automatically. To change how the plot is scaled select Edit/Scaling. 
The plot can be made real-time, and if the auto-scale option is used, the plot will resize automatically 
to fit all the data points as needed. 
 

 
Fig:12.2.5 XY Plot Bond Index depth 



 
FIG: 12.2.6 XY PLOT Gamma ray Depth  

 
FIG: 12.2.7 XY Plot Selecting no lines between points 

 



FIG: 
12.2.8 XY Plot Depth Gamma ray  
 

 
 



 
FIG: 12.2.9 Selecting CCL for X and Y Axis 

 
 
A separate axis will be drawn for each curve unless the option Overlap scales for each curve is selected. 
If the auto-scale option is selected for the x or y axis, the left, right and/or top, bottom scales will automatically 
be calculated to fit all the data within the plot. If it is not selected, you can enter the scales yourself. If only 
one database item is selected to plot, then one of the axis will be depth or time. 
When plotting two database items, there is a depth or time scaling option. It can be auto-scaled, or a range 
can be selected. The scales for the depth or time must be within the recorded range of the interval being 
plotted. 
The x and y origin is defaulted to (0,0). If the origin is outside the range of data being plotted, then the origin 
will be moved to the bottom left corner of the plot. 
The X and Y ticks give an approximate count to the number of gridlines that will be shown on that axis. The 
gridlines will attempt to be drawn at an integral distance apart, so the displayed ticks may not be the same 
as what are requested. 
Sometimes it may not be appropriate to draw a line to connect each data point. To make a dot for each data 
point, deselect the option "Draw a line between plotted points". 
 

12.2.2.2 Plotting 
 
If the plot is being created as the data is being collected, then the Start Plot button will change to 
Stop Plot. Press the Stop Plot button to halt the plotting. If the data collection continues, then press Start 
Plot to plot the entire collected interval again. Starting the plot in the middle of data collection will plot over the 
interval as described in Scaling. 

 



FIG: 12.2.10 Start Stop Plot Button 

 
FIG: 12.2.11 XY Plot Two curves in the same chart 

 

12.2.3 Scaling 
 
The scaling menu allows you to manually or automatically scale both the x and y axis. It also has the options 
to set grid for both the x and y axis. There are four check boxes that select either displaying or not the grid 
lines, drawing lines between points and displaying scales. 
 
 

 
FIG: 12.2.12 XY Plot Scaling 

 



 
Fig:12.2.13 Scaling Menu 

 

12.2.4 Annotations 
 

To create an annotation, select Annotations/Create or click on the "<-ab" annotation button in the toolbar. 
When the annotation button is depressed, an annotation can be added. When the cursor is moved in to the 
plot area, the cursor will change to indicate the type of annotation that will be added. Right click on the mouse 
to change the annotation type. Left click to place the annotation on the plot. Type in the text for the annotation 
while the annotation is highlighted. To move an annotation, click and hold the left mouse button and drag the 
annotation to the appropriate position. To delete an annotation, left click on the item to be removed. When it 
is highlighted, press the delete key. To edit an annotation, left click on the item and then type in the new text. 
 

 
Fig:12.2.14 Anotations 

 



 

12.2.5 Zoom 
 

Select the Zoom in, zoom out buttons to change the cursor to a magnifying glass. Then select the area of the 
plot to magnify. To set the plot back to its default size, select the Auto scale button. 
 

 
FIG: 12.2.15 XY Plot zoom feature 

 
 
 

12.2.6  Save and Restore 
 

When saving the cross plot, two items can be saved. First the cross plot can be saved to a Warrior database 
to be plotted with pplot. Second, the plot setup can be saved and restored later with the cross plot program. 
Saving the setup does not save the plot itself - it only saves the curve(s) being plotted and the setup used to 
create the plot. 
The plot heading is only seen when the plot is printed. It can accept multiple lines by hitting the enter key at 
the end of each line. 

 



Fig:12.2.16 Save Plot and Setup 

 
 

12.2.3 Tracer Interpretation 

 
FIG: 12.2.17 Tracer Interpretation 

See Section 27  
 
 

12.2.7 Create Differential Curve 
 



 
FIG: 12.2.18 Create Differential Curve 

 



 
FIG: 12.2.19 Create Differential curves. (DIFFCCL) 

 

 
FIG: 12.2.20 Processing 

 
 

 

 

12.2.8 Create Total Dissolved Solids Curve 
 



 

FIG: 12.2.21 Create Total Dissolved Solids Curve 

 
When you select the Create total Dissolved Solids Curve the system will prompt you to select either a 
calculation using resistivity and delta travel time or resistivity density porosity in either decimal or percentage. 
 

 
 
FIG: 12.2.22 Total Dissolved Solids Options 

 



 

FIG: 12.2.23 Deep Resistivity 

Then it will request the Delta Travel Time curve or density porosity. 

 

FIG: 12.2.24 Delta Travel Time 

 

FIG: 12.2.25 Density Porosity  

 



12.2.9 Calculate Borehole Volume from Caliper 
 

 

FIG: 12.2.26 Calculate Borehole Volume from Caliper 

When selecting the “Create Borehole Volume from Caliper” the software will prompt you for Volume X Caliper 
Curve select your X Caliper and then OK. 

 

FIG: 12.2.27 Volume X Caliper Curve 



Then you will be prompted for “Volume Y Caliper Curve” If you do not have one select the same curve as for 
the X Caliper. 

 

FIG: 12.2.28 Volume Y Caliper Curve 

This will generate the Hole volumes. It ask if you want to calculate volumes to surface answer appropriately. 
It will then indicate the total footage processed. 

 

FIG: 12.2.29  Hole Volumes displayed As Tabular curves.  

 

  



 

 

12.2.10 Calculate Rxo/Rt and Rwa Curves 
 

 

FIG: 12.2.30 Create Total Dissolved Solids Curve 

Click on the Calculate Rxo / Rt button. This produces as file selection box, where the required database may 
be selected. Double click or Open the database file containing the input data for the calculation. 
The program presents a list of the log curves present in the database and requests selection of the Rt curve. 
Select the desired curve. 
 



 
FIG: 12.2.31 Select Dataset for Deep Resistivity Curve 

The system then requests the selection of the shallow resistivity curve. 
 

 
FIG: 12.2.32 Select Dataset shallow Resistivity Curve 

The system then requests the porosity curve for the calculation of Rwa. 
 



 
FIG: 12.2.33 Select Dataset for Porosity 

Note that the “A” and ‘M” variables must be present in the dataset for Rwa to be calculated. To set the values 
of “A” and “M” use Edit Variables in a Dataset. After selecting the porosity curve the system requests the 
name of the dataset for the output. 
 

 
FIG: 12.2.34 Select Dataset Output 

Select the required dataset and the system computes the Rxo / Rt and Rwa curves and displays a message 
indicating completion and log interval processed. 
 



 

FIG: 12.2.35 Processing 

Note that for the Rxo / Rt and Rwa curves to appear on the log, the respective curves must be added to the 
log format. The mnemonic for the Rxo / Rt and Rwa curves are RXORT and RWA respectively. 
 
 

12.2.11 Pipe Tally 

 

FIG: 12.2.36 Pipe Tally 



 

FIG: 12.2.37 Get Joints from a Log Pass 

 

FIG: 12.2.38 Scan log for Collars 

 

FIG: 12.2.39 Screen Plot 



 

FIG: 12.2.40 Scan Pass 

 

FIG: 12.2.41 Plot Pass and select area 



 

FIG: 12.2.42 Accept 

 

FIG: 12.2.43 Done 

 

FIG: 12.2.44 Done 



 

FIG: 12.2.45 Results 

For a more detailed look at Pipe Tally as it relates to multi armed caliper see section 18. 
18.1 Caliper Presentation 

 

12.2.12 Curve Normalization 
 

 

This program will cross plot two curves over a chosen interval.  Then it calculates the gain and offset required 
to apply to the second curve (Curve to be normalized) to make it overlay the first (Reference curve). 
Select the reference curve, then the curve to be normalized.  Interactive plot should start with the reference 
log pass.  You should be able to plot the curve to be normalized on that same pass - look in the progress 
window to see the name (alias) that was created for the normalized curve.  From interactive plot you can 
drag a rectangle over the interval to choose the depth range for normalization.  Once that is done, and then 
selects MakeXY.  If you are satisfied with the data points in the XY plot, then select Normalize.  Interactive 
plot will start again, but this time with the pass from the normalized curve.  If you look in the progress window, 
another curve will have been created in the Normalized pass.  That curve will be what the curve looked like 
prior to the normalization.  The name should be the same as the normalized curve except preceded by a ‘.’, 
and the normalized curve will have the original name. 



 

FIG: 12.2.46 Curve Normalization 

12.2.13 Log Summary Generator 
 

The log summary generator will produce a statistical analysis of tabular data in a database. 
There are radio buttons to select Minimum, Maximum, Average and Standard Deviation. 
The resultant table can is appended to the database and can be included in the plot job. 
 



 

FIG: 12.2.47 Log Summary Generator 

 

  



 

12.3 Data Import 

12.3.1 Read ASCII Data into the Warrior (LAS) 
In the Warrior System group, choose the database Utilities icon. The window shown below appears. 
The ASCII Importer reads data from existing ASCII file(s) and writes the data to one or more Warrior well log 
database files. 
Start the ASCII importer from the program group or Interactive Plot. The dialog and control box is presented 
as shown below.  
 

 

FIG: 12.3.1 Read ASCII Data into Warrior 

The input files are selected by clicking the Add Files button. This produces a file selection box as shown 
below. 



 

FIG: 12.3.2 Input File to Read 

 

FIG: 12.3.3 Select the ASCII File Type 

The importer will automatically import several common ASCII file types. Clicking on the Files of type selection 
displays the various ASCII formats handled. Select the type to be imported. 
If the ASCII file format to be imported is not displayed here, contact SDS. 



Select the required ASCII files in the normal way and click Open. 
The selected files may be viewed by clicking the  button in the Files to read: field. The selected files may 
be cleared by clicking the Clear List button.  
In Options Clicking the One log for each file radio button generates a warrior log pass for each ASCII file 
selected. 
Clicking the Merge all files into one log button merges all the selected ASCII files into one log pass. If the 
ASCII files contain curves of the same name, the importer will automatically add a numerical subscript to the 
duplicate curves according to the order they appear in the Files to read: list. 
The default presentation file for the new log pass is entered in the Log Format  field by clicking the 
corresponding Select File button. 
The filter list file has the default extension .wif. It may be selected by clicking the corresponding Select File 
button. 
Checking the Create Heading selection causes the importer to create a log heading file based on any 
available information from the ASCII input file(s). If no information is available, it will create a blank heading 
in the new database. 
Checking the Create Plot Job selection causes the importer to create a default plot job based on the log 
heading (if any) and the imported log passes. 
 

 

FIG: 12.3.4 Select File 



 

FIG: 12.3.5 Setup Warrior data Importer 

If required, the curves may be filtered during the import process. An ASCII text file must be created in the 
\warrior\bin directory and consist of a list of filter definitions like those used in the tools.ini file to define default 
filters 

 

FIG: 12.3.6 Start to select the curves 



If a curve is found with units that warrior does not recognize you will be prompted to select  the appropriate 
units along with a radio button to select weather the unit referenced should be save for future imports. 
 

 

FIG: 12.3.7 Identify Data Units 

 

 

FIG: 12.3.8 Reading the ASCII and convert to DB 

 
The status window displays a log of the importing operations. 
Having made the various selections and chosen the required options the importer may be run by clicking the 
Import button. The importer will read the selected ASCII files and display the status. 



Clicking the Heading button starts the Heading Editor program and displays the heading generated by the 
import process. If Create Heading was not selected a blank heading will be presented. 
Clicking the View button starts the Interactive Plot program for screen display of the results of the import 
process. 
Clicking the Plot button starts the Plot Job Editor program with the plot job generated during the import 
process (if any). If Create Plot Job was not checked a blank plot job is presented. 
The Close button closes the Importer program. 
 
 
 
 
 
 
 
 
 
 

12.3.2 Read LIS Data into the Warrior 

 

FIG: 12.3.9 Select Read LIS Data into Warrior 



If you are using a tape it must be copied to a disk file before it can be read in to a Warrior database.  Select 
‘From Tape’ and then select the tape drive and the output file name.  Once that is completed, select OK to 
copy the data to a file.  Once the data is read to a file, then a scan or conversion can be done. 
 

 
 

 
FIG: 12.3.10 Tape to file conversion 



 

FIG: 12.3.11 Select LIS file 

When opening the LIS, the default extensions will be shown on the lower right hand side of the open file 
dialog. 
 

 

FIG: 12.3.12 SCBLDemo.nti File 

Once you have selected an input file and an output database you can scan the LIS file. 
The scan dialog has an optional radio button to save the scan as a text file. 



 

FIG: 12.3.13 Scan 

Once you scan your file then select Curves/Constants. Here you can change the LIS Mnemonic to a Warrior 
Mnemonic. This way you can use your standard presentations, if you make a change here it will be stored 
by the system so that the next file will have the edited mnemonics. Double clicking on any of the curves will 
bring up the mnemonics editor. At this point you can also select whether to output the curve to the database. 
 
 



 

FIG: 12.3.14 Curves/Constants 

 

 

FIG: 12.3.15 Mnemonics Change 

 



 

 

FIG: 12.3.16 Convert List to Warrior 

The destination database file name does not have to exist, but the specific run given for the destination cannot 
exist.  For any LIS passes greater than the first pass, the LIS pass number will be appended to the output 
Warrior database pass name to create a unique Warrior name for each pass. 
If a header is requested, then the heading information will be filled out based on the type of heading chosen.  
The heading that is chosen will affect the list of available heading names shown when editing constants from 
the Curves/Constants dialog.  The heading that is created will go to /[field]/[well]/[run]/_plots_/_headings_/1.  
Only one heading is allowed per /[field]/[well]/[run]/.  Therefore, if a database is created from a LIS file with 
multiple passes, only the heading information from the first pass will be used to create the heading 



 

FIG: 12.3.17 Output 

 

FIG: 12.3.18 Header not Output Curves 

 

FIG: 12.3.19 Setup Output Details  

 



More Information Required for Waveform Data 
The top line of the dialog contains the pass number and name from the LIS tape.   
The start time for the waveform is the number of microseconds that elapsed prior to the beginning of recording 
the waveform. 
The waveform sample rate is the total sample interval (in microseconds) divided by the total number of 
samples taken. 
The minimum and maximum recordable waveform values are required for scaling the waveform plot properly.  
For example, a 13 bit-sampling device may have a range of values from –2048 to +2047. 

 

12.3.3 Import ODBC Data into Warrior 
This program will import data for Excel, Access, and other ODBC compatible databases.  The limit for 
exporting data is 255 data points per sample.  A normal curve is one data point, but a waveform will be many 
more points for each sample.  You will see a message in the progress window that the column count has 
exceeded if you exceed that amount. The Import ODBC to warrior opens the same executable as the export 
to ODBC but in the Import tab. 
 

 

FIG: 12.3.20 Import ODBC Data into Warrior 

The Import ODBC to warrior opens the same executable as the export to ODBC but in the Import tab. 
 



 

FIG: 12.3.21 Import ODBC Data Dialog 

 
From here you can select the source Destination and presentation. 
When you select source the select data source window will open from here you can select either dBase, 
Excel or MS Access. There is a new button that can be used to import another ODBC Type, unless you need 
one that is not listed you should not need this option. There is also a tab for File Data Source, unless you are 
using a server to retrieve you file you should not need this option. 
  



 

FIG: 12.3.22 Machine Data Source  

Once you select Ok the Select Workbook or another dialog will appear. Select your file that you wish to import 
and click OK. 
 

 

FIG: 12.3.23 Machine Data Source  



 

FIG: 12.3.24 Importing File Data  

 

 

12.3.4 Create Log format from Dataset 
 

This utility will allow you to create a presentation file from a log pass. 
 



 

FIG: 12.3.25 Create Format from Dataset 

Select the pass that has the desired embedded format you wish to save. 

 
FIG: 12.3.26 Create Format from Dataset 



 

 

FIG: 12.3.27 Select new presentation name 

 

12.3.5 Import VIA Internet 

 

 

FIG: 12.3.28 Import via Internet 

You can receive a saved data base or a real time database with the Import via Internet function. 
You will need the IP address of the sending computer and the port if different than the default the port number. 



 

FIG: 12.3.29 IP address and Port setting. 

 

12.4 Depth Correction 

See Interactive Plot Section 7 
 

12.5 Data Management 

12.5.1 Create an Alias for a Data Item 
Clicking on this button brings up a dialog box, which allows a data item, typically a curve from a log pass, to 
appear as though it were present in another (different) log pass. This allows curves and other data items to 
be effectively merged to other datasets, without using the Merge program or creating new merged log passes. 
Essentially a form of link is defined in the database(s) that allows application programs (such as Interactive 
Plot) to access data items from datasets other than the dataset currently selected.  
In the Warrior System group, choose the Utilities icon.  
 



 
FIG: 12.5.1 Select Create an Alias for a Data Item 

Click on the Create an Alias for a Data Item button. A dialog box will appear as shown below: 
 

 
FIG: 12.5.2 Browse DataBase 

Click the Browse button and select the database file, then the dataset (log pass) and finally the data item to 
aliased. In the case shown below the curve GR has been selected from pass12 of the cbldemo.db database. 



 
FIG: 12.5.3 Create data Item Alias 

This is the database item to be aliased to another pass.  
In the New Name for item field replace any or the entire data item path. For example, if we want this CCL 
curve to appear in pass1, we type over pass11 with pass1, as shown below: 
 

 
FIG: 12.5.4 Create Pass1 

 
The OK button is clicked and the CCL curve from pass11 will now appear in pass1. If a curve with the same 
name already exists in pass1 then the program will give a message indicating that this is the case and the 
alias will not be performed. The easiest thing to do in this case is to rename the CCL curve to something else 
(which does not already exist in that pass) e.g. CCL2. 
 

 
FIG: 12.5.5 Create CCL2 Curve 

Clicking the OK button will now alias the pass12 CCL curve to pass1 as CCL2. Note that if you now wish to 
plot this curve it will be necessary to include a curve called CCL2 in the presentation file with which the pass 
will be plotted. 
Note that a linear depth offset may be applied to the data item as it aliased, so if the curve is not depth aligned 
with the other data in the destination path, it may be corrected at this point. 
Note also that no new log passes are created in this process and the size of the database(s) remains the 
same. This is very important when wishing to present waveform data from several passes simultaneously, 
as large amounts of data would otherwise be created. 



12.5.2 Multiple pass Auto merge 

 

FIG: 12.5.6 Multiple Pass AutoMerge 

 

FIG: 12.5.7 Multiple Pass Automerge 



 

FIG: 12.5.8 Set Passes and Curves 

 

FIG: 12.5.9 Four new aliases curves 



 

FIG: 12.5.10 View option 



 

FIG: 12.5.11 Plot the new add curves 

 



12.5.3 Edit Variables in a Dataset 

 

FIG: 12.5.12 Edit Variables in a Dataset 

See Section 4.5.2 
 

12.5.4 Create Variables in a Dataset 
 
In the Warrior shortcut folder, double-click the Database Utilities icon. The Warrior Utilities menu box will 
appear. Click on the Create Variables in a Dataset button. 
 
 



 

FIG: 12.5.13 Create Variables in a Data set. 

 

 
 

 

 
A file selection dialog box appears. Select the required database, followed by the log pass (dataset). At this 
point a selection box is displayed allowing selection of the variable to be created in the log pass. Fig: Create 
Variables in a Dataset Double-click on the required variable name to create it in the pass variables. 
 



 
FIG: 12.5.14 New Variables  

 

 

FIG: 12.5.15 Choice the Variable 

Once you have chosen a variable to add you should go back to edit variable in a dataset and enter the 
appropriate value. 



12.5.5 Create Waveform Gate Curves 
 
 

 
FIG: 12.5.16 Create waveform Gate Curves 

Select the Database 

 
FIG: 12.5.17 Gate Curves 

This option is used to generate the high and low gate curves for sonic tools (e.g. CBL and RBT). 
You are prompted to select a database and pass containing a sonic tool with waveform data. The high and 
low gate curves are then automatically generated and added to the pass. 
When a CBL tool is in the database Warrior looks for the WVF3FT and WVF5FT waveform curves in the 
pass and generates WVF3FTLG (3ft low gate) and WVF3FTHG (3ft high gate) if the WVF3FT curve is 
present, and the WVF5FTLG and WVF5FTHG if the WVF5FT curve is in the database. 



These curves can be added to the Signature track as shown below in Fig:4.86 , and the low and high gate 
curves should straddle the first peak in the waveform. 
 

 
FIG: 12.5.18 Current pass List 

 



FIG: 12.5.19 Plot Curves 

 

 

12.5.6 Create CCL Curve from Keyboard 

 

 

FIG: 12.5.20 Create CCL Curve from Keyboard 

To add collars to a log select Create CCL Curve from Keyboard. This will open a dialog that will allow free 
form text box for the depth entries of the collars. Once entered and excepted a dialog will show the depth 
range of the collars to be created. You will then be prompted for a Database and pass to modify. A completion 
dialog will confirm the changes, the generated collars will be one division negative. 



 

FIG: 12.5.21 Enter Depths of Desired CCL 

 

FIG: 12.5.22 Dialog of CCL to be created 

 



FIG: 12.5.23 Select Database and Pass to add CCL 

 

FIG: 12.5.24 Ok Dialog 

 

FIG: 12.5.25 Inserted CCL’s 

 

 

 

 

 

 

 



12.5.7 Delete Data from a Database 
 

 

FIG: 12.5.26 Select Delete data from a Database 

 
FIG: 12.5.27 Delete Individual Item(s)  

To delete a database item e.g. a curve, click on Delete Individual Item(s). The standard database file selection 
dialog appears. 



 
FIG: 12.5.28 Select Database 

After selecting the database, the dialog for selection of the data item appears. 
Select the data item(s) to be deleted. All or no items may be selected by using the Toggle button. 
 

 

FIG: 12.5.29 Select Items 



A warning message appears informing that permanent data deletion is about to take place. 

 

FIG: 12.5.30 Permanent Data Deletion 

 

 
 
DATA DELETED WITH THIS UTILITY CANNOT BE RECOVERED 
 

 
Clicking No in the above aborts the operation. Clicking Yes proceeds with the operation and allows the choice 
to repack the database file immediately or to defer the operation until later. 
 

 

FIG: 12.5.31 Permanent Data Deletion and pack database 

 

Deleatig a whole pass is the same procedure but will eliminate all traces in the sellected pass 



 

FIG: 12.5.32 Delete Whole Pass(es) 

 

Selecting “Do deferred Disk Space Recovery Now” will repack the database eliminating unused spaced freed up during the 
deletion.  

 

 

FIG: 12.5.33 Disk Space Recovery 

Clicking Yes causes the data item to be removed and the database repacked immediately and clicking No 
marks the data item for deletion, buts defers the packing of the data base. 
 

12.5.8 Undelete Data 
 

To undelete Data, select the “ Undelete  Data” tool from Data Management, select your database and you 
will be prompted with a list of deleted data that can be restored. You can only restore one item at a time. 
Highlight the data to restore and click on restore. If you are done after the restore click close or select the 
next data item to restore, continue until complete. 
 



 

FIG: 12.5.34 Undelete Data 

 

 

FIG: 12.5.35 Select Data to Undelete  



 

 

 

12.5.9 Change a Name 
 
The change a name utility allows you to change the database name of a field, Well, Run, Pass or Item. Select 
the appropriate radio button for to rename, then browse to the desired database and item. Once you have 
selected the item to edit you will be prompted for a new name and optional new description. 
 

 

 

 

FIG: 12.5.36 Change a Name 

 



 

FIG: 12.5.37 Change a Name Selection 

 

 

 

 

FIG: 12.5.38 Change a Name Selection 

 

 



 

 

FIG: 12.5.39 Name change completed 

 

 

12.5.10 Edit a Log Curve 
 

To edit a log curve, select “ Edit a Log Curve “ and you will be prompted for a database and pass, select the 
appropriate pass.  

 



FIG: 12.5.40Edit a Log Curve 

 

 

FIG: 12.5.41 Select one or more curves to edit 

You do not need to select a curve at this time in warrior 8 this has been replaced, click on OK to continue. 
This will bring up an interactive plot with an edit tool in the tool bar. 
 

 

FIG: 12.5.42 Plot Curve 

After clicking on the edit tool right click on the curve you wish to edit, make sure that it is not wrapped. After 
right clicking you will be prompted to left click and draw a rectangle around the area to be modified. 
 



  

FIG: 12.5.43 Zoom Curve 

At this point you can either hand draw the curve changes in the zoomed box or by double clicking on the text 
windows depth you can manually enter curve values. 

 



FIG: 12.5.44 Draw  Curve Free Hand and  Manually. 

 

 

FIG: 12.5.45 Free Hand Gr 

12.5.11 Select Correlations Curves from Data Base 
 

Selecting correlation curves allows you to plot a curve (es) within a database along with any other pass. The 
first thing you will be prompted for is the database and then pass. Then you will be given the option to select 
a curve or curves. Highlight the curve and select add.  On the right hand side of the window you can select 
scales color and wrap like the format editor. You also have two radio buttons the first one “Always show in 
original track with original scales “ will place the curve in the same track with the same scales as the pass it 
originated in this will bypass the scales and tracks from above. This is the standard correlation mode. The 
second radio button “Only show when another curve by the same name is plotted, show with the same name 
and scales as the named curve” will plot the selected curve only if it exists in the pass to be plotted, it will use 
the same scales and track as the current pass.  
 



 

FIG: 12.5.46 Select Correlation Curves to for Database 

 

 

FIG: 12.5.47 Select Curve(es) for Correlation 

 



 

FIG: 12.5.48 Plotting Options 

 

FIG: 12.5.49 CCL Correlation Curve 

 

 

12.6 Setup Tools 

12.6.1 Calibrate Printer 
In Database Utilities click on the Calibrate Printer button. 
 



 

FIG: 12.6.1 Select Calibrate Printers 

 
FIG: 12.6.2 Select from Hardcopy Calibrate 

Printer box. It is recommended but not necessary Select the printer you want to calibrate. This printer may 
be made the Default Printer by checking the Default to undo calibration first, this will set the gain to 1.000000. 



 

FIG: 12.6.3 Undo Calibration 

Select “Make Test Print” this will prompt you for a database to plot. 

 

FIG: 12.6.4 Select Make Test Print  

 
FIG: 12.6.5 Select Database to Plot 

The calibration is based on two parameters entered by the user. Enter the required length of print output for 
any given log interval, e.g. 10 inches for 200 feet of log on a 5-inch scale (5 in = 100Ft). 
It means Scale 1: 240.  Enter the actual length of plot currently output by the plotter for the same log interval. 
Press Calibrate. 



 

FIG: 12.6.6 Calibrate 

Note that the required length can be any length, so that the current hardcopy may be forced to match any 
correlation log, even one with an incorrect hardcopy scale. 
 

 

FIG: 12.6.7 Click on OK  

12.6.2 Configuration Backup/Restore 
 

 

 See Chapter 9 



12.6.3 Edit Logging Service Details 
 

 

FIG: 12.6.8 Edit Logging Service Details 

 
See Chapter 13 
 

12.6.4 Edit Logging Tool Details 
 



 

FIG: 12.6.9 Edit Logging Tool Details 

See Chapter 14  
 

 
 

  



 



 

 

13 Service Editor 

The purpose of the Services Editor is to aid in modifying current services, creating new services, and 
importing and exporting services from similar types of Warrior systems. To start the Service Editor, go to 
Warrior Utilities and click on the Edit Logging Service Details. 
 

We suggest that a backup of the Services.ini file be made before any service editing, so 
that existing service information may be recovered if mistakes are made while editing. 
Probably the easiest way to do this is to use the Warrior Backup utility and do a backup. 
 

13.1 Edit logging services Details 
 

Section 

13 



 

FIG: 13.1 Edit Logging Services Details 

When the Service Editor window comes up, on the left side of the window are two service lists, labeled Active 
and Disabled. The active list of services will be displayed when a service is selected from Warrior Acquisition. 
The disabled list of services are included in the service.ini file but are not displayed in the acquisition service 
list. Normally there will be no services in the disabled list. 
When an active service is selected by clicking on it in the list, all the service details are displayed in the 
Service Details panel on the right side of the window.  This information includes the default interactive plot 
for that service, the selected zero point (encoder depth reference for zero offset) for the service, a service 
title, if a title other than the service name is desired, and a choice whether the service should always use the 
master copy of the presentation or open the master and use it for editing as a private copy of the presentation 
in the database. There are also four lists that are labeled Devices, Controls, Sensors, and Tools. Each list 
contains specific details about the service.  
 



 
FIG: 13.2 Services Editor 

The Tools list contains all the tool types that are available in the service. If a tool type is not listed in a service, 
then it is not possible to use that tool in that service. Tools may be listed but excluded. (Tools are normally 
excluded by removing them from the tool string using the tools string editor in Acquisition.) The STD tool type 
will normally be listed in every service since this includes sensors for depth, tension, line speed, tool voltage 
and current, etc. 
The Devices list contains acquisition devices that the system uses to acquire information. Depending upon 
the panel type, it may include a BASE, AUX, DSP, SDSTIP, ASCTEL, and others. Each device is set with a 
default sample rate of the maximum number of samples per foot. Some of the devices also require additional 
information such as the DSP Script file, the type of ASCII telemetry, and what hardware gain controls that 
the service will provide.  
The Controls list contains settings for hardware devices within the interface panel. This includes items such 
as filter settings for various signal paths, I2C Initialization codes for setting various initial relays states, and 
software controlled tool voltage setting for that service. 
The Sensor list contains the sensors for the tool types that are available. Each sensor definition must have 
the device that it uses to acquire its information. The definition also should contain a device channel number 
or a device channel name. If the device channel name is the same as the sensor, then that name is not 
required. The definition could also have a sample rate. If the rate is less than the device default sample rate, 
then the sensor data will be saved at the slower rate. If the rate is greater than the device default rate, then 
the sensor data will be saved the default rate of the device. If omitted, the sample rate will be at the device 
default sample rate. The sample rate can only be used if the channel is listed. (Sensor=Device, channel, 
rate). 
 
 
 
 



13.2 Editing an Existing Service 

 
The Service Editor can be used to modify settings in an existing service. To view the settings for a service, 
click on the service in the Active service list. The right side of the window will display the service information 
and settings for that service. 
The default presentation for a service can be selected from the Presentation drop down list. The list will 
include all PRS files that are in the “C:\ProgramData\Warrior\Format” folder. The interactive plot presentation 
will display outputs from the sensor information at that are included in the presentation. You can add more 
than one presentation, if added each presentation will be displayed as a tabbed output in interactive plot. 
If the box labeled Use private copy of presentation for all logs from this service is checked, then when the 
first pass of the service is started in a database, the default presentation is copied into the database as a 
private presentation. If any changes are made to the log format presentation, then those changes are made 
in the private copy of the presentation in the database. The changes are not made to the original presentation 
that is in the “C:\ProgramData\Warrior\Format” folder.  
If the box is not checked, then the presentation is not copied into the database. Any changes that are made 
to the presentation from interactive plot are made to the original presentation file. If later in time the file is 
viewed using interactive plot, then since the presentation is not part of the database, the current copy of the 
presentation (if it exists on the system) in the “C:\ProgramData\Warrior\Format” folder is used to display the 
presentation. If the presentation is not located in the Format folder, then no presentation will be displayed. 
Interactive Plot options would have to be used to select a presentation format for display. 
The Zero Point drop down list has a list of sensors in the service. Any of the sensors or the bottom of the tool 
string may be selected as the zero point. The zero point of a tool string has zero offset to the encoder depth 
reading. Scientific Data recommends that the bottom of the tool string be used as the zero point in most 
logging services. In perforating services, the CCL is set as the encoder depth. In services that are normally 
run in a time drive mode at a set depth, such as a Noise Log or Freepoint Log, the sensor of interest should 
be set as the zero point to be able to position the sensor as desired. 
In acquisition, when a service has been selected, that service name will normally be displayed. By typing in 
the Title field of the Service Editor, the service displayed may be different than the service name. 
 

 
FIG: 13.3 Service 

 

FIG: 13.4 Service different Name 

 

 



 

13.3 Adding and Removing Tool Types 

 
Tool types can be added or deleted from a service. To delete a tool type from a service, click on the tool type 
in the Tools drop down list. Then either push the <Delete> key on the keyboard or on the Services Editor 
menu bar, click on Delete. A window will come up to confirm that you wish to delete the selected tool type. 

 
Tool names, Model names, and Serial names can contain a maximum of 39 characters 
and cannot have any spaces. 
 

 

 
FIG: 13.5 Tool Delete 

 It is recommended that the sensors that the tool type produced be deleted in a similar manner at the same 
time, although if the sensors are left in, the service should still work. 
To add a tool type to a service, on the Menu Bar click on Add -> Tool. An Add tool dialog box will come up 
with the next available tool number. Enter the tool type in the dialog box. Only the tool type needs to be 
entered, a specific serial number for that tool type is not required at this time (i.e. Tool6=GR not Tool6=GR; 
Serial=1234). When the service is next used, it will call up the first available serial number of that tool type 
that it can find. It is necessary for the tool type to exist in the tools.ini file. If the tool type does not exist, then 
when the service is called up from acquisition, you will get an error message and it will not work. 
 
 



 
FIG: 13.6 Add Tool 

 

 

FIG: 13.7 Edit Tool 

 
When a tool is added to a service, sensor(s) will normally have to be added also. The software modules that 
the tool type uses will have specific sensors, as shown in the Tool Editor. Each of these sensors will have to 
be added to the service or when the service is called up from acquisition you will get an error message and 
the service will not work. 
To add a sensor to a service, click on Add -> Sensor on the Service Editor menu bar. The Add Sensor dialog 
window will come up. Enter the sensor mnemonic, followed by an equal’s sign “=”, then the Device that the 
sensor acquires data from, then the channel of that device, and the sample rate for storing the sensor data 
(Sensor=Device,Channel,Rate). The Device must be listed in the Devices drop down list. The device and 
channel that a sensor will use is hardware dependent, and in the case of the DSP also script dependent. It 
is beyond the scope of this document to explain further. For more help contact Scientific Data Systems, Inc. 
 
 



 
FIG: 13.8 Add Sensor 

 

 

FIG: 13.9 Type New sensor 

Devices and Controls may be added and removed in a similar manner. Again, they are hardware dependent 
and beyond the scope of this document. For more information contact Scientific Data Systems, Inc. 
Any line in the Devices, Controls, Sensors, and Tools list may be edited. To edit a line, click on the desired 
line, then on the menu bar click Edit. Double clicking on a line will also invoke the edit command. 
 

13.4 Add Surface Sensors 

 
ADD Wellhead Pressure Sensor on AUX4 
 
Select Database Utilities 



 
 
FIG: 13.10 Database Utilities 

Select Edit Logging Tools Details 
 

 
FIG: 13.11 EDIT Logging services Details 



 

Select the service to add the new WHP sensor 
 

 
FIG: 13.12 Select the Service 

Add new Sensor 
 

 
FIG: 13.13 Sensors 

 
Type WHP1 = BASE, 11 



 
 
 

 
FIG: 13.14 Add sensors  

 
Select OK and Save the service 
 

 
FIG: 13.15 Set sensors  

 
Open the service 
 



 
 
FIG: 13.16 Monitor sensors  

Select Monitor/Sensors 

 
 
FIG: 13.17 Sensors Value 

Sensor Value in Volts 
 
Select Monitor/Outputs 
 

 
 
FIG: 13.18 Output Value 



 
WHP1  (psi.)  
 
Select Action/Calibration Wellhead Pressure 1 
 

 
FIG: 13.19 Action/Calibrate 

 
Set the low and high value to calibrate the WHP1 Sensor. 
 

 
 
FIG: 13.20 Set Calibrations Points 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



On side DB25 Add 250 Ohms 
AUX4 - 
Auxiliary 
Inputs 

 DB25 Pin 
OUT 

 USB44 
 

SOFTWARE 
CHANNEL 
 

 4-20 mA AUX4-2 CC13-2 BASE,15 

 4-20 mA AUX4-3 CC13-3 BASE,14 

 4-20 mA AUX4-4 CC13-4 BASE,13 

 4-20 mA AUX4-5 CC13-5 BASE,12 

 4-20 mA AUX4-6 CC13-6 BASE,11 

 Frequency AUX4-9 CC13-34 CTR3 

 Frequency AUX4-10 CC13-35 CTR2 

  AUX4-21 CC1-19 +5V 

  AUX4-22 CC1-20 GND 

  AUX4-23 CC1-21 -15V 

  AUX4-24 CC1-22 +15V 

 
Add Resistors (250 ohms) to convert the current loop 4-20mA to Voltage 1 -5 volts 
 

 
FIG: 13.21 AUX 4 Hardware Connections 

 
 
 
 
 
 
 
 
 



 
WPH1 and WPH2 Connectors for ASW-Board version 11 or latest 
 
 

CONNECTORS 
INPUTS 

ANSW 
 

SOFTWARE 
CHANNEL 
 

SIGNALS 
 

WHP1-A CC7-11 BASE,9 -(4-20MA) Input Negative 

WHP1-B CC7-10  +(4-20MA) Input Positive 

WHP1-C      

WHP1-D CC7-8  WHP1 +15V Excitation 

WHP1-E CC7-20  Ground 

       

WHP2-A CC7-14 BASE,10 -(4-20MA) Input Negative 

WHP2-B CC7-13  +(4-20MA) Input Positive 

WHP2-C      

WHP2-D CC7-18  WHP2 +15V Excitation 

WHP2-E CC7-42  Ground 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



13.5 Realtime Calculator 

 

13.5.1 Realtime Calculator 

 

 
Real time calculations can be added to a service.  From the Service menu drop down, select RTCalc.  Or 
right click the service from the service in the tree view and select RTCalc from the context menu. 
 

 
 

FIG: 13.22 Realtime Calculator Service Editor 

Select RTCalc will bring up a formula editor. 



 

FIG: 13.23 Realtime Calculator Output Window 

Formula will require an output name and a formula to apply. 

 

FIG: 13.24 Realtime Calculator Formula Editor 

 

 

 

 

 

 



Type in a name for the output.  Select a formula to apply from the list. 

 

FIG: 13.25 Realtime Calculator Formula Selection 

Fill in the formula with output names and constant values - OK to save. 

 

FIG: 13.26 Realtime Calculator Formula Editing 

 



Add as many as you need to the formula list: 

 

 

FIG: 13.27 Realtime Calculator Multiple Entries 

 

 

 

 

 

 

 



Errors will be indicated at the bottom of the dialog 

 

FIG: 13.28 Realtime Calculator Error Indications 

Formulas can have optional arguments.  Insert in brackets: 

  

          AVG( CAL1, CAL2, [CAL3], [CAL4] ) 

  

** AS ALWAYS, save and exit service editor before loading service to pick up formula 

changes. 

  

 

 

 

 

 

 

 



 

 

 

 

 

13.6 Modifying the Service List 

 
The Service Editor can be used to modify the appearance of the service list in a variety of ways. Services 
can be renamed, have where they appear in the list changed, be temporarily disabled so that they do not 
appear as a selection in Acquisition, or can be completely removed from the services.ini file. 
To change the name of a Service in the active service list, click on the service. (Only services that are in the 
active service list can be renamed.) Then on the menu bar, click on Service -> Rename. A dialog box will 
come up with a place to type in the new name for the service. When the OK button is pressed, the service 
name will be changed.  
 

 
FIG: 13.29 Rename 

 

 



FIG: 13.30 Enter new Service Name 

Moving a service can change the order of the services in the active service list. To move a service, click on 
the service in the list. Then on the menu bar, click on Service -> Move.  A dialog box will ask you to choose 
a location in the current list to move the service to. The service will then be moved to the selected location in 
the list with other services between the original location and the new location moving up or down in the list 
as needed. 
 

 
FIG: 13.31 Move Service 

 

FIG: 13.32 Move service to 

A service can be disabled so that it does not appear in the Acquisition service selection list. It will  
remain in the services.ini file so that it can be reactivated or enabled at some later date. To disable a service, 
click on the service in the Active list. Then on the menu bar, click on Service -> Disable.  The service will 
immediately be moved to the disabled list. Any service that is in the Disabled list can be put back into the 



Active list. Click on the service in the Disabled list. Then on the menu bar, click on Service -> Enable. The 
service will immediately be moved from the Disabled service list to the bottom of the Active service list. 
A service from either the Active service list or the Disabled service list may be removed. Once removed it will 
no longer be available. When the service has been selected and Service -> Remove clicked on from the 
menu bar, a confirmation window will come up. If you click No, the removal process will be terminated. If you 
click Yes, the service will be removed from the list. 
 

 
FIG: 13.33 Service Delete 

13.7 Adding Services 

The two most common ways to add new services are to copy an existing service that you have or to import 
a service from an exported service list or a different services.ini file. Copying a service is normally used if you 
have an existing service that works, but you need an additional service that is very similar, such as having a 
Gamma Ray service that detects positive pulses and needing a Gamma Ray service that detects negative 
pulses. Importing a service is normally used to add a service that has tool types that the present service list 
does not support. 
 
 

13.6.1 Copying a Service 
To copy an existing service, click on the service that you wish to copy that is in the active service list. Then 
on the menu bar, click on Service -> Copy. A dialog box will come up requesting you to enter a name for the 
new service that you are about to create. The name cannot be the same as any name that currently appears 
in either the existing active or disabled service list. When you click on the OK button, the new service will be 
added to the bottom of the active service list. Be aware that the service information that is displayed on the 
right side of the Service Editor window is the information for the original service that was selected. If changes 
are to be made to the new service that was created, you must first click on that service in the active service 
list.  
 
 



 
FIG: 13.34 Copy service 

 

  
FIG: 13.35 Type new Service name 

 

13.8 Importing Services 

Services can be imported from a variety of sources. They can come from the Warrior cased hole 
(CH_80.serv.wbu ) service list or from services that have been exported from other warrior systems. With a 
little effort, they can be imported from service.ini files. Be aware that for an imported service to work, the tool 
types that the service calls out must exist in the tools.ini file. The Tool Editor can be used for restoring 
calibrations for tool types to the tools.ini file. 
 
 



  
FIG: 13.36 Import service 

  

FIG: 13.37 Select warrior service file 

To import a service, on the menu bar, click on Service -> Import. A browse window will come up looking for 
a WSV file in the Warrior\Config folder. If you select the CH_80.serv.wbu file, it contains nearly 135  logging 
services that support most types of cased hole equipment.  Click on one or more of the services that are 
listed. Each of the services chosen will be added to the bottom of the active service list. 
Services that have been exported from the service editor are normally saved with the WBU extension but 
have been given a file name at the time they are exported. These files may be read in the same manner. 
You may have to use the look in drop down list to locate the correct drive (and folder) to read them. 



 
FIG: 13.38 Select Verbose Import/Export 

I F  Y O U  E N A B L E  T H I S  C H E C K  B O X  A T  T H E  E N D  O F  E I T H E R  A N  I M P O R T  

O R  E X P O R T  A  T E X T  S T A T U S  W I N D O W  W I L L  P O P  U P  I N D I C A T I N G  W H A T  

W A S  I M P O R T E D  O R  E X P O R T E D  A N D  T H E  S T A T U S  O F  T H E  P R O C E D U R E .  

 

13.9 Exporting Service 

 
The purpose of exporting a service or multiple service is so that they can be imported and used on a similar 
system that uses the same type of devices. To export a service, on the menu bar, click on Service -> Export.  
A list of the existing active services is then brought up. Click on one or more services in the list and each will 
become highlighted. When the OK button is clicked, a Browse for Warrior Service File window will come up. 
Enter a file name in the file name box. When the Save button is clicked, the file will be saved in the folder 
indicated in the Save in: drop down list. 
 
 



 

FIG: 13.39 Export 

 

 

FIG: 13.40 Export service 

 



 

FIG: 13.41 Save new service 

This will create a wbu file containing the service(s) and serial numbers of all the services and tools selected. 
This file can be brought over to any warrior 8 system and imported. 

 

 

 

 

  



 

 

 

 

 

 

 

 

 

 



 

 

14 Tools Editor 

When tools are ran in a service (by editing the tool string for a service), they are chosen by type and serial 
number. Each serial number is assigned to a specific tool model. Each model of tool has the information that 
the Warrior System Software uses to process the data that it receives. This includes such general information 
as type of software, sensor offsets, sensor filtering, and tool length (which effects the offsets of other sensors 
in the tool string). 
By using the tool editor, the pertinent information for each model can be easily changed, new serial numbers 
created, and new models created. The Tool Editor can be accessed from the Utilities Program in the Warrior 
Software Group Menu. 
 

We suggest that a backup of the tools.ini file be made before any editing is done so that 
information may be recovered if mistakes are made.  
Tool names, Model names, and Serial names can contain a maximum of 39 characters 
and cannot have any spaces. 
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FIG: 14.1 Select edit logging Tool Details 

In the Fig: 14.2 through 14.7 show the way to take the tool measurements for Length and Offsets  



 
FIG: 14.2 CCL Tool Length and Offset 



 
FIG: 14.3 Gamma Ray /CCL Tool Length and Offset 



 
FIG: 14.4 Gamma Ray /Neutron/CCL Tool Length and Offset  



 
FIG: 14.5 Single Receiver Bond Tool Length and Offset 



 
FIG: 14.6 Dual Receiver Bond Tool Length and Offset 



 
FIG: 14.7 Dual Receiver Bond/Gamma Ray/CCL Tool Length and Offset 

 

 

 



 

14.1 Editing an Existing Model or Serial Number 

 
To edit the information for a tool, click the + beside the Tools icon. This will show all the different types of 
tools that are currently available. Click on the + beside the type of tool that you want to edit. This will show all 
the serial numbers that are available for that tool type. Next click either a Serial Number shown or click on 
the Model drop down list and choose a model type.  Any information that is changed will be changed for all 
serial numbers that are of that model type. 
The measuring Units used for all dimensions, sensor offsets, and filters can be selected to be entered as 
either English (In, Lbs.) or Metric (Cm, Kg).   
The Change Tool button can be used to convert a tool to a non-serialized item such as a centralizer or weight 
bar. Extreme caution should be used with this button. This is to be used to convert files from older versions 
of Warrior, to Warrior version 8.0. If a tool is converted to a tool with no serial number, the software type and 
all sensor information is removed.  
Tool information is entered by selecting the Model, Software, and Diagram tabs at the top of the window. 
Each tabbed sheet will contain specific information about the tool model. 
 

 
 

FIG: 14.8 Tools Editor 

Under Model Specific information, a brief description of the model can be given (This description will appear 
in the tool string diagram and in some calibration reports). The Length of the tool should be measured from 
tool joint to tool joint. This should be an accurate measurement in that it can affect sensor measurements for 
other tools in the string. The Diameter of the tool can affect services that do flowrate calculations. The 
combined string length, string weight, and maximum tool diameter will be presented on any tool string 



diagrams that are printed. Voltage and Current entries are not used by the Warrior software at this time but 
can be used as a reference for the user. A check box is supplied for tools that may have a variable length 
that can be set at run time such as guns or sinker bars.  
The Software modules to be used for logging can also be selected. The selection of the software modules 
will determine what sensors and filtered outputs will be available for that model of tool. Other model specific 
parameters may be available depending on the software modules selected. The Warrior 8.0 Software now 
provides for selection of multiple software modules in the same tool model although the sensors for each 
module are configured separately. 
 
 

 
 

FIG: 14.9 Select Tool Model 

Sensor Offsets should be measured from the lower makeup joint of the tool. Note that the sensor 
measurement for a source / detector or transmitter / receiver pair is half way between the two points. To 
change a sensor offset, double click on the sensor to bring up the edit box. Enter the appropriate 
measurements and click save. 
 

 
FIG: 14.10 Set Offset 

 



To change a filter setting, double click on the appropriate sensor. There is a drop down list for the different 
filter types. Square filtering should be used with sensors that would change slowly, such as Tool Voltage, 
while Gaussian filters should be used with statistical sensors, such as Gamma Ray. The longer the Filter 
Length, the more pronounced an effect the filtering would have.  
 

 
 

FIG: 14.11 Select the Filter Type and Filter Length 

For some software modules, a specific Cal Report (Calibration Presentation) can be selected for the tool 
model. 
The Model area contains information that is again determined by the software type. The Serial Number 
section is used for limited types of tools at this time.  
 
 

14.2 Tool Diagrams 

 
The diagram section of the tool editor allows the used to select or create tool diagrams for the tool model. If 
no Name is entered, the tool will be represented in tool string diagrams as a rectangle with the length and 
diameter given in the Model Specific area. The browse button next to the name box can be used to select an 
existing Warrior tool diagram. The selected tool diagram will now appear in the diagram window. The Zoom 
button can be toggled to change the display to see the complete width that will be displayed in a tool string 
diagram, although the length may not be to scale.  
 

 

FIG: 14.12 Select Diagram 



If you want to create your own tool diagrams using a third party graphics package, the only requirement is 
that the output file format be either Windows Metafile (*.wmf) or Windows Enhanced Metafile (*.emf).  Once 
you have created the file, copy it to your C:\ProgramData\Warrior\Format directory and rename it to (*.wtd) 
for Warrior Tool Diagram. 
For any diagram to line up when it is placed in a tool string, it needs to be modified by using the Tools Editor.  
Select the diagram you want to edit from the Tools Editor and the image should appear on the right side of 
the window.  A red box will appear also which indicates the location where the image should appear for it to 
line up with another image of the same diameter.  It is important that the image be sized using the proper 
diameter.  If you have two devices that you want to use the same image for, but they have different diameters, 
then you need to save two different tool diagrams, one for each diameter. 
To size the image, use the buttons to change the width and height as well as shift the image up/down and 
left/right.  You can also use the mouse to drag the image into position.  The mouse moves the image by 
clicking and dragging from the appropriate portion of the screen. 
Some tools, such as centralizers, may extend outside the red box. 
When you click the save button, the image gets written to disk and then read back and redrawn to verify that 
the save was done properly. 
 
 

 

FIG: 14.13 Select Zoom 

In the zoom mode, the red rectangle reflects the appropriate length and diameter specified for the tool. The 
user can now use the controls in the Move Diagram box to resize and configure the drawing as needed to 
shift the drawing left/right or up/down or to widen/narrow or lengthen/shorten the drawing. Ideally, the 
body of the tool should fit the red rectangle, with external components (centralizer springs, etc.) allowed to 
extend outside of the red rectangle.  
Within the red rectangle, there are four quadrants. The mouse can be used in each of these quadrants to 
configure the diagram in the same manner as the Move Diagram controls. By clicking the mouse in the top 
quadrant and dragging it up or down, the diagram will move up or down. Clicking and dragging up or down 
in the bottom quadrant will lengthen and shorten. Clicking and dragging to the left or right in the left quadrant 
will move the diagram left or right. The right quadrant will widen or narrow the diagram. 
Once the diagram has be resized and configured as desired, the Save and Save As buttons can be used to 
save the diagram as a Warrior Tool Diagram. The Save button will replace the existing diagram that was 



called up. Be aware that if any other model of tool uses this diagram, the drawing will be changed for that 
model also. The Save As button will prompt you for a new file name. 
The Undo button, will undo any changes that have been made since the file was opened or since the last 
Save or Save As. 
The user can create his own tool diagrams by pasting from the Windows Clipboard. Using a drawing 
application, you create the initial tool drawing. Then copy it onto the windows clipboard (Edit – Copy, right 
mouse click –Copy, etc.). When the paste button in the tool editor is clicked, you are first prompted to enter 
or select a file name for the drawing. When the file name is saved, whatever is on the Windows Clipboard is 
displayed in the diagram window. The drawing should then be reconfigured as described above to fit into the 
red rectangle. Finally, it should be saved again after the reconfiguration. 
 

14.3 Creating a New Serial number for an existing tool model  

 
If you have existing tools and wish to create a new serial number, find and select the serial number of an 
existing tool in the tool drop down list. Then on the menu bar, click Create - Tool. The New Tool dialog 
window will then come up and show the selected tool type, model type, the software module being used, and 
a list of existing serial numbers for that tool type. Enter a new serial number in the New Serial Number box 
and click OK. The new tool will use the same physical dimensions, sensor offsets, filters, and tool diagram 
as the model of the selected tool. 
 

 
 

FIG: 14.14 Select Tool  



 

FIG: 14.15 Type the new serial  

14.4 Creating a new tool type or a new model for existing tool 

To create a new tool, click on the Create selection in the Tools Editor menu bar. To create a new tool type, 
click the Tool drop down list and click on the first item in the list, <new tool type>. 
You will then be prompted to enter a new tool type.  - Be aware that any new tool that you have created can 
only be used if a Service in Services.INI lists that tool type as one of its available tools. 
If you are creating a new tool type, the Create New Model Type box will appear.  If you are going to create a 
new model for an existing tool type, once the tool type has been selected from the Tool drop down list, from 
the Model drop down list, select the first item in the list, <new model type>. 



 
FIG: 14.16 Select new tool type and create a new tool type  

 

FIG: 14.17 Create new model type 



 

FIG: 14.18 Select GR software for GR tool. 

You will then be prompted to enter a new model type. For any new model type, the software module(s) to be 
used must be selected from the software drop down list and then click the ADD>> button.  

 
Tool names, Model names, and Serial names can contain a maximum of 39 characters 
and cannot have any spaces. 
 

Continue selecting and adding software modules as need to include all the sensors in the tool.  A list of 
sensors for the different software modules is included at the end of this section (Software Module 
Description).  
The last step is to enter a New Serial Number. An Existing Serial Number drop down list is provided so that 
duplicate serial numbers are not entered. 
Certain software modules will allow you to also create a new sensor. Note that all boxes of the Sensor Details 
section must have data entered for the created sensor to work properly. The Sensor is the name that you 
wish to have as an output; it cannot be a duplicate of any sensor that would be in the same string of tools. 
The Units can be chosen and printed on the log insert and calibration reports. The Description can be printed 
on calibration reports that include this sensor.  
Once the basic sensor has be created and saved, reciprocal and/or differential outputs can also be created 
for the same sensor. 
 

 



 
 

FIG: 14.19 Create a new Sensor 

14.5 Creating a Tool 

 
As an example, we will go through the steps necessary to create a new tool sting for a Gearhart COSMOS 
GR/N tool. One version of the Gearhart COSMOS Gr/N tool is a single tool that is approximately 7 ¼ feet 
long and 1 11/16” in diameter, has a total weight of 25 pounds, and has three sensors, gamma ray, collar 
locator, and neutron. There are two different ways that we can create this tool. We can break it up into three 
separate tool types, with each type having its own software module. Or, we can make one tool type that has 
three software modules. We will do an example of each way. 
 

 
 

FIG: 14.20 Tool string editor 

First, we will do the three separate tool types with each type having its own software module. 
The first tool we will create is the neutron. Open the tool editor and click Create – Tool. Scroll down the Tool 
drop down list to NEU (if not in the list, click <New Tool Type> and enter NEU). Now enter a Model name by 
clicking on the model drop down list and clicking <New Model Type> and entering COSMOS (if not already 
in the list). Use the Software drop down list to pick NEU software, and it to.  Enter a unique serial number 
(CMOS001) in the New Serial Number box. You should now have a tool created but with no information for 
it as shown. 



 

  
FIG: 14.21 Select Tools Editor 

 
FIG: 14.22 Select Model 

Now we will have to enter all the information for our COSMOS model of neutron tool.  The length from the 
bottom of the source to the ccl joint is 48”, the weight we will guess at 15 pounds, the diameter is 1 11/16” or 
1.68”. 
The neutron detector is 14” from the bottom of the tool, but if we measure from halfway between the neutron 
source and the neutron detector to the bottom of the tool, we measure 8”, so our NEU offset is 8”. We will set 
the filter type to use a Gaussian 3 foot filter to start with. 



 

FIG: 14.23 Set Sensor, Filter, and Model values 

We will use a two-point calibration and use 60-second averaging for the calibration time. We will plot our 
output as Neutron API counts (NAPI), and not have a porosity curve. Our completed neutron tool should look 
as shown. 
We will use the length and diameter rectangle for a tool diagram Therefore we will not have to do anything 
on the Diagram page. 
We now need to create our next tool – the CCL.  Click on Create – Tool. Chose CCL from the Tool list. 
Check the Model list for COSMOS. If COSMOS is not in the list, chose new model type and enter COSMOS. 
Software should be set to CCL and a New Serial Number will need to be entered (CMOS001).  

 
FIG: 14.24 Set New Tool 



 

FIG: 14.25 Set Model values 

The length from the lower case to the upper case is 11 inches, we will guess at a weight of 5 pounds, and 
the diameter is 1.68 inches. The center of the CCL coils is 5 1/2” from the bottom case. We do not want to 
use any filtering with a CCL, so we set the filter to NONE and the length to 0.00 Feet. We will not set any of 
the model specific parameters. 
 

 
FIG: 14.26 Set Sensor, Filter, and Model values  

Finally, we need to create our Gamma Ray tool. Once again click on Create in the menu bar. Then choose 
Tool. Scroll down the Tool drop down list to GR (if not in the list, click on <New Tool Type>and enter GR). 
Now click on the Model drop down list and click on <New Model Type> and enter COSMOS. Click on the 
Software drop down list and choose GR software. Enter a serial number (CMOS001) in the New Serial 

Number box. 



 
FIG: 14.27 Set New Tool  

 

 
FIG: 14.28 Set Model values  

We now need to enter our model specific information. A tool description can be entered if desired. The length 
from where the upper case makes up to the top of the tool is 27 3/8”.  We will guess at a weight of 10 pounds. 
The diameter is 1 11/16”. 
The center of the gamma detector on this model is 16.68 inches up from the CCL. We want to use a Gaussian 
filter of 5-foot length, since this is a GM type detector. We will set this up with a two-point calibration with a 



gain and offset and use 60-second averaging. The output will be plotted a Gamma Ray API counts (GAPI). 
We will not do field verification. Our completed Gamma tool should look as shown below. 

 
FIG: 14.29 Set Sensor, Filter, and Model values . 

This completes all three sections for the tool being set up as separate tool types. To use this tool in a service, 
the service must include each of the separate sections in the list of available tool types (GR, CCL, and NEU). 
When the service is selected from acquisition and the tool string editor comes up, the proper configuration 
must be set up (GR on top, CCL in the middle, and Neutron on bottom), and the serial number for each 
section should be selected. 
Now we will go through the same process of creating the tool but will use a single tool type with all three 
software modules. 
Click on Create, then Tool.  Click on the tool drop down list and choose new tool type. Enter GR_N_CCL for 
the tool type. For the new model type, enter COSMOS. Choose and add the GR, CCL, and NEU software 
modules. Enter CMOS001 for a serial number. 
 



 

FIG: 14.30 Set New Tool 

 

 

 
FIG: 14.31 Set Model values  

The overall tool length is 77 3/8”, weighs 35 lbs., and is 1 11/16” OD. This information is entered the Model 
page. We measure the CCL from the bottom of the tool to the middle of the coils as 44.5 inches. The Gamma 
Ray detector is 66 5/8” from the bottom of the tool. And the Neutron measure point is 8 inches as in the 
previous example. For each software type, we will have to set up the appropriate sensors using these offsets. 
We will do the CCL module first. The offset is 44.5 inches.  The rest is set the same as the previous example. 



We do not want to use any filtering with a CCL, so we set the filter to NONE and the length to 0.00 Feet. We 
will not set any of the model specific parameters. 

 
FIG: 14.32 Set Sensor, Filter, and Model values 

To edit the Gamma Ray sensor, click on the GR software in the list. The sensor offset is 66.68 inches. The 
rest of the information is the same as the previous example. Gaussian 5-foot filter, two point calibration, 60-
second calibration averaging, output as Gamma Ray API counts (GAPI), and no field verification. 

 
FIG: 14.33 Set Sensor, Filter, and Model values  



 

FIG: 14.34 Set Sensor, Filter, and Model values  

Select NEU software to edit the neutron senor settings. Our NEU offset is 8”, Gaussian 3 foot filter, two point 
calibration, 60-second averaging, and output as Neutron API counts (NAPI), and not have a porosity curve.  

14.6 Deleting Tool Entries 

 
Options are available under the Delete selection of the menu bar. Sensors, Serial Numbers, Models, or Tool 
types can be deleted. Be careful in deleting information. Read the whole confirmation box closely. You would 
not want to lose a whole tool type when you meant to delete only a serial number. 
If a tool model has a user-defined sensor, click on the Sensor listed in the software specific area, and then 
clicking on Delete -> Sensor will remove that sensor from the tool model. 

 

FIG: 14.35 Select sensor option to Delete  

If a specific tool serial number has been selected from the tool list, then clicking on Delete -> Serial Number 
will remove that specific tool serial number from the tools.ini file. 



If a tool type has been selected from the tool list, then clicking on Delete -> Model will provide a drop down 
list of models of that type of tool. Selecting a specific model and clicking OK will allow you to delete that model 
only if no serial numbers are currently set to that model type. 
If a tool type has been selected from the tool list, then clicking on Delete -> Tool Type will delete all 
information for that type of tool. This includes all serial numbers and model information for any tools that are 
of that tool type. 

 

FIG: 14.36 Delete model for GR  

14.7 Saving Calibrations 

 
Calibrations can be saved to disk or restored. This is meant to be an aid in the transfer of calibrations between 
different units or to transfer tool type and model information from one unit to another. 
 



 

 

FIG: 14.37 Select Tool and serial number 

 
On the menu bar click on Tool Configuration, then click Export. Only one tool type can be selected, but as 
many serial numbers as desired can be placed into the file. The model information for each selected serial 
number can also be included. The file is given a WBU extension but is a mini tools.ini file if the model 
information has been included. When the Save button is clicked, the save dialog box is brought up.  The 
default is file name is the tool type and it is saved into the Warrior\Config directory. You can change the drive, 
folder, and name of the file. 



 

FIG: 14.38 Save Xipe calibration 

If you select an existing WBU file, you will be given the option of appending to the file or overwriting the file. 

  
FIG: 14.39 Save XIPE 

To restore calibrations, click on Tool Configuration on the menu bar, then click Import. When the dialog 
box appears, select the saved file from the appropriate drive and directory. Then select as many serial 

numbers as desired to be restored. 



 
FIG: 14.40 Software Module Descriptions 



 

FIG: 14.41 Software Module Descriptions  



 

FIG: 14.42 Software Module Descriptions  



14.8 Accessory Tools 
 

These tools such as centralizers, sinker bars knuckle joints etc., have no measurement. The only thing they 
affect in the tool string is the depth offsets of the other sensors and the tool diagram. If they are Over body 
tools, they will not affect depth offsets either. In the Tools Editor they are separate from the Logging tools. 
 

 
FIG: 14.43 Accessory Tools 

To create a new Accessory Tool is like creating a new logging tool, select create > Tool from the menu. This 
will bring up the New Tool window, in this case you will want to ensure that the “Tool accessory” radio button 
is selected. Notice that Category is now optional. You can now select an existing tool or a new tool type, if 
you select new tool type you will be prompted for a name, then a name for new model type. Once selected 
you can check the “Over body type” this is used for centralizers such as Gemcos and will not affect depth 
offsets. Now if you desire you can use a serial number, but it is not required. 



 

FIG: 14.44 New Accessory Tools 

 
You can now enter a description, tool length, Diameter and Weight. You have another opportunity to select 
Over body type. Here you will also notice a check box to select “Tool has Variable length” if you chose this 
option the length you enter here will be the default but when the service loads you will be prompted with the 
option to change the length. 

 

FIG: 14.45 tool Information 



If you click on the Software tab you will notice that it is grayed out and is not used for Accessory Tools. The 
next thing to change is the tool diagram it is modified in the same way as a Logging Tool. 

 

FIG: 14.46 tool diagram 

If you have selected a tool with a variable length when you load a service with your new tool you will be 
prompted with the following window. 

 

FIG: 14.47 Edit length of New tool 

If you had selected an over body, you would be able to potion it anywhere in the tool string without affecting 
the stack length. 



 

FIG: 14.48 Over Body 

 

  

14.8 Multiple Similar Instruments 
 

In certain instances, it may be necessary to have several similar tools, such as multiple pressure tools in a 
production logging stack or gamma Ray detectors in an ejector service. The easiest way to accomplish tis is 
with the use of the Prefix function. 

 

FIG: 14.49 Tool Prefix 



In this example shown we will and a dual detector GR. The first step is to add a Prefix we used “Dual_” to an 
existing GR instrument. 

 

FIG: 14.50 Tool Prefix Example 

Once that is done click on the software tab and add another “GR” from the available software, this will and a 
GR$2 to the software in the tool string and rename the “GR” to “GR$1” 

 

FIG: 14.51 Multiple similar sensors 



Once you have your sensors added you must enter the appropriate depth offsets for the detectors, and if 
necessary, change your tool diagram. Once that is completed save the tool and open the “Edit Logging 
Service Details”. Here you will need to edit the sensors so that they match your instrument. 

 

FIG: 14.52 Service Editor for GR$1 and GR$2 

Save your service and load acquisition to test your new service. 
 



 

FIG: 14.53 Tool Diagram with GR$1 and GR$2 

 

 

FIG: 14.54 Sensors GR$1 and GR$2 



 

 

 

15 Math Pack 

A math pack output is created by a formula applied to one or more values from existing databases. 
A math pack job consists of one or more math pack outputs. Each math pack job is saved in a file with the 
extension ".wmp". 
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FIG: 15.1 Warrior Utilities-Math Pack 

Math Pack user interface 
The Math Pack job file contains: 
A presentation file name and scale. 
Each output name, output units, data id, sample rate, description, and the formula used to create the output. 
The units for each input variable. 
Math Pack can be run from the command line - "Math Pack.exe [wmp file name]" to load a job file 
When the program loads. Note that the presentation file and scale will not be necessary if a Report is being 
generated. 

15.1 File Menu 

 



 
FIG: 15.2 Math Pack window. 

 
FIG: 15.3 Save Math Pack Job 

The file menu controls the Math Pack job files. The default directory for Math Pack jobs is 
"C:\ProgramData\Warrior\Config". The default extension is ".wmp". 
 
 
 
 
 

15.2 Output  

 
Each output requires a formula to create the output. 



To create a formula, either select Output/Add from the main menu, or press the Insert key when inside the 
Output box in the Math Pack window. 
To delete a formula, first highlight the formula to be deleted. Then either select Output/Delete from the main 
menu or press the Delete key. 
To edit a formula, first highlight the formula to be edited. Then either select Output/Edit from the main menu 
or press the Enter key. 
 

 
FIG: 15.4 Output options 

 



 

FIG: 15.5 Output /Add 

15.2.1 Output Units 
 
If an input variable has units selected as "None", then the units for that variable will come from the database, 
otherwise the selected units will be used. If the units for the output or input are "None", then no unit conversion 
will be done. Otherwise, an attempt will be made to convert the value from the input units to the output units. 
An example may be: 
CalAvg = (Cal1 + Cal2) / 2 
CalAvg units may be inches, Cal1 units may be mm, Cal2 units may be cm. 
Cal1 and Cal2 will be converted to inches before they are added together. 
 

15.2.2 Output Box 
 
The output box shows the output name, output sample interval, and the formula used to create the output. If 
the output sample interval is 0, then it will be calculated when the Run button is selected. 
The calculated output interval will be the maximum of the intervals of the input curves. Any zoned variables 
will be sampled at a rate of 600. 
 

15.2.3 Presentation / Scale 
 
The presentation file and scale to be used when creating a new pass. If the data is going to an existing pass, 
then the existing presentation and scale will be used. 
 

15.2.4 Main Input Data Source 
 
Will overwrite any data sources that were selected for curves. Will default data source for each formula 
variable to: field/well/run/pass/[variable name]/* 
At runtime, if it cannot locate field/well/run/pass/[variable name]/* then it will try to locate it as a zoned variable: 
field/well/run/pass/_vars_/[variable name] 
If that cannot be located, then a warning message will appear "Unable to connect to input [variable name] in 
[database]:[pass]" 
If the Output Data Destination is blank when this is selected, then a default new database name will 
be created. The new name will be: field/well/run/mpk_[x] where x increments for each math pack run. 
 

15.2.5 Output Data Destination 
 
This can be created automatically by selecting the Main Input Data Source first. This can be an existing 
database if the created curves do not exist already. If the created curves exist, then the following message 
will appear: "Unable to create output [database]:[pass]/[variable name]/1" 
If you select Generate Report from the Options menu, then the destination will be the location of the 
embedded text report. 



 

15.2.6 Processing Interval 
 
To process the entire input interval, leave FROM and TO values as "*". 

 

15.3 Formula Editor 

 

15.3.1 DataID 
 
A value used for Warrior databases. Default is 0. 
 

15.3.2 Description 
 
This will be written to the output database along with the output name. 
 

15.3.3 Formula 
 
To see what functions are available, select the "f(x)" button. This will also show what parameters are needed 
for each function. There is a different set of formulas for the Report output and for the Curve output. The AVG 
curve formula will create a new curve which will be the average of one or more curves - i.e. AVG(GR1, GR2, 
GR3). The AVERAGE Report will create the average value of the curve(s) over the entire interval. The MIN, 
and MAX functions are like the AVG function, and the MINIMUM and MAXIMUM functions work like the 
AVERAGE function. 
 

 
FIG: 15.6 Formula Editor 



15.3.4 Test 
 
This will run sample values through the formula and show the result. It will automatically fill the variables with 
values starting with 1 and incrementing for each variable. You can also test the formula with other values by 
placing a number in the Data Source box next to the variable name. 
 

15.3.5 Compile 
 
This will determine if the created formula will be able to compute a value. The Formula Editor window will 
change after the compile to show the new variable list. 
 

15.3.6 Data Source 
 
Select the Curve button to select a curve from a dataset. Select the Var button to select a zoned variable 
from a dataset. This will be the source of the data for each variable. This will also be filled in if the Main Input 
Data Source from the Main Window is selected. 
 

15.3.7 Variable Units 
 
To override the units from the database, change this setting; otherwise leave it "None". Also see output units. 

 
 

15.4 Options 

 
The Math Pack program will generate two types of outputs - curves and reports. The curve output will create 
another log pass with the output curves generated by applying the formula at each data point. A report output 
will generate an embedded text report, which will contain the results of the formula(s) applied to all the data 
points over the entire interval. The output data destination will be the location of the embedded text file in the 
database. 
 

 
FIG: 15.7 Options 



15.5 Demo example 

 
Create a new Math Pack Job  (demo), Add new output curve (GRADD), Select GR curve from DB 
CBLDEMO, ADD 200 API, and plot. 
 

 
FIG: 15.8 New Job Math Pack 

Type new Math Pack job “demo’ 

 

FIG: 15.9 Formula Editor Setup 

ADD or create a formula, either select Output/Add from the main menu, or press the Insert key  
Type on Name box “GRADD” 
Type on description box  “Gamma Ray ADD “ 
Type the formula GR+200 
Type the formula and click on Test  
Click on Save 



 

FIG: 15.10 Run Math Pack 

Select Main input data source from the warrior Data Base (SCBLDEMO)  
The Output Data Destination can be created automatically by selecting the Main Input Data Source first. 
Click on Run  

 

FIG: 15.11 Select New Curve 

Add a new curve GRADD 
 



 

FIG: 15.12 Set Curve 

Set Scales and Track values 

 

FIG: 15.13 Plot Curve 

Plot the Curve GRADD 
 
 



16 Cable Types and Filter Settings 

 
The Warrior 8.0 Software now includes provisions for setting certain parameters for user defined cables. 
These parameters include the line resistance for that line and filter settings for multiple user declared signal 
types.  
The line resistance setting for a line will be used in computing the Head Voltage Apparent output in all 
services.  
If a service has a signal type control in the service, then when that service is ran the Warrior Software will 
look for specific filter settings that have been saved for that signal type for the cable that is currently selected. 

16.1 Defining Cable Types  

The first step in setting up the process to use different cable selections is to define a new cable by name. The 
name can be any text string that the User wishes to identify that cable or type of cable. The name may be 
something as simple as “Truck 1234 – 5/16 Line”. It may also be something more specific as “1K22PZ – 7/32 
(12000 ft. to 18000 ft.) 
To declare a new cable, go to the Control Panel in the Warrior Program group. At the top of the window, click 
on the Acquisition tab. The Cable type section is in the upper right hand corner of the Acquisition sheet. 
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Fig. 16.1 Acquisition Sheet of Warrior Control Panel 

 
Fig. 16.2 Cable type section of the Acquisition sheet of Control panel. 

 
To add a new line, click on the [ Add ] button to bring up the New Cable Type Description window. 



 
Fig. 16.3 New Cable Type Description 

Type in the new name or description that you wish to use to identify the cable then click [ OK ] to accept the 
name. 

16.1.1 Setting Line Resistance  

 
Each of the defined lines may have a line resistance setting. Enter the measured resistance of the line, then 
click the [ Set ] button to assign that resistance to the currently selected line. The line resistance is used to 
compute a head voltage apparent output HVOLTA. This is calculated by multiplying the line resistance by 
the Tool Current output to give a line voltage loss and then subtracting this from the Tool Voltage output. 
HVOLTA = TVOLT – ( TCURR * Line resistance ).  
Unless the line resistance is accurate and the tool voltage and current are properly calibrated then the head 
voltage will not be an accurate measurement. 
  



16.1.2 Defining Cable Signal Types  

 
There are two different methods to set up signal types. The first are device signal types for certain proprietary 
devices. When the device is called out in a service, the software will look for a cable filter setting for the 
current cable.  
The more common method comes from the SDSTIP device (Scientific Data Systems Tool Interface Panel). 
The cable signal types for the SDSTIP are User defined types of signals, usually telemetry signal from the 
tool that are filtered through the CBL1D board in the interface panel. If a signal type control has been added 
to a service, the software looks for saved filter settings for that type of signal in the settings of the cable that 
is currently selected in the Warrior Control Panel. If cable filter settings are found, it will use those settings, 
otherwise a notification that no settings were found will be displayed and it will use the service default settings. 
The first time a cable is used with a signal type control in a service the settings will not be found, and a 
warning message will be shown. To save the filter settings for the currently selected cable, from Warrior 
Logging System Acquisition window click on Edit -> Device Configuration -> SDSTIP. Click on the [Update 
Cable Settings] button to save the filter settings for the signal type to the cable selected. The next time the 
service is started, no error message is shown, and the service default filters are used. To use the cable signal 
type filters, you will need to edit the device configuration for the SDSTIP again and select to use the cable 
type filters. That setting will be saved so that from then on, the cable type filters will be used unless they are 
turned off in the SDSTIP settings. 

 
Fig. 16.4 Cable filter settings not found. 

16.1.3 Example of Setting up Two Cables with different Filters for the same Service 

 
I realize how convoluted all of this might seem to someone not familiar with the process. As an example, to 
show the procedure for getting a service to run different filter settings, I will give an example of a CSS 
(Computer Sonic Systems) tool that has previously required two different services to run on different length 
of lines. 

16.1.4 Setting Two Example Cables 

 
We will be making two lines. The first will be the short to medium line and the second will be the medium to 
long line. To set up cable types we will need to go to the Warrior Control Panel Acquisition page. In the Cable 
Selection area, click on the [ Add ] button to add a new cable. 



 
Fig. 16.5 Click to Add a new Cable. 
When the Add new Cable Type window comes up, type in the description for the new cable type. Click the [ 
OK ] button to accept the description. 

 
Fig. 16.6 Enter short to medium line description. 
Click on the [ Add ] button again to add the second line. Type in the line description for the medium to long 
lines in the text window. Then click on the [ OK ] button to accept the description. 



 
Fig. 16.8 Enter medium to long line description. 
Next, we need to set the line resistance for each line. From the control panel acquisition page cable selection 
area, click the drop down list of cable selections and pick the short to medium line 

 
Fig. 16.9 Click Drop Down list to select cable. 
For this example, we will set the line resistance to 35 Ohm. Enter 35 in line resistance and then click the [ Set 
] button. 

 
Fig. 16.10 Set Line Resistance for short to medium line to 35 Ohm. 
Next, click the cable selection drop down list and select the medium to long line. We will put in an example 
resistance or 70 ohms, and then we click the [ Set ] button to save that value. 

 
Fig. 16.11 Set Line Resistance for medium to long line to 70 Ohm. 
Click the [ OK ] button at the bottom of the control panel Acquisition page to save changes. 

16.2 Setting up Signal Types through the Service Editor 

The next step is to add the Signal Type control to our services. From the Warrior Software program group, 
select Database Utilities. From the Database Utilities, click on Edit Logging Service Details to bring up the 
Service Editor. 



 
Fig. 16.12 Starting the Service Editor from Database Utilities. 
In the Service Editor, click on one of our CSS services to edit it. We will start with the “CSSM 3 18” RBT Short 
to Medium Lines” service. Then click on Add -> Control. 
 

 
Fig. 16.13 Select CSS Service and Add Control. 
Scroll down the Control Keyword dropdown list to “Signal Type”. For this example, we will enter “CSS_TEL” 
as the Control value for the signal type. Note that any text string that the User chooses may be entered for a 
signal type. SClick [ OK ] to save the setting. Click on File -> Save to save the edited service. 



 
Fig. 16.14 Set CSS Service signal type to CSS_TEL 

We now must add the same signal type control to the “CSSM 3 1/8” RBT Medium to Long Lines. Click on 
the service to edit it. Click on Add -> Control. Select the “Signal Type” Control keyword and enter CSS_TEL 
for the control value. Click [ OK ] to save the control value and then click on File -> Save to save the edited 
service. 

16.3 Setting Filter Settings for the Signal Types on each Line 

Now we need to set the filter settings for the CSS_TEL signal for each line that we will be using. Go to the 
Warrior Control panel Acquisition page, and in the Cable Selection area, click the dropdown list to select the 
5/16” – Short to Medium cable that we have already declared. Click [ OK ] to save. 

 
Fig. 16.15 Select Short to Medium line for use. 
Now start Acquisition and select the “CSSM 3 1/8” RBT Short to Medium line” service. You will get a message 
stating that you have incomplete filter setting for cable type. Click [ OK ] to cancel the message. 



 
Fig. 16.16 Filter settings not yet saved for this cable and signal type message 

To save the settings, Click on Edit -> Device Configuration -> SDSTIP. 

 
Fig. 16.18 Edit SDSTIP to save filter settings 

When the SDS Tool Interface Panel Configuration windows come up, click on the [ Save As Cable Settings 
] to save the current values to the cable type. Then click [OK ] to close the window 
 
 
 
 
 
 
 
 
 



Fig. 16.19 Saving the filter settings to 5/16” – Short to Medium line 

 

Now restart the “CSSM 3 1/8” RBT Short to Medium line” service and Edit -> Device Configuration -> SDSTIP 
again. This time the Use cable Type Filters check box has been enable. Click on this box to use the saved 
cable settings. This service now will use the saved cable filter settings every time until they are changed by 
editing the SDSTIP configuration settings and unchecking the Use Cable Type Filters box. 
 

 
Fig. 16.20 Selecting to use the saved Cable Filter settings. 
 
Now that we have set up a CSSM service to use the short to medium line settings, we must set up the 
medium to long lines service. Go to the Warrior Control panel Acquisition page and select the 5/16” Medium 
to Long line. Then Click [OK ] to close the control panel and save the selected cable. 



 
Fig. 16.21 Select the Medium to Long line to start savings CCS_TEL settings 

Now go to Acquisition and select the “CSSM 3 1/8” RBT Medium to Long line” service. You will once again 
get the warning message about incomplete filter settings for cable type. 

 
Fig. 16.22  Warning message for incomplete filter settings for cable type 

From Acquisition, we need to once again Edit -> Device Configuration -> SDSTIP and Click the [ Save As 
Cable Settings ] Button. Click the [ YES ] button to save the settings. Then click  [OK ] to close the SDS Tool 
Interface Panel Configuration Window.  
Fig. 16.23 Saving CSS_TEL filter settings for Medium to long line 

 

Now from Acquisition, restart the “CSSM 3 1/8” RBT Medium to Long line” service. When the service is 
loaded, we need to edit the SDSTIP configuration by clicking again Edit -> Device Configuration -> SDSTIP. 
Click the Use Cable Type Filters checkbox to bring in the saved cable settings. Then click [ OK ] to close the 
SDS Tool Interface Panel Configuration window. 



 
Fig. 16.24 Using  CSS_TEL filter settings for Medium to long line 

 
 
If you look at the filter settings that were saved in Fig 16.20  and Fig 16.24, they were: 
   Gain        Sonic Fc Sync Fc Aux Fc 
Short to Medium  1.50  1.00  6000 BP 
Medium to Long  2.00  2.00  6000 HP 
Now with Medium to Long lines selected in the Warrior Control panel, if you start Acquisition and select either 
the “CSSM 3 1/8” RBT Short to Medium line” service or the “CSSM 3 1/8” RBT Medium to Long line” service 
and then edit the SDSTIP configuration settings, you will find that both services are using the filter settings 
for the medium to long lines. Likewise, if you change the selected cable in the Warrior control panel too Short 
to Medium line, you will find that the short to medium filter settings are being used in both services.  
At this point, you could use the Service Editor to Remove one of these two services and then rename the 
remaining service to “CSSM 3 1/8” RBT”. 
If later, it is decided that you need to change the filter settings of the service for a cable, you would need to 
edit the SDSTIP Device Configuration and uncheck the Use Cable Type Filters check box. The software will 
revert the filter settings to what is saved in the service. Make any changes that you need and then [ Update 
Cable Settings ]. Restart the service and edit the SDSTIP device configuration to check the Use Cable Type 
Filters check box. 
 



17 Simulator Box 

The USB Simulator connects to the USB port of the system pc and receives 5-volt power up to 500ma from 
it.  Tool waveforms can be downloaded and then played back in analog form through the line or directly into 
the system.   Outputs to test the Depth Encoder and Tension are also provided. 
 

 
FIG: 17.1 Simulator 

 
When the USB Simulator is powered up by plugging it into the USB port of a PC or the USB HUB of a Warrior 
Interface panel, it goes through a two-step enumeration according to the device code found on EPROM IC5.    
Double clicking the SIMULATOR icon in the Warrior panel will bring up the control window.   
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FIG: 17.2 Simulator Controls 

Select LOAD and choose the tool waveform from a list.  These files are in the Warrior Bin directory. 
 

 
FIG: 17.3 Simulator tool files 

 
FIG: 17.4 Power Control 



 

FIG: 17.5 Outputs 

To playback the waveforms press the START button. 
There are slides for Encoder Speed and Output Gain.  The Encoder speed will depend on what number is 
input for pulses/foot.  120 should give a reasonable range.  If less speed is needed change the number to 
600 pulses per foot.  There is a button for high and long range.  Low range will provide speeds less than 100 
feet per minute.  There is a button for changing the direction, up/down. 
The Depth Encoder power from the interface panel lights an LED or both if it is twelve volts. 
 

17.1 Circuit Description 

The simulator gets its intelligence from IC1 – a Cypress AN2131Q EZ-USB controller with 8k of internal ram.  
An external 128k x 8 static ram, IC2 - CY71019B – is used to store waveform data.  IC5 - 24LC00P, EPROM 
is used to store the USB address code, so the device enumerates as a Simulator and not as something else. 
IC6 provides 3.3 volts for most of the logic from the USB 5 volt supply.   A DC-DC Converter supplies +/- 12 
volts from the 5 volts supplied by the USB port.  An external 5-volt supply can be used if it is needed. 
The encoder frequency is set by OUT0 from DAC, MAX519.  The DAC output goes to a voltage divider to 
reduce the 0 to 5 volt swing to 0 to 1 volt for the V to F converter, IC10, AD654.  Software controls the high 
and low range of the encoder speed.  The output frequency goes to IC9B, buffer, and then is split and one 
side inverted.  One side goes to IC12A, and the other to IC12B, SN74LS74, dual D flip flop.  These are wired 
to give two wave trains 90 degrees apart.  The A signal goes to Encoder Out A.  The B side goes to IC9A 
where PA5 sets direction.  When PA5 is changed the output of IC9A will be inverted.  That is how UP/DOWN 
is controlled.  The signal then goes to Encoder Out B.  IC7 and IC8 test the ENCODER voltage, lighting one 
led if it is five volts, or both leds if it is twelve volts.  The encoder pulses are derived from the supply voltage.  
A 5 volt supply produces 5 volt pulses and a 12 volt supply produces 12 volt pulses. 
SDA and SCL from IC1 control the DAC.  IC4 address lines: 01000000 address byte. 
PA6 controls IC14, DG411, switch.  It connects R32 for 20ma and disconnects it for 2ma.  The 12 volts from 
the STIP is converted to a current by IC7, LM317 to furnish the output signal.   The circuit will accept a 24 
input also. 



The data loaded into the ram, IC2, is sent to the DAC a byte at a time and reproduces whatever waveform 
has been recorded.  The chip enable comes off A15 to allow memory paging.  It is inverted.  Write enable 
and out enable are active low.  A15 is used because we are only interested in high addresses.   A16 comes 
from PC1/TXDO.  R36 was added to shift the DC offset of the DAC to zero.   The signal is sent from the DAC 
to U2A, TL082P, op amp, and then to U3, AD633, and voltage multiplier, through a 1K resistor.  The multiplier 
voltage is supplied by IC4, serial DAC, and OUT1, which set the output gain.  The signal then goes to U2B 
and IC3, BUF634, op amps to the line out connector. 
Cable to Encoder and Line Weight: 

17.2 SIMULATOR Hookups 

  
5 PIN MALE - Tension -------------------------Interface Panel    
 
A – TENSION SIGNAL GROUND REF ----------A 
B – TENSION SIGNAL OUT -----------------------B 
C – Tied to E   ------------------------------------------C 
D – +12 VOLTS IN------------------------------------D 
E – GROUND ------------------------------------------E 
 
7 PIN MALE – Depth Encoder 
  
 A – ENCODER-A 
 B – ENCODER-B 
 C – N/C 
 D – ENCODER POWER IN  
 E - GROUND 



 
FIG: 17.6  Simulator Box Hookups 

 



 
 
FIG: 17.7 USB SIM R2 board layouts 



 
FIG: 17.8 USB SIM R2 Schematic 

 



FIG: 17.9 USB SIM R2 Schematic 



 

18 Recorder 

18.1 Warrior Line Signal Recorder Service 

With the Recorder service, it is possible to make a recording of the line signal with minimal filtering. The 
recording can then be used to make a Simulator file to play back into the system through the Scientific Data 
Systems Simulator Box. Or the recorded file can be sent to Scientific Data Systems to check the tool 
telemetry or set up a new service for the tool telemetry. The recorder service is not normally installed as one 
of the default services. The service can be imported through the Service Editor.  
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FIG: 18.1 Select Edit logging Details 

To install the Service Editor, go to Warrior Utilities and click on [Edit Logging Service Details]. To Import the 
Recorder Service, Click on Service ->Import. From the Warrior\Config folder, choose the SDS_80.serv.wbu 
file and click the [ Open ] button. From the service import list, choose the Recorder service. It will then be 
added as the last service in your active service list. The Service Editor and Utilities can now be closed. If 
Acquisition is open, it will have to be closed and then reopened before the Recorder service will be available. 
 

 
FIG: 18.2 Service\Import 

 
FIG: 18.3 Import Recorder service 

To make a line recording, start Acquisition and select Service -> Recorder. When the Tool String editor comes 
up, click [ Save ] or [ Exit ], there are no tools to select or edit. In the Acquisition window click on Action -> 
Power Control and enable the line in the normal manner. Adjust tool power for proper operating voltage and 
current for the tool that you are using. The Recorder Threshold window will show a sample of the signal that 
will be recorded. No adjustments are necessary in the Recorder Threshold window. 



 
FIG: 18.4 Recorder  

 

 
FIG: 18.5 Set up Signal Recorder 

There are two other windows that come up when the Recorder service is started. These are the Panel 
Controls window and the Signal Recorder Setup window. The Panels Controls are not normally used unless 
the default Input Channel is changed from 15 to a channel that corresponds to the Sync, Aux, or Sonic input 
channels. This will be discussed further later. 
There are 4 settings in the Signal Recorder Setup window that can be adjusted. If any of these settings are 
changed, the [Apply Settings] button must be clicked before the recording is done, otherwise the original 
settings are used. 
The Input Channel is the selected DSP input channel (0 to 15). These channels are hard wired within the 
Warrior Interface Panel. Channel 15 comes from the ANASW board. The signal has been capacitive 
decoupled from the line and ran through a buffer. It is as true a raw signal as the system can digitize.  
The Sample Rate is how often the DSP will digitize the incoming signal. A 5us rate is appropriate for most 
recordings. It should not be set to lower than 3us. 
Signals may be attenuated on the DSP before they are digitized. Before doing a recording, the Attenuation 
setting should be adjusted to maximize the signal in the Recorder Threshold Window. The signal should not 
go to the top or the bottom of the window. The smaller the Attenuation setting value, the larger the signal will 
be. An Attenuation of 100 will not show any signal and will not give a usable recording. 
The record time is the number of seconds that the signal is recorded.  
When settings have been adjusted as needed and the [Apply Settings] button has been set, the next step is 
to click the [Record] Button. You will need to select a file name to save the file. It is recommended that the 
file extension show the sample rate so that the file can be played back at the appropriate rate to give a valid 
recording such as 5us for a 5-microsecond sample rate. Once the [Save] button is clicked, the recording will 
start and continue for the number of seconds set in the Record Time setting. The Record Time will count 
down showing the number of seconds left to record until the recording is complete. 



 
FIG: 18.6 Save the Recorder signal 

The following is a list of the Hard Wired DSP channels in the SDS Interface Panel. 
 

Input Channel Signal Note 

0 Sonic Amplitude Configurable Filter 

2 Audio X10  

3 Audio X1  

4 Sync / Pulse Configurable Filter 

5 Audio X.1  

6 Audio X.01  

8 AUX Configurable Filter 

15 ANASW Signal Recorder Default  

 

18.2 Converting Recordings to SDS Simulator Box Files 

The recording must first be converted from a DSP recording to a WAV file and then the file must be edited to 
fit a format needed by the simulator box.  
In "C:\Program Files\Scientific Data Systems\Bin" is SIMConver32.exe or  SIMConver64.exe that will read in 
a recording and write a WAV file. Click on the [Load Oscope File] button to select the DSP recording. After 
loading the file and before writing the 8 Bit Wave file, be sure that the sample period matches the sample 
rate done during the recording. For simple recordings, the difference in the Start Sample and Stop Sample 
should be less than 128000, since this is the maximum number of samples the Simulator box can hold. Click 
the [Write 8 bit Wave] button to write the file. If this is a simple file, it can be saved with a .SIM extension and 
used directly by the Simulator Box. 
  



  
FIG: 18.7 SIM convert 

  
FIG: 18.8 Open  

  
FIG: 18.9 Save As 

With more complex recordings, it may be necessary to use a Wave Editor to view and modify the recording 
before converting it to a simulator file. The Warrior software does not include a waveform editor, but there 
are many free editors available through the Internet. The following Internet link is a down load for a very 
versatile editor - http://www.yamahasynth.com/download/twe.html. 

http://www.yamahasynth.com/download/twe.html


If the signal being recorded has a periodic rate, the waveform should be edited to start before a given point 
in the period of the signal and to end before the same point at several cycles later in time and keep below 
the 128,000-sample limit of the Simulator Box. The waveform editor could also be used to adjust the 
amplitude of the recording or insert or enhance features in the recording, such as gamma pulses in a bond 
tool recording. 
 



 

19 Corrupted Database  

 
It is recommended to do a backup of the file before you begin this procedure. 
 
 

Run Windows Explorer.  
 
Go to the C:\Program Files\Scientific Data Systems\Warrior\Bin. 
 
Find a file called dbdump32.exe or  dbdump64.exe 
 
Double click on the program  
 
This will open a window called Warrior Database Dumper. 
 
In this window click on file and click on Dump Records. 
 
Select corrupted database.  
 
Click on file again and click on Scan Linkage. 
 
Select corrupted database.  
 
Click on file again and click on Scan Data Blocks. 
 
Select corrupted database.  
 
Close the Warrior DataBase Dumper Window.  
 
There will be three new files in the C:\ProgramData\Warrior\Data.  
 
They will have the same name as the corrupted database with the following extension: 
dsc, scn, and dmp.  
 
Email these three files to sds.info@warriorsystem.com 
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The programmer will attempt to create a patch. The patch will be Emailed back to you and you will run 
dbdump32(64).exe again from the   C:\Program Files\Scientific Data Systems\Warrior\Bin. 
From the Data Base Dumper Window click on file, then click on Patch. Select corrupt database and following 
instructions in Email. 
An example of a patch is attached below. 
Example of Patch for data base 14377.db. 
A set of patch number will be supplied by Scientific Data Systems, Inc. 
Long word patch: 
  
Hex offset   Old Hex Value   New Hex Value 
------------    -----------------   ---------------- 
000000D8     02149C8A        037FFD5A 
00000378     02147B86        02112D6C 
 
This is an example so do not use these numbers, the correct numbers will be supplied by Scientific Data 
Systems, Inc. 
Open Dbdump.exe by double clicking on the file.   
 

 
FIG: 19.1 Run Dbdump32(64).exe  

Click on File and then click on Patch: 
The Select Database for Manual Patch window will appear. 
Select the corrupted database and click on open. 

 
FIG: 19.2 Select Database 



The Manual Patch window will appear: 
Do not enter anything in the Password box. 

 
FIG: 19.3 Manual Patch 

Long word patch: 
  
Hex offset   Old Hex Value   New Hex Value 
------------    -----------------   ---------------- 
000000D8     02149C8A        037FFD5A 
00000378     02147B86        02112D6C 
 
Select the Long Button, enter the Hex Offset number, the Old Hex Value will appear enter the New Hex 
Value, press apply. 
If more than one patch set of numbers were supplied enter the next set and select apply. 

 
FIG: 19.4 Set values 

 

FIG: 19.5 Apply and Close 



Close the Manual Patch window, and the Warrior Database Dumper window.  The database should be 
accessible 
 
  



 

20 Panels Hookups  

DEPTH CABLE 
Depth Panel 7 Pin Female     Interface Panel 7 Pin Male 
 A 
  
  
  A (Signal A) 

 B       B (Signal B) 
 D       D (5 Vdc) 
 F              F (GND) 
 G 
            
ENCODER CABLE 
7 Pin Male       Depth Encoder 7 Pin Female 
 A       A (Signal A) 
 B       B (Signal B) 
 D       D (5 Vdc) 
 F           F (GND) 
 G 
TENSION CABLE 
Depth Panel 5 Pin Female     Interface Panel 5 Pin Male 
 C       A   
 D       B 
 E       E  
 
TENSION TRANSDUCER CABLE (XPRO-HONEYWELL PRESSURE TRASMITER) 
 5 Pin Male       Pressure Transducer  
 D       1 (Excite Usually Red)   
 B       2 (Signal Usually Black) 
 A        Shield           3 (Case) 
 E 
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TENSION TRASDUCER CABLE  (ASCO PRESSURE TRANSMITER) 
5 Pin Male       Pressure Transducer  
 D       3 (Excite Usually Red)   
 B       2 (Signal Usually Black) 
 A              Shield           
 E 
 
DC CABLE 12V DC 
3 or 2 Pin Male      Battery Truck (12 VDC)  
 A       Positive   
 B       Negative 
 C       NC 
 
LIGHTS CABLE  
4 Pin Male       Lights  
 A       Common   
 B       RED Light 
 C       GREEN Light 
           D       NC 
 

 
 





 





 



 

21 Perf Job Planner and UniFire 

21.1 Perf Job Planner 

 
The primary purpose is to assist in the design and assembly of perforating strings and help the user execute 
perforating and TCP jobs.  For TCP jobs, the result will be an inventory of all the items required to complete 
your TCP string.  For wireline jobs, you will have a list of all the runs you plan on making and the design of 
each tool string that goes in the hole.  For either type of job, you build every gun to your specifications, and 
then add all the other components required to complete the tool string. 

21.1.1 TCP Jobs 

For TCP, the job table will be the inventory list of all the items that will go in the hole. 

21.1.2  Wireline Jobs 

 

FIG: 21.1 Job Plan  

For Wireline jobs, the job table will be a list of all depth intervals that you will be dealing with during your job.  
One line in the job table will indicate either a depth to be perforated or a depth to set a plug or a depth to cut 
casing. 
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Each job consists of 1 or more Runs.  Each Run contains 1 or more Intervals.  Each run has a Base Service.  
The Base Service is what service will be run in the hole that will be attached to the gun, plug, whatever.  Each 
interval consists of either a single depth or a single depth range (top depth - bottom depth).  A run may contain 
more than 1 interval if the string contains a select fire assembly, or is a core gun, or is any other combination 
of devices that can be activated over more than one depth or depth range.  The other possibility is that you 
may have more than one interval that will be part of one gun.  If you must perforate from 5000-5002 and 
5008-5010, then that may be achieved with 1 10’ carrier but will still have to be entered as 2 intervals.  The 
program will verify with the user if two intervals can be placed in the same carrier and that will be shown in 
the Job table by two intervals with the same serial number.  Serial numbers of guns will be generated by the 
system and not editable by the user. 
One interval takes up one line in the Job table.  An interval consists of a single depth or a single depth range 
(top depth - bottom depth).  An interval must be associated with a run name and a base service and must 
consist of some type of device. 
here are two types of inventory you will need to do in order to take full advantage of the job plan module. 
 

21.1.2.1 Tools Inventory: 
Since the purpose of this is to design perforating and TCP jobs, to start you need to make entries for all the 
equipment you will run in the hole using the Tools Editor.  This includes gun subs, sinker bars, tandem subs, 
setting tools, firing heads, etc.  Some items you may want to create as non-serial items so you can add as 
many to a tool string as you need.  For this to properly calculate offsets and tool string lengths, all items that 
go in the hole that modify the length of the tool string need to be added to the tool string through the tool 
string editor.  For example, if you choose a 10’ carrier for a perforating job, that carrier will automatically be 
added to the bottom of the service you have chosen.  But you will have to add the top and bottom gun subs 
to the tool string through the tool string editor. 
 

21.1.2.2 Perforating Inventory: 
From the job plan module, you can create the gun types that you use.  From job plan menu select Job-
>Wizard, and then go to the Build guns tab.  From there you can create your gun types and charge types 
that you use.  Right click on the Gun Type, and then select New Item or New Category.  Each gun type can 
have 0 or more categories and each category can have 0 or more items associated with it.  Categories are 
optional.  For each item you create, you will see a picture on the right side.  Just click on the item you want 
to edit.  When you are done, select Save gun type.  Now when you go to creating a perforating job, you will 
select from your inventory and the gun will automatically be filled in with the requested shot length.  You will 
be warned if the requested shot length does not fit in the gun you selected. 

21.1.3 Getting Started 

There are two types of inventory you will need to do in order to take full advantage of the job plan module. 
 

21.1.3.1 Tools Inventory: 
Since the purpose of this is to design perforating and TCP jobs, to start you need to make entries for all the 
equipment you will run in the hole using the Tools Editor.  This includes gun subs, sinker bars, tandem subs, 
setting tools, firing heads, etc.  Some items you may want to create as non-serial items so you can add as 
many to a tool string as you need.  For this to properly calculate offsets and tool string lengths, all items that 
go in the hole that modify the length of the tool string need to be added to the tool string through the tool 
string editor.  For example, if you choose a 10’ carrier for a perforating job, that carrier will automatically be 
added to the bottom of the service you have chosen.  But you will have to add the top and bottom gun subs 
to the tool string through the tool string editor. 
 

21.1.3.2 Perforating Inventory: 
From the job plan module, you can create the gun types that you use.  From job plan menu select Job-
>Wizard, and then go to the Build guns tab.  From there you can create your gun types and charge types 
that you use.  Right click on the Gun Type, and then select New Item or New Category.  Each gun type can 
have 0 or more categories and each category can have 0 or more items associated with it.  Categories are 
optional.  For each item you create, you will see a picture on the right side.  Just click on the item you want 



to edit.  When you are done, select save gun type.  Now when you go to creating a perforating job, you will 
select from your inventory and the gun will automatically be filled in with the requested shot length.  You will 
be warned if the requested shot length does not fit in the gun you selected. 

21.1.4 Job Wizard 

Use the Job Wizard to complete the information for your job.  You will have 4 pages (tabs) of information to 
fill out.  The first 3 tabs will be the same whether you are doing a TCP job or a Wireline job. 
 

 
FIG: 21.2 Job Wizard  

 

21.1.4.1 Job information 
You can enter the database name of the correlation log here.  If you have a correlation log entered here, 
when you set your results, a well object will be added to this pass indicating the completion of that interval.  
All the other information is for reference use only. 
 

 



FIG: 21.3 Job Planner  

 

21.1.5 Shot Depths 

Enter your shot depth information here.  Fill in the job table with shot depths or select an item from the list to 
edit.  To enter a new interval, if the button says Update interval, press the Clear selection button.  Then type 
in your new depths and select the Add interval button. 
 

 
FIG: 21.4 Job Planner 

21.1.6 Build Guns 

Now that you have intervals in your table, you need to assign a gun type to your depth interval.  If you have 
no gun types in your list, then you must create new ones (see Gun types below).  To assign a gun type, first 
select the interval from the list of intervals, and then choose the gun type from the list of gun types.  If you 
want more than one interval to fit in one gun, then select more than one interval by using <ctrl> left click.  If 
the intervals can fit in one gun, then a message will pop up reminding you that more than one interval has 
been assigned to a gun.  Otherwise the same gun will be assigned to each of the selected intervals.  You 
should see your gun in the picture on the right.  The parameters that show up (length, top shot, etc. ) are the 
ones that you assigned to that gun type.  You can edit any of those parameters to change them for this gun 
by clicking on any of the values and typing in new values. 
The gun will be loaded by default starting at the top of the gun.  To change where the loaded interval starts, 
click in the loaded area of the gun (where the red dots are) and slide the loaded interval up or down.  The 
distance to the top shot and bottom shot will change as you slide the loaded interval.  The distance to the top 



shot can be no less than the top loadable number and the distance to the bottom shot can be no more than 
the bottom loadable number. 
When you are viewing the design of a gun with no interval assigned to it, the shots will be indicated in black.  
When you are viewing a gun that does have an interval assigned to it, the interval will be displayed in the 
upper left part of the diagram and the loaded interval will be indicated by red shots. 
You can print a picture of the gun from here to give to the gun loader. 

21.1.6.1 Gun types 

 

 

FIG: 21.5 Gun Types  

 

FIG: 21.6 New Item  

There are several predefined gun types, or you can add your own gun type.  Your own gun type will require 
a metafile picture to go with it.  To add new items, right click on the Gun type and then select New Item, New 
Category, or Delete.  For each type of gun, you can have 0 or more categories, and then for each category 
you can have 0 or more items.  You can drag and drop items and categories within their gun type if you want 
to organize things differently.  All the gun and charge type information goes in the file explobjs.ini so once 
you have all the standard gun information entered; you can pass out copies of this file. 
Once you have a new gun showing in the window on the right, you can edit any of the parameters for the 
gun.  All entries are edited by clicking on the value to be edited and then typing in a new value.  The following 
entries are critical to having the gun diagrams and shot calculations come out properly.  The Total length 



value is the total length of the item without any gun subs.  The Top shot value is the distance from the top of 
the gun body to the top shot.  The Shot length is the maximum shot length that this type of gun can be loaded.  
All the parameters can be edited for a specific gun once you assign this gun to an interval in case you have 
a carrier that is slightly different from the generic gun type you created. 

 
FIG: 21.7 New Gun Type 

 

21.1.7 Charge types 

All the charges that you create in this list will show up in the list of charge types that you can choose from 
when you edit your gun parameters from your gun picture on the right. 



 
FIG: 21.8 Add New Charge 

 

 
FIG: 21.9 New Charge 

 
 

21.1.8 Build TCP string 

Selected TCP for the job type, then you will see this tab.  The TCP job is centered around the gun shot depth, 
so as you add items to the string, their depth will be calculated based on the gun shot depth.  To find items 
to add to the TCP string, select the Edit TCP string button.  This will bring up the tool string editor and allow 
you to add and remove items from your TCP string.  It is up to the user to add any gun subs to the carrier to 
make the diagram complete.  If you have more than one gun in the TCP string, the depths will be referenced 
from the top gun.  You will have to fill in items below the top gun to get the rest of the guns on depth or you 
will get a warning message.  When you are completed with your TCP string, and then select the Finish button. 
 

21.1.8.1 Off Depth Warning: 
If you have more than one gun in the TCP string, then you may get a warning message that displays how far 
off depth the gun is.  The depth value is the amount of space you need to add above that gun to make it 
come out on depth.  If it is negative, then you have too much space above the gun.  From the Build TCP 



String tab, you can modify that amount by changing the value TCP Depths must be within.  The default is 
0.25 ft. 

21.1.9 Build Tool Strings 

Selected Wireline for the job type, then you will see this tab.  The first thing you must do is assign a service 
to one or more intervals.  From the services editor, there is an option for every service – “Make this service 
available for perforating”.  Only the services that have this option checked will show up as services you 
can assign to a perforating interval. 
Select one or more intervals from the list that will be run in the hole on one tool string.  Say you have 10 
intervals in the list.  You may have two intervals that you will perforate with one run in the hole - either with 
select fire or because they both fit on one gun.  Once you have those items selected, then choose a service 
from the list of services at the bottom of the screen and then select the Assign Service button.  The tool string 
editor will start up with those selected guns in the tool string as well as the tools from the service you selected.  
It is up to you to add your gun subs and any other items to make this match what you are running in the hole.  
When completed, select the Finish button. 
 

 
FIG: 21.10 Service editor  

21.1.10 Main Window 

21.9.1 Job menu 
Saving a Job:  The following information will be saved with each job: 

21.1.11 The job plan itself 

- /f/w/r/_jobplan_/_job_/1 
 
The results of the job 
 



- /f/w/r/_jobplan_/_report_/1 
 
Each tool diagram 
 
- /f/w/r/_jobplan_/_wtd_/[name] 
 
The TCP diagram ( for TCP jobs ) 
 
- /f/w/r/_jobplan_/_tcp_/1 

21.1.12 Utilities 

Insert a Well Object into a Log: Will create a well object in the run you have chosen.  The tool diagrams will 
be saved in the database also, so you can recreate the picture. 
 

21.1.12.1 Import/Export 
The loaded job can be exported to a floppy disk to be imported on another machine.   The floppy will contain 
one file with the job information as well as tool diagram files for the guns.  Note that every gun has a serial 
number assigned to it.  When the job is imported to another machine, those gun serial numbers may already 
exist, so the imported serial numbers may be reassigned to prevent conflicts. 
 

 
FIG: 21.11 Utilities Charge 

 

21.1.12.2 Changing order of runs 
Let’s say you have 2 different runs created.  Then you decide you want to have run 5 be the first run.  Click 
on run 2 and drag it up above run 1 and drop it.  You will be asked “Move run 5 before run 1?”.   The run 
numbers will be rearranged; run 5 will be called run 1, run 1 will be called run 2, etc.  The renumbering will 
always start at 1. 
 

 



FIG: 21.12 Reorder Runs 

 
FIG: 21.13 Job Planer swap Runs 

 

21.1.12.3 Running a wireline job 
Now that you have built a custom service for each run in the hole, you will control the service that is loaded 
from Job Plan.  Right-click the run you are making from the list of runs and select Load Service.  That will 
start Acquisition with the selected run.  Make sure the tool diagram matches what is going in the hole, 
including gun subs.  If this does not match exactly, then your Stop Depths will not be calculated correctly.  
When you close the tool diagram window, the Stop Depth will be updated, indicating the depth to stop the 
hoist to make the perforation.  If you have made a previous run with this service, then Acquisition should load 
with the next free pass as the Dataset. 
In the Depth Configuration screen, there is a “Stop Depth” setting that you can use to indicate when your 
logging depth is close enough to perforate. 

21.1.13 Active interval 

You will also notice there is an Active Interval choice below Load Service.  Since a single run in the hole can 
have more than one interval associated with it, you can choose the interval within the loaded service you 
want to be active.  If you only have one interval within the run, then that interval will be active.  The active 
interval will change the color of the depth to green when the hoist depth is at the active interval stop depth.  
Also, the active interval will have an icon next to the run indicating it is active. 
 

21.1.13.1 Results 
Once you have completed one interval, right click on the interval and select Results.  Your interval will show 
a different icon dependent upon what choice you make for your results.  You can also add a text string to go 
with your results.  You must at least choose one of the options (Successful, Unknown, Misfire) so you can 
keep track of the runs you have made already.  If you choose Successful, then it will automatically add a 
perforating  or plug well object to the log pass.  If you have a correlation log entry in your Job Information 
screen, then the well object will be added to that log pass.  Else the well object will be added to the current 
log pass. 
 

 



FIG: 21.14 Results 

 
FIG: 21.15 Comments 

 
FIG: 21.16 Job Status 

 

21.1.14 Print 

 
FIG: 21.17 Print options 

Select the option to print. 



  

21.2 UniFire 

21.2.1 Introduction 

Addressable switches provide the client with the ability to perforate zones in sequence and if necessary, out 
of sequence. This has become extremely popular with the advent of shale oil production and pump down 
perforating. Warrior supports addressable switches from various manufactures including but not limited to 
“GEO Dynamics, Guardian, Phoenix, Tru-Perf, Schlumberger, SRS and VeriFire. All the before mentioned 
switches operate with a Warrior STIP panel and a properly modified Probe shooting panel.  The STIP panel 
must have a PSXD R7. It is recommended that you have a TELA HR5 “with appropriate panel wiring “and 
an ANASW R15 or R16 with U1 and U2 update to a surface mount OP Amp. All ANASW R20 have the 
correct op Amp. Most switches that are compatible with Warrior software and hardware operate from the 
new unified desktop. All screen shots will be made using the Phoenix addressable switches but will be similar 
for others. The UniFire software has been optimized for pump down perforating for optimal speed and ease 
of use. 
 

 

21.2.2 UniFire Menu Option 
 

UniFire is a standalone application that loads the required software in a similar way that Warrior Acquisition 
does. Most addressable switches supported by Warrior are compatible with this front end. To load the front 
end simply click on the shortcut. 

 
FIG: 21.18 Warrior Shortcuts 

 



 
Once UNIFIRE is loaded you will be presented with a switch optimized front end. 

 

FIG: 21.19 UniFire Front End 

If you have a like to add a corporate water mark to UniFire save a bitmap with the name MyWatermark.bmp 
to the Warrior config directory “ C:\ProgramData\Warrior\Config “.  

 

FIG: 21.20 Water Mark 

 
21.2.3 Building a Stage 
 
To build a stage you have a choice of using the icons or the more traditional File pull down menu. Either 
choice will give you the same results. To create a stage select the tool bar icon furthest to the left.  



 

FIG: 21.21  Build a Stage  

 

 

 
This will bring up the Create Stages dialog. Enter the field, well, stage number and well color. The UniFire 
background will be colored in according with the color selected to ensure you are on the correct pad. At this 
point you can choose to reopen an existing database if you wish to continue a stage. Once you have 
competed the Create stage fields click OK. 

 

FIG: 21.22 Create Stage Dialog 

 

 

 

This will open the next configuration window. In this window you will build your stage, selecting the service 
will automatically populate the UniFire front end with the appropriate buttons for the switch ‘s manufacture. It 
will also populate this window with the switch options available. Notice the yellow background this was 
updated from the stage color selected on the previous screen. All subsequent Stage #1 screens will be 
yellow.  Once you have selected the correct service for your specific switches add the appropriate switch 
hardware for this stage. Below the Stage bottom depth there is a button that allows you to add optionally 
specific stop depths within the stage. 



  

Once you have saved the stage you can contiue to add stages by simply entering new dpths and clicking on 
save assuming the switch configuration remains the same. 

 

FIG:  21.23 Building a Stage Dialog 

 

When completed save the stage. Check that the stage is displaying the correct depths.  
The details Colum in this case indicates a Release Tool, 4 Guns and a Plug. The Details column will show 
R4P as a representation of your stage. If all the details are correct select close. 
 



 

FIG: 21.24 Populated Stage 

 

 

 

FIG: 21.25 UNIFIRE With Stage Loaded 1 



 

 

21.2.4 Using UniFire 

Again notice the background color is yellow coresponding to the stage color. In the top banner the stage 
number and top and bottom depths are shown. There are also buttons to add  a stage, edit a stage and an 
acquisition buton. Notice that a Release Tool, four guns and a Plug are shown graphically in the control panel. 
After the stage is loaded click on the Acquisition button. This will load Acquisition in the background, on the 
banner the panel control, PMon buttons are now enabled and Near the lower right hand corner the depth 
and line seed are also enabled. Selecting the Depth Control button will now let you adjust your depth. You 
may also notice that the status window and Line Tension windows have now become active. 

 

FIG: 21.26 UniFire With Aquisition Loaded 

Sellecting the panel control icon next to the PMON and Power icons will allow you to adjust CCL gain, 
telemetry signal, downlink level and depending on the service Gamma Ray or telemetry signal. 



 

FIG: 21.27 Panel Controls 2 

 
Clicking on the Pmon button displays the telemetry window and if included in the service the corelation 
window. 

 

FIG: 21.28 PMon without Corelation 3 

 



 

FIG: 21.29 PMon with Corelation 

 
 
 
 

 

 

21.2.5 Correlation Logging  

When Acquisition was loaded the buttons on the left had side of the screen were activated, at this point you 
can log up , down or on time. You can also inventory your switches. You must be at a save depth 200 ft 
before you can power up you correlation tool or inventory your switches. 
To run a coreclation down pass sellect correlate, make sure your power settings for your corelation tool are 
set correctly and your PMON thresholds and gains are corect. 



 

FIG: 21.30 Corelation Settings 

 
To end the corelation log and proceed to firing the switches stop the log and click on the Perf Mode button. 



 

FIG: 21.31 Logging Corelation Pass  

As you log the shooting depths will be highlighted on the log transitioning from yellow to green as you enter 
your perforation zone. 

 

FIG: 21.32 Highlighted logging zones 

 

 



21.2.6 Inventorying Switches 

To inventory click on the Inventory button, make sure your Sync Gain and Download Gain sliders are set 
correctly. You can monitor the uplink using the PMON window. 

 

FIG: 21.33 Switch Telemetry  

 

 
As the inventory is completed the individual switches will change color to green as they are found. There will 
be switch mismatch error if the switch count or type does not match the anticipated switches for the stage. 
 

 

FIG: 21.34 Switch Inventory  

 



 
 

21.2.7 Arming Switches 

At this point if you are on depth you can begin to shoot your switches. Click on any switch and the Arm button 
will be activated, if you need to shoot out of sequence you be prompted to use the control key on your 
keyboard while clicking yes on the Warrning window. 

 

FIG: 21.35 Selecting out of Sequence Switch 

 

Clicking Arm in sequence will highlight the selected switch and start the countdown timer, you will not be able 
to fire the switch unless you are at the correct depth. You have until the timer times out to position the gun 
and fire or you will need to reinventory and Arm. The depth shown will go from red to green when you are 
within the switches depth. There will be a message in the message box Arm Success when a switch is armed 
and ready to fire. 

 

FIG: 21.36 Arming the switch  



 
FIG: 21.37 Successfull Arming and on Depth  

 
 
 
 

21.2.8 Firing Switch 

When you click on the Fire button you should see aFire comand Sucsess in the message box. You should 
now be able to fire the switch using the Shooting Panel. As you ramp the Variac the shooting voltage and 
current will be shown on the window below the line tension. 

 

FIG: 21.38 Successfull Switch Firing 

 



If you right click on a switch that was fired you can display its shot profile.You can now continue to shoot the 
rest of the guns in sequence. 

 

FIG: 21.39 Switch Firing inn Sequence 

 

  



 

 
  



 

22 USB Shooting Panel 

The shooting panel has a new additional option Safety Software Key to run guns, if the panel has the USB 
port available (USB board inside), it should be connected to USBHUB back to the interface panel, add the 
DEVICE, SENSORS and Check the box to Make this service available for perforating must be include in 
the service  
Setup in the software the new device, add the Device CYSHPNL, 4 

22.1 Software set up 

 
FIG: 22.1 Device 
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FIG: 22.2 Add Device 

 
FIG: 22.3 Sensor 

Add the new two Sensors SHVOLT=CYSHPNL, and SHCURR=CYSHPNL 
 

 
FIG: 22.4 Add Sensor 

Shooting Voltage sensor 
 

3  
FIG: 22.5 Add second Sensor 



Shooting Current sensor 
Add sensor in order to acquire at the same time DEPTH and TIME versus Curves in the same Data Base. 
Double check the ADPTH = AUX is under sensor. 
Set the Data base for two outputs (Time and Depth) 
TimeToDepthInputSec = (seconds per time sample),     e.g. 0.10 
TimeToDepthOutputFt = (feet per depth sample),          e.g. 0.25 
 

 
FIG: 22.6 Add Time to convert to Depth Input 

Set the File Time with sample rate every 0.1 Sec, for high resolution for low resolution increase the sample 
rate  Time. 
 

 
FIG: 22.7 Add Time to convert to Depth Output 

Set the Depth File with sample rate every 0.1 Ft. for high resolution, for low resolution increase the sample 
rate to 0.25 FT. 
Check the option Make this service available for perforating  
 



 
FIG: 22.8 Set Service 

 

FIG: 22.9 Interactive Time Plot 

Select the File Pass1 to plot Time Vs Curves 



22.2 Time Plot 

 

FIG: 22.10 Time Plot 

The time plot is continues just depend of start acquisition (Record Up, Record Down, Record Time) 

 

FIG: 22.11 Depth Plot 

The Depth is the standard plot Depth Vs curves if the you stop the tool the plot stop to acquire data. 



22.3 Depth Plot 

 

FIG: 22.12 Depth Plot 



 
FIG: 22.13 Panels Connection 



22.4 Shooting Panel Calibration 

 

FIG: 221.14 Shooting Panel Calibration 

 

 

FIG: 22.15 Voltage and Current Calibration 



 

FIG: 22.16 Voltage and Current  Values 

22.5 Operation of the Shooting Panel 

 
The speaker will emit a continuous WARNING tone while the AC / DC switch is in the AC position. 
The ‘LOG’ and ‘AUX’ positions on the ‘MODE’ switch are active when the shooting panel is not powered. If 
the ‘MODE’ switch is set to the ‘LOG’ position, the ‘LOG’ and ‘LINE’ connectors on the rear of the panel are 
connected. 
 

22.5.1 AUX Position 
Place Switch in Aux Position 
The ‘AUX’ key switch position simply connects the AUX connector to the line connector on the rear of the 
panel. 

 
FIG: 22.17 Switch in AUX 



22.5.2 LOG Position 
Place Switch in LOG Position 
To log, set the 'MODE' key switch to 'LOG'. The 'SAFE LIGHT' connector on the back of the panel will have 
pins A & C shorted for a UNSAFE 'red light' to be illuminated on the rear of the logging truck. 

 
FIG: 22.18 Switch in LOG 

22.5.3 SAFE Position 
Place Switch in SAFE Position 
The panel is in 'SAFE' mode (line is shunted) any time the ‘MODE’ key switch is in the ‘SAFE’ position. The 
'LIGHTS' connector on the rear of the panel will have pins A & C shorted for a SAFE 'green light' to be 
illuminated on the rear of the logging truck. If the ‘MODE’ switch is in any other position, pins A & B of the 
‘LIGHTS’ connector are shorted to indicate an unsafe CONDITION. 
 

 
FIG: 22.19 Switch in SAFE 



22.5.4 CCL Position 
Place Switch in CCL Position 
To log CCL, set the ‘MODE’ key switch to ‘CCL’.  The CCL amplifier is now connected to the line. The 'CCL 
GAIN' control adjusts the relative reading of the 'CCL' meter and the 'VOLUME' control adjusts the volume 
of a speaker inside the panel that emits a chirp when a collar is detected. The CCL amplifier will function 
when the power plant is shut off as long as the 'MAIN' switch is on. 
 

 
FIG: 22.20 Switch in CCL 

22.5.5 ARM Position 
Place Switch in CCL Position 
To arm the panel, set the 'MODE' key switch to 'ARM'. The 'SAFE LIGHT' connector on the back of the 
panel will have pins A & C shorted for a UNSAFE 'red light' to be illuminated on the rear of the logging truck. 
 

 
FIG: 22.21 Switch in ARM 



 

FIG: 22.22 Set Stop Depth 

 

FIG: 22.23 Set Enable Shoot 

Click over Enable Shoot 



 

FIG: 22.24  Software Ready to Shoot 

 

Ready to shoot 
To shoot, verify that the 'MODE' key switch is set to 'ARM' and the 'ADJUST VOLTAGE' control is rotated 
fully counter clock wise. Set the 'AC / DC' switch the and the 'POS / NEG' switch to the required settings 
(NOTE: the 'POS / NEG' switch has no effect when the 'AC / DC switch is in the AC position.) The panel is 
now ready to shoot. Lift and hold the 'SHOOT' switch up and rotate the 'ADJUST VOLTAGE' control clock 
wise while watching the 'VOLTAGE' and 'CURRENT' meters. 



 
 
FIG: 22.25 CCL on Depth 

Tool on Depth CCL Reference 



 
FIG: 22.26 Positive Voltage and Current Shooting 

 
Set Switch in Positive position 
 

FIG: 22.27 Negative Voltage and Current Shooting 
 
Set Switch in Negative position 
 
 
 
 
 



 
FIG: 22.28 Voltage and Current Shooting 

Set Switch in AC position 
 
 
 
 
 

 

 

 

 

 

 

 

 



 

23 Distributable Digital Media 

The Warrior software now includes the option of being able to generate a distributable digital media that 
would allow a User to supply their clients an interactive copy of log data to view without having to have Warrior 
software installed on their computer. Multiple files may be included for different log runs. It also includes the 
option to add a PDF file to the distributable files. 
 
 
 The media would allow the customer to view the log much as interactive plot is viewed by scrolling up and 
down the log. It does not provide capabilities to alter the log presentation such as changing scales or adding 
or removing curves. It does have the ability to change the vertical scaling. If the plot was created with a 3D 
presentation attached, as often happens in multi-finger caliper presentation, the 3D imaging will also be 
included in the distributed files. 
 
Basic knowledge in the use of the Warrior Plot Job Editor is required in order to assemble a plot job from 
which the distributable media is created. Refer to the Warrior software manual for more information on the 
use of the Warrior Plot Job Editor. 
   

 

23.1 Writing Distributable Digital Media 

Once the option for distributable media has been invoked in the Warrior Software, the creating of the 
distributive digital media occurs through the Warrior Plot Job Editor much in the same manner as printing a 
log through a printer. 
  
  

23.1.1 Use of Plot Job Editor to Create Files 
After a plot job has been created in the normal manner and is ready to print and make copies, click on File -
> Print, as if printing the plot job. 
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Fig. 23.1 Preparing to print a plot job 

The normal printing dialog window will come up. Click on the Printer drop down list to see all the available 
printers. “Distributable Digital” will have been added to your existing list of printers. Select the “Distributable 
Digital” printer and then click the [Print] button. The Distributable Digital dialog window will then open.  
 

 

Fig.23.2 Click Drop Down List to view available printers 

 

Fig. 23.3 Select Distributable Digital 



 

Fig. 23.4 Distributable Digital Dialog window 

The first time the software is used the default Output Folder will be the Warrior\Data folder. The [Browse] 
button can be used to select a different Output Folder. It is highly recommended that the Output Folder 
be a blank USB Drive, writeable CD, or empty folder. The output will contain multiple files that could be 
misplaced otherwise. Once selected, this can be made to be the default Output folder by click the box beneath 
the folder path. 

 
Fig. 23.5  Selecting Distributable Media Output folder 

 
The Client Database name defaults to the Warrior Database name and plot job name. The User should 
change this so that it would be familiar to the Client and more descriptive of what the log is. 



 
Fig. 23.6 Renaming Client Database 

 
A PDF file will be generated as part of the distributable media package if the “Include Virtual Fanfold (PDF 
Image of the entire plot)” is checked. When the [OK] button is clicked, you might temporarily get a window 
that shows the progress of generating the files. When all the files have been written, you will get a message 
window that will say that the file is ready. 

 
Fig. 23.7 Files have be written to folder 

 
If you check the folder, you should see the files shown below. 

 
Fig. 23.8  Files created in folder 

 



 
Fig. 23.9  Example files in Files Folder 

IMPORTANT NOTICE 
If you have written to a CD / DVD or USB Drive, make sure that you properly eject the drive to ensure that 
files are completely written. Failure to do so may result in the client receiving unreadable data. 
 

23.2 Creating Multiple Files of Distribution 
 

If the user wanted to add another Plot Job to the same distribution file, you would go about it in the same 
manner and write to the same output folder, but the Client Database name would need to be changed so 
that the original data is not overwritten 



 

Fig. 23.10 Adding additional data to output folder 

 

 

 

 
 
 
 
 
  

23.3 Viewing Distributable Digital Media 

The Distributable Digital media has an Autorun.inf file included. If the Computer that is viewing the files is 
setup to use Autorun.inf files it will open the Menu viewing menu. The menu will include all log passes that 
were in the Plot Jobs that the media was created from. Any PDF files that were created of the plot job will 
also be shown as a Fanfold document. 



 
Fig. 23.11  Distributable Digital Viewing Menu 

 
To view any of the log passes or PDF Fanfold files Simply click on the desire one. PDF Fanfold files will be 
opened in Adobe Acrobat for viewing and the Log passes will be opened with a simplified version of Warrior 
Interactive. Plot 
 
 

  



 



 

 

24 Convert from 7.0 to 8.0 Warrior 

The conversion from Warrior 7 to Warrior 8 is a straight forward process with one exception, if your warrior 7 
services use CBL instruments. If you are unsure if you are using CBL or SCBL instruments go to section 
24.4.  

24.1 Procedure 

On the system with Warrior 7, Install Warrior 7 Backup for Warrior 8  “setup_w7bk_2013_11_19001.exe “ 
you will find this on the CD provided with your system or it can be downloaded from the Scientific Data 
Systems web site  
http://www.warriorsystem.com/private_download/Beta/setup_w7bk_2013_11_19001.exe 

 

FIG: 24.1 Warrior 7 Backup for Warrior 8 
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Once installed execute the program. This will convert your Warrior 7 configuration into a warrior 8 compatible 
configuration. The first thing you may notice is that in warrior 7 configuration backups took the form of a zip 
file and warrior 8 backups use a wbu extension.  
 
 

 

FIG: 24.2 Warrior 7 Backup for Warrior 8 Execution 

Make a note of where the backup file will be saved so that you can browse to it later to install the generated 
backup or copy it to a USB drive to be installed on another computer. 
The advanced button lets you modify which files to convert, this option is for the more experienced  and is 
beyond the scope of this manual. 
Once you click on begin the software will begin the backup process. You will receive a Backup completed 
status when finished. 



 

FIG: 24.3 Backup Completed 

 

24.2 Importing WBU file 

 
FIG: 24.4 Warrior Backup 



Select Restore tab in Warrior Backup and the File created with the Warrior 7 Backup for Warrio8. Once 
selected “ Examining” and a status bar will come up.  
 

 

FIG: 24.5 Opening Backup 

 

 
FIG: 24.6 Begin Restore 



Once the Examining is complete click on the Begin button. This will cause a pop up asking you if you want 
to Restore configuration from Warrior 7 , click on yes 
 
 

 
 
FIG: 24.7 Confirmation Pop Up 

This will begin the restoration process that will end with a text status window. 

 

FIG: 24.8 Restore Results 

This should complete your restoration; load acquisition and all your services and tools should be present. 

24.3 Importing select Services from Warrior 7 Backup 

You may wish to only import select services, this can be done from the same Warrior 7 backup for Warrior 8 
“wbu” file. Go to Database Utilities and select “ Edit Logging Service Details “. 



 

FIG: 24.9 Edit Logging Service Details 

 

FIG: 24.10 Browse to WBU file 



This will open a dialog that will allow you to select one or more services to import, by holding the control key 
and right clicking with your mouse. 

 

FIG: 24.11 Selecting services 

 

FIG: 24.12 Confirmation Dialog 

You will then be prompted to select or de-select specific tool serial numbers. 

 

FIG: 24.13 Serial number Selection 

At this point the service and selected serial numbers will be imported with a confirmation text window. 



 

FIG: 24.14 Status Text Box 

If the service or any of the serial numbers already exist, you will be given a confirmation window to confirm 
overwriting the existing file. 

24.4 Importing select Serial numbers from Warrior 7 Backup 
 

You also have the option of importing specific tool serial; numbers from the Warrior 7 backup for Warrior 8 
“wbu” file. Go to Database Utilities and sellect Edit Logging Tool Details. 



 

FIG: 24.15 Edit Logging Tools Details 

 

FIG: 24.16 Importing Tool 

Select the “Tool Configuration” tab and from the pulldown select Import. 



Browse to the Warrior 7 Backup for Warrior 8”wbu” file and select it. This will bring a a tool import window , 
here you can sellect a tool type and specific serial numbers. 
 

 

FIG: 24.17 Tool and Serial number selection 

Once you have selected the desired Tool and serial numbers click on Restore. This will bring up a 
confirmation dialog click on OK. If the tool and serial numbers do not exist on the system you will be given a 
confirmation message in the status window. 
   



 

FIG: 24.18 Restore Confirmation  

If either the tool or specific serial numbers were already present, you will be give an overwrite confirmation 
for each. 
 

24.5 Identifying a CBL Service  
Before using the Warrior 7 Backup for Warrior 8 you should confirm that your Bond services are configured to use SCBL  
as opposed to CBL instruments.  Go to Database Utilities and select Edit Logging Tool Details.  

 



 

FIG: 24.19 Edit Logging Tool Details 

Browse to your Bond tool Serial number, highlight it and click on the software tab. If under Software in this 
Tool string it has CBL  contact Scientific Data System for instruction on the most effective way to convert you 
service prior to running Warrior 7 Backup for Warrior 8.  

 

FIG: 24.20 CBL Service 



 

 

25 Spartek Tools 

25.1 Tool Editor Setup 

In the Warrior Utilities, Edit Logging Tool Details check to see if the default (sample) Spartek logging tools 
are present. SPTK-BULLPLUG, SPTK-CCL, SPTK-CENT, SPTK-FULLBORE, SPTK-GRCCL, SPTK-
MAST, SPTK-PTC, SPTK-SPIN, SPTK-TEMPPRES, SPTK-TPCD. 
 

 
FIG: 25.1 Tools Editor 
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If these tools are not present use the Calibrations->Restore feature to either restore the sample tools from 
“CH USB 70.wcf” or “SpartekPL.wcf”. 
There are also some “external” calibration files needed to correctly configure some of the tools, these are the 
pressure and temperature quartzdine format .cff and .cft files. These will be provided by Spartek, but sample 
files are included in our release and in the file “SpartekCals.zip”. These files need to be in the 
“Warrior\Config” directory. 
Special care needs to be taken when creating a new Spartek tool in the Warrior system when basing it on 
an existing example tool. The Spartek tools communicate their types and serial numbers via telemetry to the 
system, and likewise the tools are set up in Warrior to convey their types and serial numbers to the telemetry 
handling device (the DSP inside the panel). Each tool will be examined in turn to demonstrate where the type 
and serial information is stored to be passed on to the telemetry 
 
 

25.1.1 SPTK-BULLPLUG 
Well, the first one on the list is an exception to the rule, no ID or type; this tool can be copied again as 
necessary without any special steps. 
 

25.1.2 SPTK-CCL 
In the example screenshot the field in the Software, Serial section termed “TelID” needs to be filled correctly, 
this tool, serial number L00121, has the TelID field set to “ccl@121”, this is type@serial and the format 
follows through the tool family. Note that the “L00” has been stripped off, this is because the tools identify 
themselves in telemetry in the same manner, only the numerical part of the serial number is used. This field 
will need to check and filled when creating new tools. 

 
FIG: 25.2 CCL Tool 

The centralizer does identify itself in the tool string so appropriately there is the need for it to have the correct 
TelID setup. In the first screen shot the software section of the tool serial L00318 is shown having a  



25.1.3 SPTK-CENT 
Sensor called “IDOnly”, double clicking on this brings up a second screen where the field “Telemetry ID” is 
filled in with “cent@318”. This field will need to be checked and filled in correctly for new tools created in the 
system. 

 
FIG: 25.3 CENT Tool 



 
FIG: 25.4 CENT Sensor 

25.1.4 SPTK-CFB 
This tool type takes care of the 1-3/8” caged spinner tools. The example shown with tool serial “L00264” 
shows the TelID field in the Software screen, Serial Section, filled with “cfb@264” appropriately. This field will 
need to check and filled when creating new tools. 

 
FIG: 25.5 CFB Tool 



25.1.5 SPTK-FULLBORE 
This tool takes care of the 1-3/8 folding flow meter. It is setup in the same manner as the SPTK-CFB as seen 
in the following screenshot, the “TelID” uses the same “type” being “cfb” as before. This field will need to be 
checked and filled when creating new tools. 

 
FIG: 25.6 CFB Tool 

25.1.6 SPTK-GRCCL 
The setup for this tool is slightly different as for the spinner tools as the tool incorporates two software modules 
combined to represent the tool in its single housing, being the CCL and GR. The “TelID” information only 
must be present in one part of the tool information, we have chosen to use the CCL screen as this is the 
default when looking at the tool information and creating the new copies of the tool. In the screen shot below 
for example tool “L00043” the “TelID” is “grccl@43”. This field will need to be checked and filled when 
creating new tools. If you click on the “GR” in the “Software in this tool string” box you will see the GR 
setup and note that intentionally the “TelID” field is left blank, this does not have to be filled in as the CCL 
software is communicating to the telemetry that the tool is present. 



 
FIG: 25.7 GRCCL Tool 

25.1.7 SPTK-MAST 
This takes care of both the 1” and 1-3/8” telemetry master tools. There is one example of the 1” tool, serial 
“L00020” and several examples of the 1-3/8” tools, such as “L00041”. Care must be taken when copying one 
of these tools to create a new one in the system that the correct model type is selected, this is in the “Model” 
tab-screen of the tool in the Tools Editor. The SPTK-MAST tools have three sensors, double clicking on any 
sensor will bring up its set-up screen. As each sensor can have a “Telemetry ID” but we only need one to 
convey the tool type and identity to the telemetry we have chosen to set this up with the “CHV” sensor. Care 
must be taken to check and fill in this field when copying  these tools. 



 
FIG: 25.8 MAST Tool 

In this example the “Telemetry ID” is “mast@41”, the same type “mast” is used for both 1” and 1-3/8” tools. 

 
FIG: 25.9 Edit sensor 



Calibration values for the INCL and ZACC must be provided by Spartek and are hand-entered in the software 
using Acquisition->Edit->Calibrations and selecting the appropriate output. For example, with the INCL 
(inclinometer): 

 
FIG: 25.10 Edit Calibration 

25.1.8 SPTK-PTC 
This tool is another composite of several tool software modules using CWH (Capacitance) and PRESTEMP 
(Pressure/temperature) software. The example tool “L00026” sets up the “TelID” in the CWH page as seen 
in the screen shot, “ptc@26”.  Care must be taken to check and fill in this field when copying  these tools. 
The CWH calibration is hand entered similarly to the INCL mentioned above, via Acquisition->Edit-
>Calibrations and selecting the “CWH” from the list. Currently Warrior software is supporting this with 10 
calibration multi-points (provided by Spartek), this may change in the future converting to a curve-fit type 
calibration that can handle more points. Clicking on the “PRESTEMP” line on the “Software in tool string” 
box will bring us to the pressure/temperature setup. There are three sensors here, PTCP, PTCT and 
PTCTEMP. All of them need correct configuration when setting up a new tool. Double clicking on a sensor 
will take you to the sensor setup screen and importantly the “Gauge Serial No.” of each sensor needs to be 
filled correctly. These fields relate directly to the external calibration files (provided by Spartek) for the tool. 
Each prestemp sensor has a calibration file. The file name is the composite of the serial number and the 
sensor channel, for example for tool “L00026” the pressure calibration name is “L00026-01303”, software 
automatically assigns the file extension (.cff or .cft) by gauge type (pressure or temperature). These fields 
must be correctly configured for each sensor and each tool. 



 
FIG: 25.11 Tools Editor 

 
FIG: 25.12 Tools Editor 



 
FIG: 25.13 Edit Pressure sensor 

 

 
FIG: 25.14 Edit Temperature sensor 

 
FIG: 25.15 Edit External Temperature Sensor 

 



25.1.9 SPTK-SPIN 
This is for the 1” spinner that is optionally run on the PTC. Setup is very similar to the SPTK-CFB except that 
the “TelID” has a different identifier, for the example tool “L00026” the “TelID” is “spin@26”. 

 
FIG: 25.16 Tools editor Spin 

25.1.10 SPTK-TEMPPRES 
This tool is the combined 1-3/8” Temperature/Pressure. Setup is like the PTC Prestemp software section. 
Each sensor must have the correct “Gauge Serial No.” entry to identify the calibration file. The “Telemetry 
ID” is entered only in the “TPP” sensor setup as shown in the screen shots below. The example tool is serial 
“L00022” and the “Telemetry ID” is “tp@22”. Each sensor must have the calibration file info entered as 
before in the PTC example and as demonstrated below. These fields must be correctly configured for each 
sensor and each tool. The external calibration files will be provided by Spartek and copied to the 
Warrior\Config directory as before. 



 
FIG: 25.17 Tools editor PresTemp 

 
FIG: 25.18 Edit Pressure sensor 

  
FIG: 25.19 Edit Temperature sensor 



 
FIG: 25.20 Edit Compensation Temperature sensor 

25.1.11 SPTK-TPCD 
This is set up for the 1-3/8” TPCD tool with dual pressure, external temperature and capacitance. It comprises 
three software modules, CWH, PRESTEMP and GRADIO. GRADIO is purely a calculation module that uses 
pressure or delta pressure outputs together with the INCL output of the SPTK-MAST to calculate fluid density.  
Setup is the same as for the SPTK-PTC and this can be used as a reference with the exception shown in 
the  “TelID” type being “tpcd”, so for example tool “L00051” the “TelID” is set up as “tpcd@51” as seen in 
the CWH screen shot below. There are 5 Prestemp sensors to be configured correctly as seen in the example 
and this will need 5 corresponding external calibration files from Spartek copied to the \Warrior\Config 
directory. The sensors are PRESU, PRESL, TEMP, TEMPU and TEMPL. 

 
FIG: 25.21 Tools Editor TPCD 



 
FIG: 25.22 Edit Pressure sensor 

 
FIG: 25.23 Edit Pressure sensor 

 
FIG: 25.248 Edit Temperature sensor 



 
FIG: 25.25 Edit Temperature sensor 

 

 
FIG: 25.26 Edit Temperature sensor 

 

 

 

 

 

 

 

 

 



25.2 Acquisition 

When selecting the Spartek service you will first need to configure the Tool String in the Tool String Editor: 
 

 
FIG: 25.27 Tool String 

Once this is set up how you want to run the tools press Save. 
The normal acquisition windows will now appear and will include the Spartek Telemetry monitor, and the TEL 
Threshold screen. This is how they will appear before tool power is applied: 
 
 



 
FIG: 25.28 Telemetry Monitor 

 
FIG: 25.29 Telemetry  

Currently the system is set up to work with manual thresholds, but possibly future automatic thresholds will 
be made available. Initial threshold settings (that can be saved so as not to set them every time the service 
is loaded) as above work fine. 
Other settings that influence the telemetry detection are the line conditioning and gain settings. In Edit-
>Devices->SDSTIP the following general settings work well where only changes in the gain using the AUX 
slider will be needed to “sync” the tool. 

 
FIG: 25.30 SDSTIP 



On powering the tool, if an uplink is detected the system goes through a sequence of enquiring the tools 
themselves as to what type and serial numbers they are and configuring the telemetry to be setup in the 
specified configuration that the user selected. 
Any differences between the user set up and the tool responses to the enquiries will be shown in the monitor. 
One other possibility is that the tools are unable to respond to the system downlink (on extremely long cables), 
in this case the system makes no attempt to downlink a new configuration and will simply try to acquire data 
from the tools in the manner they are sending it. Since these tools memorize their prior configuration it is 
possible to use the system to configure the tools while on surface using a dummy-load cable and then running 
them in the whole where they will work without being configured again on power-up. 
The following screen shots indicate a normal start up and ones with non-matching user selection and actual 
tools and a shot of the TEL Threshold monitor: 

 
FIG: 25.31 Tel Threshold 

 
FIG: 25.32 Telemetry Monitor 



 
FIG: 25.33 Telemetry Monitor 

It is advisable that once the status screen has been updated with the tool information that the user switch to 
the Channels display. This will show the Frame Count and as importantly the Errors. Normal operation will 
show an update of 10 frames per second, some initial errors are normal while the configuration is taking 
place, but this should not update once the tools are running. The sensor channels are unprocessed raw 
counts. 

 
FIG: 25.34 Telemetry Monitor 

The final view option is Setup. This tells us exactly what the downhole EEPROM was programmed with to 
configure the master controller. Each press of Setup will take us on to a new setup screen. 
 
  



  



 
 

 

 

26 MULTI-FINGER CALIPER AND PIPE 

TALLY 

The Warrior Logging Software supports imaging tools that include a wide range of multi-arm or multi-finger 
caliper tools supplied by different manufacturers such as Sondex , Hotwell, Probe, Katwell, GoWell, and 
Spartek Systems. The various caliper tools may have from 12 to 60 fingers. The Warrior software presents 
the readings from the fingers as radii or diameters. In addition, many presentations will also present a 3-
dimensional image of the caliper log. 
 
One of the problems with multi-finger caliper tools is when the tool is not centered in the wellbore, the readings 
of the diameters measured may not be correct. With the tool not centered, the diameters perpendicular to 
the high / low axis will read smaller than actual size, showing an eccentric pipe. Warrior Software has a 
Caliper Processing package available as a supplement to the Warrior 8 Software that corrects the eccentric 
caliper readings in real time. The Caliper Processing software would replace the third-party software that is 
normally used after the well is logged as post processing in the office or processing center. Sondex calipers 
cannot use the Warrior eccentricity correction. 
  
The example shown in Fig. 26.1 shows a log pass with uncorrected caliper image on the left and a corrected 
caliper image on the right. Fig. 26.2 shows a cross-section image of the caliper readings. Fig. 26.3 shows a 
3-dimensional image of the uncorrected and corrected caliper readings. 
 
 
If you have Caliper processing software you will have an option in variables to select none, eccentricity 
correction or eccentricity correction and elliptical correction. 
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Fig. 26.1 Multi-finger Caliper Correction Selection 

 
For more information about the Caliper Processing Software contact Scientific Data Systems. 
 
 
 
 

 
Fig. 26.2 Multi-finger Caliper Image Plot 

 



 
Fig. 26.3 Image map showing uncorrected and corrected caliper readings 



 
Fig. 26.4 3-D Image map showing uncorrected and corrected caliper readings 

 

26.1 Pipe Tally Utility 

 
The Warrior 8 software has an enhanced version of the Warrior Pipe Tally Utility. The utility provides a 
numerical table by joints of casing / tubing showing casing loss. In addition, it provides capabilities for 
enhancing the log presentations. 
The Pipe Tally Utility is accessed through the Warrior Database Utilities by clicking on the Pipe Tally selection 
button.  



 
Fig. 26.5 Warrior Database Utilities – Pipe Tally 

 

26.1.1 Get Pipe Tally Data – Scan for Collars 
When the Pipe Tally Utility is opened, there is no information present. The first step is to get the casing joints. 
If you click on the [Process] button, you will get the choice of getting the joints from a log pass or entering 
them from the keyboard. By clicking on [Get Joints from a Log Pass], multiple collars can be selected at one 
time with the mouse and the software will enter them into the table. If [Get Joints from Keyboard] is selected, 
the user must type in each collar position that he wants to use 
Fig. 26.5 Pipe Tally Utility – Process  

 



 
  
When getting joints from a log pass, any curve that indicates collars may be used, not just CCL. In the 
following example, since there is no CCL in the string, I will use the IDMXC curve. The maximum collar length 
would be set to the minimum length of a casing joint or longer than any hardware that might be in the well, 
normally 2 to 4 feet. When the [Start Plot] button is clicked, Interactive Plot will start. You will need to select 
the pass that you wish to process and to do a screen plot to see the pass. It is often advantageous to 
compress the scale of the plot to enable the user to select more collars at one time. To do this, click the 
Options choice from the Interactive Plot menu. 

 
Fig. 26.6 Setting Vertical Scale to compress the viewed log pass 



Click the Vertical Scale drop down and select a larger number to compress the scale. 600 or 1200 are good 
options. Using the mouse, draw a rectangle that catches the peaks of the curve that you are using as a CCL 
indicator. 
 
Fig. 26.7 Capturing CCL indications in a log pass 

The Scan Log for Collars window will show a summary of what you have just scanned. In this case, it shows 
4 collars in the range of 8504.0 feet to 8618.2 feet and gives the minimum, maximum, and average lengths 
of the joints in that interval. If you click the [Reject] button, the summary is cleared, and you may reselect the 
collars from the log pass. If you click the [Accept] button, the collars that have been selected will be entered 
automatically into the pipe tally table. You should continue down the log pass, selecting collars until the whole 
pass has been collars picked. When you are finished, click the [Done] button to close the Scan Log for Collars 
window. 
At this point, it is a good idea to take a close look at the Pipe Tally table and look for problems with the collars 
that have been selected. Things that should be looked for are extra-long and extra-short joints. 



 
Fig. 26.8 Examine table for bad CCL selections 

In the table shown in Fig. 2.5, there are long joints at joints 14, 7, and 2 and a .1-foot joint at joint 4. The long 
joints are probably caused by not having enough of an indication in the signal to pick the collar and the short 
joint is caused by selecting the same collar twice. The collars that have been selected twice can be eliminated 
by clicking on that collar in the table and then click on Edit -> Delete Selected Entries.  



Fig. 26.9 Deleting erroneous entries from table 

To correct the long joints, you would need to Process and Get Joints from a Log Pass again or in this case I 
will Get Joints from Keyboard. 
 
Fig. 26.10 Get Joints from Keyboard 

After closely examining the log, I missed collars at 8695.3, 8966.1, and 9209.4. These depths will be entered 
the window separated by spaces or commas as shown in Fig. 2.8. 



 
Fig. 26.11 Process – Get Joints from Keyboard 

The corrected table is now shown in Fig. 26.12 

 
Fig 26.12 Corrected Pipe Tally Table 

 



26.1.2 Edit Pipe Tally Settings 
There are several things that should be done before continuing. The first is editing the table header 
information. 
Fig. 26.13 Edit Heading Information 

If the Warrior Heading has already been completed and saved, that information can be brought into the Pipe 
Tally Header by clicking the [Get from Heading] button at the bottom of the Job Information window. If that 
heading information is not available, then the User should enter the data in the fields provided. The heading 
information is saved into the table by clicking the [OK] button. 

 
Fig. 26.14 Completed Job Heading Information 



If grading to going to be applied to the log data, the grading options need to be set up before the casing 
thickness is scanned. Click on Settings -> Grading and options to bring up the options window. 
Fig. 26.15 Options and Grading 

The grading is based on a percentage of loss. The User would normally setup between 2 and 6 grade levels. 
This may be as simple as 0% - 50% Passing (Green) and 50% - 100% Failing (Red). It could be something 
more complex, such as a letter grading A=0% -20% (Green), B=20%-40% (Blue), C=40%-55% (Yellow), 
D=55%-70% (Orange), and F=70%-100%  (Red) 
Fig. 26.16 Example Grading Scales 



The colors assigned to the grading are used as a quick indication of the grading and can be shown both in 
some of the pipe tally tables and as a pattern strip in the log. The color for a given grade may be edited by 
clicking on the box located between the grade symbol and the grade color, defining the color and then clicking 
the [ OK ] button. 
Fig. 26.16 Selecting Grading Colors 

 

26.1.3 Remaining Wall Loss and Grading 
Now that grading options have been set up, the next step is to have the software scan the log, computing the 
wall loss percentage and grading the casing joints. Click on [Process] to open the Process window. Click on 
the [ Compute Remaining Wall, Losses and Grading ] option. 

Fig. 26.17 Remaining Wall and Losses 



There are two ways to process the remaining wall and losses. If the Warrior Caliper Processing software has 
been used, remaining wall has already been computed and that curve (MINRC – Minimum Remaining 
Corrected) can be used. The second method is to use the maximum diameter (which, depending upon the 
caliper eccentric could be appreciably off) and the casing OD and ID set up in Variables. 
From the Compute Loss and Grading window, the User will first need to select which method that he wishes 
to use. And then, using the [<<Browse] button select the data item that he wished to use to process the log 
for losses.  

 
Fig. 26.18 Compute loss and Grading 

 
Fig. 26.19 Selecting Data to Process for Losses 



The Pipe Tally table will now be completed, showing the number of joints, the collar depth of each collar, the 
length of each joint, the minimum remaining wall in each joint, and the grade that has been given to each 
joint. 

 
Fig. 26.20 Completed Pipe Tally Table 

 
  



26.2 Multi-Finger Caliper Presentations 

 
If the Warrior Caliper Processing software is being used, there are several additional curves or outputs that 
are created in addition to the standard logging outputs. These include but are not restricted to IMGMAPC 
(corrected image map), IDMXC (corrected maximum diameter), IDMNC (corrected minimum diameter), 
IDAVC (corrected average diameter), MINRC (minimum remaining wall), and CTR_DIST (distance from 
center of tool to center of hole). These outputs can be added to presentations in the normal manner. 

 

26.2.1 Pipe Tally Annotations and Grading 
 
During the processing of the Pipe Tally table, there are two processes that will add data to the database. 
These are “Put Grade Strip into a Log Pass” and “Put Annotations into a Log Pass”. While the information is 
added to the database, it is not plotted until it is added to a presentation format. 
 

 
Fig. 26.21 Additional Pipe Tally Processes 

 
From Interactive Plot, with a log pass pulled up, edit the log format. Click on the [Add] button to add a new 
database item to the presentation. 
 

 
Fig. 26.22 Add a New Item to Presentation 

 
To add the Pipe Tally Annotations to the presentation, the DB Item needs to be PTANN. This can be typed 
in or chosen from the [Current Pass] drop down list. The annotations can be placed in any track that is 
available, and the scales have no relevance in this case. The Presentation Type must be tabular, and the 
Style needs to be Tabular by delta. 



 
 
Fig. 26.23 Adding Pipe Tally Annotations 

 
To add the grading strip, the DB item needs to be Grade. The presentation type needs to be a Pattern Strip. 
The color map needs to be Pipe Grade. This is a special color map that can only be edited from the pipe tally 
grading and options settings. It cannot be edited through the normal color map editing. The scales should be 
set from 1 to the number of grades that were set up in the Pipe Tally Options. 

 
 
Fig. 26.24 Adding Pipe Grade Strip 

 

 



Fig. 26.25 shows an example with annotations and grading strip in a presentation. 
 

 
 
 

26.2.2 Pipe Tally Tables in Plot Job 
▪  

▪ When adding a pipe tally table to a plot job, there are several formats that the table may be printed 
under. These are *.WRF in the Warrior\Format folder. When adding the table to a Plot Job, the format that 
is to be used for printing the pipe tally table can be selected. Examples are shown below. 

▪  

Fig. 26.26 Selecting Pipe Tally Report format 

▪  



▪      JNTTBL01.wrf                                        

▪  CCL.wrf      

▪  

▪  



▪ JNTBARPCT.wrf 

▪  

▪  

▪   JNTGRADE.wcg 

▪  



▪  

▪  

▪ MAC.wrf     

▪ MAC2.wrf 

Fig. 26.27 grading examples 

26.2.3 Borehole Presentations 



The Borehole Presentation Window, available in some presentations, has been enhanced with the ability to 

show two image map presentations. To show the second image map, click on the “Window” menu option 

and then select “Clone”. 

Fig. 26.28 Setting Borehole Image Presentation for two Images 

Once the two images are cloned, they will be the same image. By clicking one of the images and then 

clicking on the “Options” icon, as shown in fig. 3.1, the second image can be set to be a corrected caliper 

array image IMGMAPC. Either image can be set to either a 2-dimensional or 3-dimensional presentation. 

. 

Fig. 26.29 Setting Corrected Image for Second Borehole Presentation 

 



 
clicking on the “Options” icon, as shown in fig. 3.1, the second image can be set to be a corrected caliper 
array image IMGMAPC. Either image can be set to either a 2-dimensional or 3-dimensional presentation. 
 

. 
Fig. 26.30 Setting Corrected Image for Second Borehole Presentation 



 
Fig. 26.31 Showing Caliper Array Image and Corrected Image 

26.2.4 Multi-Finger Presentations 
In previous versions of Warrior software, an array of curves, such as arm radii, each had to be plotted 
individually. This meant that if a scale change was required each individual arm had to be rescaled. Warrior 
8 allows the User to plot a list of curves as a single DB item. The presentation shown if fig.3.4.1 shows a 40-
arm caliper presentation with arm R01 plotted from 2.4375 to 4.9375. Each additional arm is plotted with the 
scales set to .0625 less so that arm R40 is plotted from 0 to 2.5.  
In this example, I will remove every caliper arm curve as shown in Fig. 3.4.2. Next, I will click the [ ADD ] 
button and select the List type of Data Source for the DB item. Click the [ Curve List Properties ] button to 
bring up the Curve List Editor Window as shown in Fig. 3.4.4. 



 
Fig. 26.32 Typical 40 arm caliper presentation 

 
Fig. 26.33 Presentation with all caliper arm curves removed 



 
Fig. 26.34 Selected List type Data Source DB Item  

 
Fig. 26.35 Curve List Editor Window 

On the left side of the Curve List Editor Window is a drop-down list of all the available outputs. Select the first 
curve in the list of curves that you would like to plot. There is a brief example that describes how to pick the 
curve shown in the “How to create curve list” box. When the curve is selected, the “list identifier” will be filled 
out. The “For all curves” box of the Curve List Editor Window is used the same as the style box of a normal 
curve. 



 
Fig. 26.36 Select List of Curves 

The “For each curve” box provides some additional settings. When plotting multiple curves, it is normal to 
offset each curve by a small amount so that the curves are not stacked on top of each other and are 
distinguishable. Another method of distinguishing multiple curves is to make one of the curves a different 
color every so often. This box provides the User those capabilities with the multiple curve lists. When the 
settings have been selected, click [ OK ] to close the Curve List Editor window. Note that the scales for the 
first curve and every nth curve will automatically be shown. 
The final settings for defining the list of curves are giving the list a name. This can be anything to identify the 
list, such as Calipers, R0 thru R40, or whatever the User decides is appropriate. The track and the scales 
also need to be set.  The scales will be the scale for all the curves, but only the first curve and every nth curve 
will the scales be shown on the log insert. When complete, click [ OK ] to save the curve definition. Then click 
[ Save ] to save the edited plot. 

 
Fig. 26.37 Setting Track and Scales and giving list of curves a name 



 
Fig. 26.38 Final presentation for a list of caliper curves 

 
 
 
 
 

26.3 Multiarm64(32).exe 

This program will read in LAS data from a Multi-Arm service and create a single pass in a Warrior database.  
This pass will not only contain the curves found in the LAS data, but will also create a 180-point VDL curve 
by interpolating between each of the Multi-Arm caliper readings.  This program also contains a viewer that 
can display a 3-dimensional view of a section of the Multi-Arm data. The program is located at "C:\Program 
Files\Scientific Data Systems\Bin" 

26.3.1 Importing Multi-Arm Data 
 
The first step is to import the Multi-Arm data in to a Warrior database.  Use the build button “Import from LAS” 
to select the LAS file to import. 
 



 
FIG:26.39 LAS Multiarm Caliper 

 
 
 
 
 

26.3.2 Caliper Presentation 
 
The presentation file will be embedded in the database as the presentation to be used when the data is 
plotted.  This can be edited later. 
Select the Las File  
Select the Presentation file (Probed60.prs) 
Select the output database Select an existing database or type in a new database name.  Fill in the 
field/well/run portion of the dataset.  The name of the pass will always be the same as the LAS file name. 
Set the offset between calipers to show all the calipers in one track  
Type the “Base Caliper Name” (MULTIARM) 
Type the VDL output name (imagmap) 
If you just have LAS, then select import from LAS. If you have the database select create VDL 

 

26.3.3 Output curves 
The program will search through the Multi-Arm LAS data for caliper curves that start with this name – i.e. 
ARM1, ARM2, etc.  It uses these names to create the 180-point interpolation for the 3-D view.  The offset 
between each caliper is automatically applied to the presentation file to display the individual arm data.  An 
offset of 0 would put all the arm curves on top of each other which may make it difficult to see responses of 
individual curves.  The VDL output name is the name of the curve that will contain the interpolation of the 
caliper data.  This curve will contain 180 data points for each depth sample. 



 
FIG: 26.40 Set up Multi-Arm Caliper 

Start the process to convert the LAS to BD It takes long time for example to produce 1Gb . 

 
FIG: 26.41 Warrior Data Import 



 
FIG: 26.42 Selecting Caliper Name 
Once the system reads through the LAS file it will prompt you to select a caliper name, browse the list until 
you find the applicable mnemonic. 

.  
FIG 26.43 Creating VDL 

Once it has completed the process the system will open the resulting file with interactive plot using the 
presentation selected earlier. 
 
 

26.3.4 Edit Presentation 
 
See section 6 
 
 
  



APPENDIX Caliper Calibration Reports 

 

 

 Calibration Reports for IMG tool software (multi-finger 
calipers)  
Background  
First a little background about Warrior calibration reports.  
Calibration report formats are essentially templates that describe a mixture of hard coded text and 
place-holders for calibration “terms” that the logging system produces.  
The formats have the extension “wcp” and are edited using a text editor.  
Within the file there are three sections:  
[columns], starting at 1, this is a list that lets us demark column positions for placement of text in 
the report (the report itself is described row based).  
For example:  
1=10  
2=45  
3=20  
4=27  
5=34  
Etc.  
[layout], also starting at 1 for row 1, typically uses column references, alignment characters and text 
or “terms” to place information on the report dynamically when being generated.  
@n places whatever follows at column n, ~ implies centering, - as the first character of a line implies 
a thin dividing line, = as the first character of a line implies a thick dividing line, . as the first 
character of a line implies a blank line. Terms are bookended between % symbols.  
For example:  
1= ~ Multi Finger Caliper Tool Calibration Report  
2=-  
3=@1 Serial Number: @2 %serial%  
4=@1 Tool Model: @2 %model%  
5=@ 1 Performed: @2 %date%  
6=.  
[WarriorFileInfo] is the final section, this is used during restoring of configuration backups or tool 
calibration exports or service exports. When a restore is made on a new system from the exported 
file if the target computer already has a file with the same name this section is looked at and 
compared to  



resolve the conflict, when the date of the new file being restored is newer than the current then the 
new file will write over the current. The only content of this section is a line like the example below 
representing August 3rd, 2017, version 1 of the day (001):  
WarriorFileVersion=2017.08.03001  
Some tool modules have hard coded calibration report format file names but, in many cases,  there 
is an option to specify the name (or base name when multiple pages are required) in the Tool 
Editor. Terms are generally tool module specific but there are a few general “terms” that will appear 
such as tool name, mnemonic, date of the calibration, model and serial number. This document will 
focus mostly on the “terms” produced by the IMG tool module but first here is how the format files 
should be named,  

IMG calibration format file naming  
Because by nature we are interested in information not just about the tool itself but also the 
individual caliper arms the calibration report can easily span more than the typical one page of say a 
simple logging tool like a Gamma Ray. Also, the IMG module must cater with various dynamic 
options where the number of individual arms can vary from one tool to another, the number of 
calibration references can vary, calibration options can vary, the engineering units can vary as well 
as some proprietary or tool type terms may or may not be produced also.  
In the initial stages of this tool module development we required two or three pages for the reports 
depending on the number of arms. Any tool up to and including 40 arms would have two pages, the 
first for “master” or “shop” ring calibration, the second for the verifications. These would be files 
“basename_1.wcp” and “basename_2.wcp”. Tools with more than 40 arms would have three pages, 
“basename_1.wcp” and “basename_2.wcp” for the “master” calibration, splitting the report of the 
arms in to half on the first page, half on the second. Then “basename_3.wcp” would be for the 
verifications.  
The latest version of software has added two more pages, “basepage_n+1.wcp” and 
“basepage_n+2.wcp” for charts where “n” was the number of the page used for the verification 
report earlier. Page “n+1” has charts produced from the “master” calibration stage, “n+2” from the 
verification stages. So that these reports follow in a logical sequence, “master” tabular data 
followed by “master” charts and “verification” tabular data followed by “verification” charts, the 
actual “print” sequence is perhaps best shown in an example. The first column is for a 24-arm tool 
(would be like this for 36 and 40 arm tools), the second column for a 56-arm tool (would also be like 
this for a 60-arm tool). I am demonstrating this with a base cal report name of “BRANDX_MFC” 
which is named in the tool configuration, the number of arms and page are added dynamically:  
BRANDX_MFC24_1.wcp (master cal) BRANDX_MFC56_1.wcp (master cal page 1)  
BRANDX_MFC24_3.wcp (master cal charts) BRANDX_MFC56_2.wcp (master cal page 2)  
BRANDX_MFC24_2.wcp (verifications) BRANDX_MFC56_4.wcp (master cal charts)  
BRANDX_MFC24_4.wcp (verifications charts) BRANDX_MFC56_3.wcp (verifications)  
BRANDX_MFC56_5.wcp (verifications charts)  



IMG calibration report “terms”  
There is a handy power-user “trick” to see what terms are being produced for which calibration 
report. After making all the calibrations, master, verifications etc., record a short database pass. In 
the Bin folder where Warrior is installed there is a program called EFEditxx.exe (xx is 32 or 64 
depending on the installation). If you launch this software you can select File->Open, choose your 
database then from the list of sections on display select the pass you just recorded /_calrep_/1, for 
example /field/well/run1/pass1/_calrep_1/1, this will now display information that is used to 
generate the calibration report. Sections start at [1] and increment. The information is term=val, for 
example:  
mnem=MFC  
serial=12345  
format=BRANDX_MFC56_1.wcp  
model=56 Arm  
date=Thu Aug 03 12:19:37 2017  
Etc.  
Below is a description of the latest terms, this may change in the future as the software is updated.  
utArmRaw – this will be blank or have the raw caliper units, for example “mV”  
utAmCal – this will be the user selected caliper units, for example “mm” or “in”  
DiaNRef – for each master calibration ring reference (N) there will be a term for the size in the units used, for 
example:  
Dia1Ref=4.00  
Dia2Ref=5.00  
RefNEccPct - for each master calibration ring reference there will be a term for the apparent eccentricity (%)  
ArmNOff – for each arm (N) this is the offset applied to the calibration (typically 0 but the user can edit)  
ArmNRdgY – for each arm (N) and each master calibration reference (Y) there will be a raw reading (some 
tools this has temperature correction applied and is in engineering units like “mm”, others types may be 
telemetry values, for example:  
Arm56Rdg1=1.98  
Or  
Arm56Rdg1=2311  
ArmNDRdgY –as above but doubled, useful for tools with temperature correction applied before the master 
calibration to give a “diameter” comparison:  
Arm56DRdg1=3.96  
ArmNRawY – for each arm (N) and each master calibration reference (Y) when the tool has raw readings in 
caliper engineering units we also store and make available the telemetry readings  



ArmNCorrY – for each arm (N) and each master calibration reference (Y) if eccentralization calibration is being 
utilized this is the amount of correction needed  
DRefTol - the reference tolerance used for diameter (double radii) comparison in the master calibration  
RefTol – as above but tolerance for radii comparison  
ArmNRefTolBadY - for each arm (N) and each master calibration reference (Y) this is the symbol ! when the 
reading is outside the reference tolerance specified  
ArmNRefTolDDiffY - for each arm (N) and each master calibration reference (Y) this is the difference of double 
radii to reference  
ArmNRefTolDiffY - for each arm (N) and each master calibration reference (Y) this is the difference of radii to 
half reference  
ArmNBad – for each arm (N) this is the symbol * when an issue is found with the arm during calibration (for 
example all readings 0  
ArmNCorCoef – for each arm (N) this is the homoscedastic (linearity) coefficient during the master calibration  
ArmNBFGain – for each arm (N) this is the best fit gain during the master calibration  
ArmNBFOffset – for each arm (N) this is the best fit offset during the master calibration  
LinTol – tolerance used to identify arms out of linear tolerance  
ArmNLinTolBad – for each arm (N) this is the symbol ~ when an arm is out of linear tolerance  
ManuSerial – when a manufacturer calibration file is used this is the serial number from the file (can differ 
from Warrior serial number)  
ManuCalBy – when available this is the user described as performing the manufacturer calibration from the 
supplied file  
ExtCalFileDate – when available this is the date from the manufacturer supplied calibration file  
ResPlotD – this is the Residual Plot chart (when applicable) from the master calibration  
NormFitPlot – this is the Normalized Plot chart from the master calibration  
ECC – Either blank or “Eccent. Corr. On”, this indicates if the master calibration used eccentricity correction  
The following terms are from the Verifications, there are Pre, Post and Adhoc terms, below when describing a 
term starting with the prefix “Pre” there will be similar terms with prefixes of “Post” and “Adhoc”  
PreArmVerTime – time verification was performed  
PreArmVerRef – diameter reference of verification  
PreArmVerMin – minimum diameter observed during verification  
PreArmVerMax – maximum diameter observed during verification  
PreArmVerAvg – average diameter observed during verification  
DVerTol – double radii verification tolerance (reading vs reference)  
VerTol – as above but radii  



PreArmVerDiaN - for each opposing pair of arms (N) this is diameter read during verification  
DiaNTolBad - for each arm (N) this is the symbol * when the above diameter is out of reference tolerance  
PreArmVerRadN - for each arm (N) this is the radii reading of the verification  
PreArmVerDRadN - for each arm (N) this is the double radii reading of the verification  
PreRadNTolBad - for each arm (N) this is the symbol * used when the radii is out of reference tolerance  
PreArmEccPct – this is the term for the verification apparent eccentricity (%)  
WearTol – Wear verification tolerance (pre radii vs post radii)  
WearRadN - for each arm (N) this wear (pre verification – post verification)  
WearRadNTolBad - for each arm (N) this is the symbol ! used when the wear observed is out of tolerance  
WearPlot – this is the Wear chart (Pre vs Post) radii comparison  
PrePlotD – this is the Pre Verification chart (vs Reference) double radii comparison  
PostPlotD – this is the Post Verification chart (vs Reference) double radii comparison  
AdhocPlotD – this is the Casing Check Verification chart (vs Reference) double radii comparison  

Please note that using EFEdit can potentially (if you change and save back anything) corrupt a 
database, this is a power user tool and not recommended for general purpose use. Please contact 
Scientific Data Systems if help is needed in generating calibration report formats.  



References  
Example Master Calibration Charts (Residual and Normalized): 

 



Example Verification Charts: 

  



27 Radioactive Tracer Survey 

27.1 Setup Procedure 

Bring up Radioactive Tracer service.  
Click Acquisition Box - Edit - Tool String  
Edit the tool string as necessary to reflect the tool string being run. This is important to insure proper offsets, 
filters, and tool diameters. 
Click Acquisition Box - Edit - Variables  

 
FIG: 27.1 Tool String 

Edit the variables to reflect the correct casing ID and tubing ID sizes for proper flow rate calculation (Tubing 
OD is also important if running in annulus). Add multiple zones if needed. (Note: a size of 0 indicates no 
casing, tubing, etc.). 

 
FIG: 24.2 Edit Variables 
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Click Acquisition Edit Tool Configuration TREJCT to bring up tracer configuration dialog box.  

 

FIG: 27.3 Tool Configuration 

 

FIG: 27.4 Tracer Configuration 

Pick the method of tracer log you wish to run Dual Detector, Single Detector, or Drop Run. 
For Single Detector Velocity logs, the detection level can be determined from a base log pass if one has been 
run, (use browse to select it, it must be in your current database). Or enter a threshold value for the level of 
when a shot should be detected. More on this later. 
If the log is being run in the annulus between the tubing and casing, check this box for proper flow rate 
determinations. 
Other than base runs, make sure the Log Passes into Shot Table Box is checked. 
While normally all shot passes are logged into a single table, more than one table can be used and would 
need to be selected. 
 



27.1.1 Tracer Ejection Control 
Click Ejection Control box to set up ejector control. The ejection duration that you choose is dependent 
upon your tool type and strength of the tracer material being used. (This should be tested with water prior to 
the job to determine the approximate number of shots that will be available during the job.) 

 
FIG: 27.5 Tracer Ejection Control 

The Additional Squelch time is set to allow settling of the gamma detectors after the ejection to avoid noise 
being detected on the log. 

27.2 Logging Procedures 

The depths where a tool is positioned in the well can be critical to the final log interpretation. Normally the 
Warrior system uses the bottom of the tool string as its zero point; this may put the detectors several feet 
above the depth shown. (It is possible to change the zero point to a sensor if desired.)  
If drag runs or velocity shots with a single detector are going to be done, it is recommended that a base run 
be logged first to record a background gamma. Use this to determine the threshold detection level or as a 
base curve that the threshold level is added to before detection occurs. Be aware detection occurs when the 
detector value crosses this threshold or base curve value plus threshold level, statistical deviations may 
cause premature detection. (Pick a high threshold level high enough to not cause premature detection.) 
 

27.2.1 Velocity Shots 
Position the tool in the well at the depth that you wish to make a shot. Shot passes are Recorded on Time. 
The true depth of the encoder is used as the shot depth. When starting a log pass. Allow enough time for the 
detectors to obtain a “background reading”. Then click the Start Ejection control. Continue recording until 
the detectors have drop back to the previous background reading. Stop the log pass. 
Log as many passes in this manner as desired. 
The Shot Table will now reflect the information just recorded. If a single detector method was used, the times 
and the flow rates will be complete. If a dual detector method was used the pass will have to be correlated to 
calculate the proper time, and thus the flow rates, as described below. 
 

27.2.2 Drag Runs 
Normal procedure is to eject a tracer slug, then to drop down and Record Up until the slug passes, then stop 
the pass. Then drop back down and start another pass. Each pass is recorded as a separate entry into the 
shot table. 
The normal calculations integrate the area between the detection level and the curve, so it is important to 
record the complete passing of the tracer material. 

 
FIG: 27.6 Generate 



 
FIG: 27.7 Generate Drag Run Profile 

By clicking on the Generate button of the Shot table, all drag runs with a plus sign will automatically be merged 
into a single presentation. Selected annotations can be added for each pass. By using auto merge, curves 
from other passes, such as collars, temperature, or gamma, can automatically be added to the presentation. 
By clicking on Velocity Shots from Drag Runs, records in the shot table will be generated with distances 
between runs. To get the times, each record will then have to be correlated. 
 

27.2.3 Shot Table Editing, Correlation, and Flow Rate Log Generation 

 
FIG: 27.8 Table flow rate 



 
FIG: 27.9 Table Flow rate 

Access to the shot table can be obtained through the Acquisition box and Editing Tool Configuration and 
choosing TREJCT and then clicking the Shot Table Button.   It can also be accessed from the Utilities menu 
through the Tracer Interpretation selection. 
The Shot Table shows the information taken each time a log pass was started. The first column contains a 
+, -, or ?. A + indicates a valid calculation. A – indicates that the record has been excluded from calculations. 
A ? indicates that correlation has not been done to determine time. The second column indicates the type of 
record. DR is drag run. DRV is velocity determined from drag runs. SDV is single detector velocity. DDV is 
dual detector velocity. 
Other columns indicate depth of pass, flow rate, percentage of flow rate, change of flow rate, percent change 
of flow rate. By clicking on the view button, casing and tool dimensions can be viewed. Also available are 
detection times, integration, and dataset information. 
Certain information for a given record can be edited by selecting the record and clicking the edit button or by 
double clicking on a record. Casing and tool dimensions can be changed. Weighting other than 1.0, adjusts 
the calculated output. . An unsatisfactory station can be removed from the flow rate calculations by removing 
the check mark beside Include in calcs. A record marked as reference will be maximum or 100% flow rate. 

 
FIG: 27.10 Options 



 

FIG: 27.11 edit shot 

If a Dual Detector method or velocity shots from drag runs was used, the data recorded will have to be 
correlated before times will be computed. Shots that have not been computed will be tagged with a question 
mark (?). Click on a shot pass to select it, then click on correlate to open the correlation process box.  



 

FIG: 27.12 Liner Correlation 

Normally the selected base curve, specimen curve, and output curve will be setup. There are options to 
select different curves to be used if desired. On the base data, click and drag on the portion of the data that 
you think is valid, if the whole pass looks good, this step may be skipped. On the specimen data, click and 
drag on the portion of the data that is valid. The length of this data MUST be less than the length of the base 
data.  
It is important that the whole response to the shot be selected since the calculations are done on the area 
under the curve and not on a given level. 
Click Begin to compute the time. Click Save to retain the present calculations. Click Exit to return to the Shot 
table. 
When all stations have been edited as desired, click on Generate. Choose Merged Composite File. Curves 
from a collar locator pass, a gamma ray pass, etc. may be added to the final presentation if desired. Finally, 
when OK is clicked the flow rate presentation will be plotted out. 

27.3 Service Specific - Tracer Survey 

The Tracer service incorporates several special features that may require further explanation. The Warrior 
software attempts to calculate results from each pass of data as it is recorded or immediately afterwards.  



27.3.1 Dual Detector Velocity 
In Dual Detector Velocity mode, the time displacement between the two curves is determined by a 
correlation technique. Any part or all the data may be used to match the curves together. It is essential that 
complete event of the slug passing the detectors be recorded for this technique to be effective. 
 

27.3.2 Single Detector Velocity 
In Single Detector Velocity mode, the time from the ejector shot to a threshold crossing by the GR (or detector) 
curve is measured. If two detectors are in the tool string, the time measurement is made from the ejector shot 
to the first GR curve to cross the threshold. 
 

27.3.3 Tracer 
In Tracer the area between the designated GR (or detector) curve and either a baseline GR or a fixed level, 
is the primary measurement. 
The results and other information are placed in a Shot Table. The contents of the shot table are used as a 
basis for the calculation of total and differential flow rates for display in tabular or log format. 
When a Tracer survey is selected,  Edit/Tool Configuration/Tracer brings up the Tracer Configuration 
window as shown below. 

 

FIG: 27.13 Tracer Configuration 

The user defines the type of survey to be run from a choice of Single or Dual Detector Velocity, or Tracer 
(Drop Run). This selection defines the type of on-line calculation that the software will attempt. If the survey 
is being run in the annulus the In Annulus box should be selected on order that the correct calculations be 
made. 
If it is required that the passes be inserted into the current shot table, the Log passes into Shot Table should 
be selected. This would be the normal case to record the results and is the default. 
More than one Shot Table may be defined for each survey. 
 

27.3.4 Drag Run 
Drag Run option is selected the user is asked to define which detector is to be used. 



 

FIG: 27.14 Tracer Configuration 

When two detectors are in the tool string and single detector velocity is selected the system will make 
calculations based on the first curve to cross the threshold. 
When making calculations from the tracer passes (i.e. the area under the DET curve) it is necessary to define 
either a fixed threshold value or a baseline DET pass. The area under the DET curve and above the 
Threshold or  
Base Curve is used to calculate the percentage of the original radioactive material passing the detector and 
the flow profile. 
This information is defined in the Threshold or Base Curve fields. 
To display the current Shot Table and/or Tracer Ejection Control window click on the appropriate button. 

 
FIG: 27.15 Tracer Ejection Control 

When running the service with the SDS interface panel the operator has the option to control the run time of 
the ejector motor from the Tracer Ejection Control window. 
The length of time for each motor run is entered in the Duration dialog box. Clicking on the Start Ejection 
button changes the polarity of the line power for the time set in the Duration box. 
 

27.3.5 Additional Squelch 
The Additional Squelch field allows the user to set an additional dead time period in the DET curves after 
the ejector motor has run in order to avoid line noise appearing on the log. The time needed depends on 
various factors and is best set by trial and error. 
The Tracer tool software module generates a curve called EJECT which shifts one unit to the right for the 
period of the ejection, thus indicating the occurrence and duration of the ejector motor run. 
The survey is currently run by logging with the internal encoder simulator, however the actual depth is 
recorded as a curve named ADEPTH. This curve may be presented on the log in curve or tabular form, in 
order to indicate movement of the tool during the survey. 
The elapsed time from the start of the survey is available via a curve named ELTIM.  
 
  



 



28 Freepoint Service  

 

 The warrior panel supports motorized and non-motorized free point tools  
 depending on a combination of panel type and installed boards. Before importing  a free point, 
service check the panel type in the warrior control panel. 
 

 
FIG:28.1 Free point Service must match Panel Type 

28.1 FREEPOINT Service CPFE and newer panels. 

  
The current warrior system uses a combination of TELA board and the DSP for the free point service. 
Currently there is a 500ma limit for setting the tool, if your free point tool requires more current to set it, you 
will require an external panel. Supported tools include Applied Electronics Bowspring and Magnetic tools and 
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Homco tools. Other models of Freepoint tools could also be setup in the Warrior system if the frequency of 
the transponder is known. 
When the Freepoint service is first started, the window show below will appear. This is the Freepoint service 
control panel. It shows a graphical representation of the Freepoint output and a text output. It has selection 
buttons that allow one to select whether the next station is to be run is to be torque or stretch. There are three 
large buttons that control the Freepoint tool setup, starting and stopping time log passes, and station manager 
access. 
 
 

28.1.1 FREEPOINT CONTROL PANEL 
 

 
FIG: 28.2 Freepoint Control panel 

28.1.2 FREEPOINT TOOL SETUP 
 

 
FIG: 28.3 Freepoint Setup 

When the Setup button on the Freepoint control panel is pressed, the window shown below will appear. This 
is the Freepoint setup control panel. Up to five different setups may be saved. Which setup is used may be 
selected by clicking on the dropdown box and choosing from Heavy Drill Pipe, Drill Pipe, Large Casing, Small 



Casing, or Tubing? Any changes made to the log sample rate or reading for 100% movement will be saved 
to the setup that has been selected. 
A normal sample rate for the log should be set to 5 to 10 samples per second. 
The 100% movement box is used to control the sensitivity of the response like the gain knob on an analog 
panel. Note that the lower the number the more sensitive the response will become. This does not have to 
be a whole number and may contain a decimal point (2.75 would be valid). 
The Set Tool button engages power supply in the interface panel and temporarily applies a DC voltage to 
the line to set the Freepoint tool. Note that the tool power switch on the interface panel must be on and the 
‘Neg, Auto, Pos” switch must be in Auto position. 
The Zero slide bar is used to set the zero position of the output before the log pass is started and torque or 
stretch is applied to the casing. 
There is an optional check box to clamp the Freepoint output to 0% to 100% so that it does not go off the 
page on the log. 

 

28.1.3 Running the Service 
 
Once the Freepoint service has been selected and the tool lowered into the well to a depth where the casing 
is known to be free, the tool should be set, and the output zeroed. Stretch or torque should be put on the 
casing and the 100% movement number adjusted to get near a 100% output reading.  
This should be repeated until you are satisfied that the equipment is responding correctly in free pipe. Once 
satisfied, the 100% Movement number should not be changed while recording stations. 
You are now ready to record the first station. Click the Start Log button on the Freepoint Control panel. The 
system will start recording on time. Have the rig apply torque or stretch and the output will be recorded. When 
you have seen the tool response, click the Stop Log button to stop the pass. The minimum and maximum 
Freepoint readings will be entered the Station Manager table at the encoder depth (note that since the 
encoder depth is used. You can only simulate a log by using the encoder and resetting the depth before each 
pass). 
Drop down the well to the depth that you wish to make the next pass and repeat the process. Make as many 
passes as desired to determine the Freepoint location in the well. Each pass will have the maximum output 
entered the station manager table.  
The depths at which you run the stations do not have to be in descending order. You would normally start at 
the top of the well and start doing stations going down. Once stuck pipe is found, you can come back up to 
a depth between there and your last free pipe station to refine the stuck depth. Whatever order the stations 
are run, they will be entered the Station Manager table in descending order. 

 

28.1.4 Station Manager 
 
 

 
FIG: 28.4 Freepoint Table 



 
As each station is run, the minimum and maximum values are placed into the station manager table. Notice 
that the stations can be done in any order but are placed into the table in descending order. 
Once a station has been entered the table. It can be viewed and edited. Any field except the station # can be 
edited. This can be useful to make your final presentation more acceptable. There is a check box to disable 
the station so that it will not be included in the final log presentation if the tool slipped or something else 
occurred to make the station invalid. 
When all the stations have been edited as desired, the final log presentation can be made by clicking the 
Generate button, and then click the Depth Log button.  
 

 
FIG: 28.5 Generate 

 
FIG: 28.6 Generate Depth 

There is a check box for Logarithmic Interpolation that will produce a slight smoothing effect to the output 
curves. Additional curves from the same database, such as a CCL or gamma ray, can be auto merged into 
the output. When the OK button is clicked, the interactive plot will be presented on a ½” /100’ scale. 
Using the Plot Job Editor, a presentation can now be made for the customer. This will normally include a 
heading, the Freepoint survey table, the generated depth log. The individual station passes could also be 
included and a tool string diagram if desired. 
 

28.2 FREEPOINT With CPFD and older panels. 

 

The main difference between the CPFD and CPFE panels with regards to the free point service is the CPFD 
has an auxiliary transformer and a Freepoint board. The auxiliary transformer can  supply up to 1000ma to 
set the tool.  The  operation is the same except that the tool power supply does not need to be turned on to 
set the tool since the auxiliary transformer produced the set current and is enabled by a software controlled 
relay. 
 



  
 

FIG:28.7 Free point Service must match Panel Type 

28.2.1 Running the Service 
 
The logging operation of the service is the same as earlier Freepoint services.  
See section  28.1.3 
 

 

28.3 Freepoint Service Homco-GO 
 

The Warrior system supports Freepoint tools that require minimum DC voltage for motorized deployment. 
This includes Applied Electronics Bowspring and Magnetic tools, and Homco tools. Other models of 
Freepoint tools could also be setup in the Warrior system if the frequency of the transponder is known. 
 

28.3.1 FREEPOINT CONTROL PANEL 
 



 
FIG: 28.8 Freepoint Control panel 

The Freepoint control panel appears the same as the control panel used for  other free point tools. The 
difference is when you select the setup button you have an added slider for the 100% reading. 

28.3.2 FREEPOINT TOOL SETUP 
 

 
FIG: 28.9  Freepoint Setup 

When the Setup button on the Freepoint control panel is pressed, the window shown below will appear. This 
is the Freepoint setup control panel. Up to six different setups may be saved. Which setup is used may be 
selected by clicking on the dropdown box and choosing from Heavy Drill Pipe, Drill Pipe, Large Casing, Small 
Casing, collars, and Tubing? Any changes made to the log sample rate or reading for 100% movement will 
be saved to the setup that has been selected. 
A normal sample rate for the log should be set to 5 to 10 samples per second. 
The Zero slider bar is used to set the frequency for when no torque or stretch is applied. The 100% slider bar 
is used to set the frequency for the maximum Torque or Stretch to be used. 
There is an optional check box to clamp the Freepoint output to 0% to 100% so that it does not go off the 
page on the log. 



 
FIG: 28.10 Freepoint PMON Threshold 

Remember that the signals in the PMON (pulse monitor) window need to be discriminated properly, like a 
gamma/ neutron service. 
 

28.3.4 Running the Service 
 

The logging operation of the service is the same as earlier Freepoint services.  
See section  28.1.3 
 
  



 



 

 

29 Bond Index and Borehole Volume 

29.1 BL Attenuation and Bond Index arithmetic 

Bond index is the ratio of measured attenuation to maximum attenuation. 

29.2 Calculation parameters 

 

29.2.1 fMxAmp 
Maximum expected amplitude; should be the same as the free pipe 
Reference value used in calibration. 
Obtained from zoned variable MAXAMPL. If the zero is entered, then a value is calculated from the casing 
O.D. 
 

29.2.2 fMnAmp 
Minimum expected amplitude; should be the same as the zero signal 
used in calibration except for one caveat: Zero is not a valid 
value, even though it is commonly used for calibration. Suggest 
using a value of one millivolt for both. 
Obtained from zoned variable MINAMPL.  
 

29.2.3 fMnAtt: 
Minimum attenuation. Attenuation value expected to be measured in free pipe. 
Obtained from zoned variable MINATTN. SPE papers suggest a value of 0.8 as an overall average for 
common casing sizes and weights. 
 

29.2.4 fLogValue: 
Calibrated log amplitude. (each sample). Transmitter/receiver spacing is assumed to be 3 feet. 
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29.3 Outputs: 

29.3.1 fAtt: 
Calculated output attenuation. 

29.3.2 fBI: 
Calculated output Bond Index. 
 
 

29.4 Processing for each log sample: (math protection not shown) 

ffRatio = fLogValue / fMxAmp; 
fAtt = 20.0 / 3.0 * log(fRatio) - fMnAtt; 
fRatio = fMnAmp / fMxAmp; 
fBI = fAtt / (20.0 / 3.0 * log(fRatio) - fMnAtt); 

29.5 BOREHOLE VOLUME 

Tool.  From the Serial Number drop From Warrior Utilities select ‘Edit Logging Tool Details’. From the Edit 
Tool drop down box select ‘STD’ down box select the serial number of the STD tool. 

 
FIG: 29.1 Tools editor 

Double click on the 'Calipers=' line. Enter a list of any output names, from all your different services that 
should be used as main ('X') caliper inputs into the borehole volume calculation. Separate multiple names by 
commas. 

 



FIG: 29.2 Edit item 

Repeat for the YCalipers line. Y calipers measure perpendicularly to X calipers and allow a better calculation 
with an elliptical hole. 

 
FIG: 29.3 Edit Y Caliper 

If any service has more than one X or more than one Y caliper, then those readings will be averaged unless 
the NoCaliperAverage flag is set to Yes. 
Double click on the ‘Volume Ticks =’ Line. 
Select ‘YES’ if you want volume ticks displayed instead of a tabular output. 
Each small tick equals 10 cubic feet or 1 cubic meter.  Each large tick equals 10 small ticks. 
Select ‘NO’ if you want a tabular output for volume. 
You can get either ticks or tabular volume, not both. 

 
FIG: 29.4 Edit Volume Ticks 

From Acquisition ‘Edit Variables’ the ‘BOREID’ size and ‘CASEOD’ size must be entered correctly for a valid 
calculation of borehole volume. 
A total borehole volume curve ‘TBHV’ must be added to the Log format as follows: 

 
FIG: 29.5 Define Data Item 

An annular bore hole volume curve ‘ABHV’ needs to be added to the log format as follows:  



 
FIG: 29.6 Set Scales Data Item 

 



 

 

30 CSS Radial Bond Services 

Computer Sonics produces two types of radial bond tool. One (the earlier model, though still produced) is 
known as the sequential tool. This tool has four modes of operation: 
3 ft.- 5 ft. mode for generating the conventional dual spaced CBL radial mode for generating the eight-receiver 
radial bond log (RBL) 
calibration mode for generating the internal calibration signal open hole mode 
The tool is switched from mode to mode and to acquire data for a complete log two passes must be made 
over the log interval, one in CBL mode and one in RBL. 
The later tool model generates all the required signals simultaneously and is known as the multiplexed tool. 
Both tools transmit nuclear, collar, and temperature log data in a digital form interleaved with analog sonic 
data. The telemetry scheme employed is not the same for the two tools, however in both cases it is detected 
and decoded in the Warrior system by DSP software through selection of the appropriate script command. 
The sequential tool transmits acoustic signals on the wireline at their natural frequency (approximately 20 – 
25 kHz). The multiplexed tool divides the downhole frequency by a factor of four before transmission to the 
surface, therefore the frequency of the tool signals on the line is approximately 6 kHz. Special provision must 
be made for this feature in the logging system in the form of a special filter / amplifier card that can be switched 
to accommodate conventional as well the CSS multiplexed tool. 
In both tools CSS has provided an internal calibration signal which can be used for a well site calibration 
which does not rely on finding (assuming) free pipe in the well. For both tools the philosophy is the same, 
namely the tool is calibrated in a known environment (zero signal and a calibration pipe) and the internal 
calibrate signal evaluated. The calibrations for all the receivers and the value of the internal calibration signal 
are recorded by tool serial number. This procedure is termed the shop or master calibration. At the well site 
the receiver zero signals and internal calibration signal are re-evaluated, and corrections made to reproduce 
the readings obtained during the shop calibration. In this way any changes in signal amplitudes due to 
electronic drift, differences in wireline and other factors may be minimized. 
The 3 ft receiver signal curve is calibrated to industry standard values. The sector signals are normalized to 
a given log amplitude during the shop calibration for calibration pipe diameter. When logging casing of other 
diameters the sector amplitudes are adjusted to produce the same log deflection and cement map 
appearance. 
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30.1 SDSTIP 

The gains and filters for the CSS tools should be setup as follows: 
From Acquisition Window Select ‘Edit/Device Configuration/SDSTIP’ 
For the CSSM 1 11/16” tool, with Short to medium lines the following values should be entered in the SDSTIP 
Panel. 
 

 
FIG: 30.1SDS Tool Interface Panel Configurations 1 11/16 Short to Medium Lines 

The Gains set the maximum gain for the Panel Control Slider bars and should be set to give a usable range 
for the slider bars depending on line length and tool signal. 
The Sonic line is for the Sonic signal. 
The Sync line is for the Sync signal. 
The Aux line is for the Telemetry signal.  
The FC is the frequency of the signal being detected.  The Q is the sharpness of the filter, the higher the Q 
the sharper the cutoff frequency. Band Pass or High Pass is the type filter used. Newer panels have 
enhanced telemetry filtering of the AUX channel that allow up to 8 filter options checkboxes selectable. 
 



The FC for the Sonic Line should be set for the frequency of the sonic receiver crystals, with a Band Pass 
Filter. 
The FC for the Sync Line usually works best with a low Q and Low FC, with a High Pass Filter. 
The FC for the Aux Line has been tested for short to medium lines and medium to long lines and should be 
entered as shown. 
For the CSSM 1 11/16” tool, with medium to long lines the following values should be entered in the SDSTIP 
Panel. 

 

FIG: 30.2 SDS Tool Interface Panel Configurations 1 11/16 Medium to Long Lines 

For the CSSM 3 1/8” tool, with short to medium lines the following values should be entered in the SDSTIP 
Panel. 
 

 
FIG: 30.3 SDS Tool Interface Panel Configurations 3 1/8 Short to Medium Lines 

For the CSSM 3 1/8” tool, with medium to long lines the following values should be entered in the SDSTIP 
Panel. 
 



 
FIG: 30.4 SDS Tool Interface Panel Configurations 3 1/8 Medium to Long Lines 

These values are not set and stone and may have to be tweaked for individual situations. 

30.2 Acquisition 

After starting Acquisition, the first step when running a Bond Tool of any type on Warrior will be to set the 
proper casing size. This will ensure that the gates will default to the correct saved settings. 
 

30.2.1 Edit 
Click on the Edit menu box of the Warrior Logging System menu box and scroll down to and select Variables. 
 

30.2.2 Variables 
Displays the Variable (parameter) editor window, enabling depth dependent parameters associated with the 
selected service to be zoned and values to be set. 

 
FIG: 30.5 SDS Variables 

Check the proper Casing OD under CASEOD. If you are outputting a Bond Index curve, enter the Minimum 
and Maximum Amplitudes. Enter any other variables that may be required. Then push the Accept button. 
The Minimum and Maximum Amplitude values are used for calculating the Bond Index Curve. Of these 

values the MINAMPL will have the greatest impact upon the calculations. The proper 
values are listed in Appendix A. Also, the MINATTN value is typical for most standard 
casings. 

 

30.2.3 Edit Logging Services Details 
From the Warrior Logging System menu box, click on Services and select the proper service for the tool type. 
Tools have different telemetry schemes and the services must be set up to match the telemetry. 
 

30.2.4 Edit logging Tools details 
When the Service is selected the Edit Tool string Window will come up automatically. Or, select Edit and Tool 
String, to display the following window: 



 
FIG: 30.6 Tool string 

From this window it is possible to change the tool being run, the order of the tools in the string, and add or 
delete centralizers, weight bars, knuckle joints or other tool string components. It is from the information set 
in this window that the calibrations, default offsets and filters settings for the log to be run are derived. 
 

30.2.5 Tool String 
Depth offsets that were derived from the Edit - Tool String step may be viewed by choosing Edit - Sensors, 
to display the following window: 



 
FIG: 30.7 Edit Sensors 

These offsets may be edited from this window, by double clicking on a sensor. The information in this window 
normally consists of the hardware source of the sensor (Device and Channel number), the depth offset of 
the sensor from tool zero reference, and the sampling rate. 
The information contained in Edit Sensors is defaulted to the current service and current tool string 
information. For example, sensor depth offsets are derived from the selected tool string and the information 
contained in the tools database. The default sample rates and device channel assignments are derived from 
the services file. The default device and channel settings, and the default sample rates are contained in the 
services.ini file. The default depth offsets are derived from tool information contained in the tools.ini file. 
Sensors cannot be modified while in a record mode. 

It is important to know that no permanent changes are saved from this window. If you 
change anything in the Edit Tool String window and save them, any changes under Edit 
Sensors will be deleted when the service is closed. If you must edit offsets in the Edit 
Sensor window the Tool.ini file should be modified. 

 

30.2.6 Power Up 
Power up the tool string. (Nominally 125V at the STIP) 
Adjusting the sync. Start by turning the Panel Control ‘Sync’ slider bar all the way down.  Monitor the 
Waveform Window and slowly raise the Slider Bar.  In the Waveform Window you will see the 0/s changes 
to typically 3/s or 4/s on the 1 11/16” tool and 7/s or 8/s for the 3 1/8” tool.  At this point the waveforms are 
synced. The PMON Window is used to adjust the telemetry thresholds. (This window will be hidden behind 
the Waveform window and must be brought to the front.) On the PMON Window the left arrow adjusts the 
positive threshold and the right arrow the negative threshold. 
Adjusting CSS Telemetry sync. While looking at the PMON window, adjust the positive (+) and negative (-) 
thresholds to about 50%.  Adjust the Panel Control ‘AUX’ Slider to adjust the height of the digital signal, until 
the pulses are just below saturation  



 
FIG: 30.8 Tel threshold 

The PMON discriminator values will be what is saved in the ‘Source/Save Setup’ for this 
service. Options - View Axis Scaling may be used to more accurately set these values. 
This window is digital. The screen will not update until waveform sync is established. 
Select Source/Save Setup to retain these values for your next log. 

 

30.2.7 Telemetry 
Verifying Telemetry Data: 
From Warrior Acquisition Window -Select Monitor/ Devices/ DSP: 

 
FIG: 30.9 Devices 

Values for CSSM 3 1/8” Radial Bond Tool 



 
FIG: 30.10 Devices List 

The above values are very close to what the tool normally reads.  Monitor TEL5-CCL, TEL7-Cable head 
voltage and TEL8-Temperature for stable readings.  If necessary, adjust the positive threshold in the PMON 
window up or down to stabilize the readings. 
 

30.2.8 Monitoring Outputs. 
From Warrior Acquisition Window select Monitor /Outputs. An Outputs window will appear that allows you to 
monitor signals such as CCL, GR, and other sensors.  



 
FIG: 30.11 Outputs List 

Continue to Shop Calibration Section. 

30.3 Shop / Tank Calibration: 

Make up the tool with the centralizers and slide it into the tank. The tool should show signals on all the signals 
in the Waveform Window. 
 Bring the Waveform Window to the front. The gates appear on the waveforms as a white line on the section 
of the waveform where they are set.  
The gates can be changed on this window by clicking on the waveform that needs to be adjusted (note the 
dark border around the selected waveform) and then using the buttons in the top right corner of the Waveform 
Window. To move the gate right or left on the x-axis use the buttons labeled << to move it to the left or the 
button labeled >> to move the gate to the right. The width of the gate can be increased by selecting the < = 
> button and decreased by using the > - < button. 
Note: It is recommended that you keep all of your gate widths the same. Approximatly 30 micro-seconds 
works well with most tool types. 



Also, specific waveforms can be viewed by selecting Options – Enable, and selecting the waveforms that 
you want displayed. Reducing the number of waveforms gives you a screen that is easier to work with. 
Remember to click on the waveform before adjusting the gates. 
Before gating on the first arrival use the (‘BHC/CBL’ pot on the panel for CBL01-09 sytems) (Panel Control 
‘Sonic’ Slider Bar on CBLDR systems) to increase/decrease the signal. Make sure that none of the signals 
are saturated. (If you are going to be running logs in casing that is smaller than your calibration tank, be 
aware that the signals will be larger in smaller casings and decrease your signal to accomodate this.) 
Note: The signal height on the screen is not valid if you are in threshold mode. 
After all of the gates are set select Source – Save As.  Give this setup a name, such as ‘CSSM 1 11/16” Cal 
Tank Amplitudes.’  If there is a problem later the setting can be restored by selecting Source – Load and 
selcting that setup name. 
Note: The same can be done for settings on the PMON Window. 
 

AT THIS POINT YOU SHOULD HAVE YOUR GATE (WHITE LINE) ON ALL THE 
FIRST POSITVE ARRIVALS OF ALL THE SIGNALS BEING DISPLAYED. (The CAL 
pulse first arrival should be positive. If the first arrival is not positive, the polarity can be 
changed through Warrior/Utilities/Edit Logging Tool Details.) 

 
On the Waveform Window, select Source – Threshold Mode and use the UP/DOWN Arrows (Only on the 3 
ft and 5 ft display). To move the red threshold line to a suitable position where the threshold cuts the first 
arrival. Make sure it is far enough to avoid baseline noise (This may be above or below the baseline).  
Threshold Mode is only used to set the travel time thresholds.   
On the Waveform Window, select Source – Normal Mode. 
On the Acquisition Window select Action – Calibrate – Shop / Free Pipe Zero Cal. A window will appear to 
sample the base line noise. 

 
FIG: 30.12 Calibrate 



 

FIG: 30.13 Zero Baseline Calibration 

FIG: 30.14 Signals 

 



Make sure the gates for all signals are on the flat part of baseline before the first arrival.  These values will be 
updated when doing the well site air zero cal.   
Click on the <<sample button.  The Sample & Average Sensor(s) box will appear.  Click on the begin button.  
When the sample is complete, monitor the values they should be very close to zero.  If they are click the 
Accept button.  If the values are not close to zero, click the Reject button and correct the problem. 
 

 
FIG: 30.15 Sensors signals 

 
FIG: 30.16 Sensors Value signals 

 



The SCBL Zero Baseline Calibration box will appear check that the values are all close to zero and click 
Accept. 

 
FIG: 30.17 Zero Base line 

On the Acquisition Window select Action – Calibrate – Shop/Free Pipe Reference. The SCBL E1 Amplitude 
Calibration window will appear to sample the first arrival pipe amplitude.  The Free Pipe Millivolt of the casing 
you are sampling is in the cells at the top of the window. The Sector E1 amplitude is normally set to 100 or 
made to match the 3ft E1 amplitude. 
Note: If the value is not there or not correct check to see if the Casing OD and Maximum Amplitude were 
input in the Variables Window.  



 
FIG: 30.18 Pipe signal Calibration 

 
FIG: 30.19 Amplitude Calibration  
 



 
FIG: 30.20 Signals 

Make sure the gates for all signals are on the positive part of the first arrival.  Click on the <<sample button.  
The Sample & Average Sensor(s) box will appear. 

 
FIG: 30.21 Sample Signals 



Select <<Sample. After the sampling has finished select Accept. The calibration gains and offsets for each 
waveform are displayed. The offsets on all waveforms should be near zero. The gains should range from 20 
to150. Select OK. 

 
FIG: 30.22 Amplitude Calibration Results 

The SCBL E1 Amplitude Calibration window will appear with the raw voltage readings displayed.  Select 
Accept. 

 
FIG: 30.23 E1 Amplitude Calibration 

Note: If you need to make more than one calibration for each tool you must enter a different Serial Number. 
 



 Do not do a downhole cal with the same Serial Number because if you accept the cal 
and it is no good you will have over written the good shop cal, which can be utilized, if 
there is no Free Pipe found in the well. 

 
Note: To create In the Warrior Screen select Utilities – Edit Logging Tool details then click Edit Tool. A list 
will come up, select SCBL and enter the “alias” Serial Number which you will use to do other cals on the 
same tool without over writing the original. Then Click Create – Tool. Enter a new serial number. 
 

30.4 Wellsite Calibration Procedures: 

The GR can be calibrated like any other GR tool. Select Action – Calibrate – Gamma Ray. Follow the 
onscreen menu. 
 

30.4.1 SCBL Air Zero Cal. 
SCBL Air Zero Cal:  The following step is performed with the tool hanging in the air. On the Acquisition 
Window select Action/ Calibrate/SCBL Well Site Air Zero Cal.  The SCBL Air Zero Cal window will appear.   

 
FIG: 30.24 Air Zero calibration 

 
FIG: 30.25 Air Zero calibration 



Ensure the gates are set in the proper position for the size pipe to be logged select <<Sample.  The Sample 
& Average Sensor(s) box will appear.  Select Begin. 

 
FIG: 30.26 Air Zero Values 

All the values should be close to zero, and are used to establish the offset to be applied to  
the primary gain and offset established in the Shop Calibration.  Select Accept. 
Select Accept in the SCBL Air Zero Cal Window. 

 
FIG: 30.27 Air Zero reading 

30.4.2 SCBL Wellsite Internal Ref Cal 

 
SCBL Wellsite Internal Ref Cal:  The following step should be performed down hole. The CAL pulse is 
recalibrated to compensate for line resistance and temperature.  The new values are used to normalize all 
waveform amplitude values back to the shop calibration.   



On the Acquisition Window select Action/ Calibrate/ Well Site Internal Ref Cal.  The SCBL Internal Reference 
Cal window will appear  

 
FIG: 30.28 Wellsite Internal Calibration 

 
FIG: 30.29 Internal Reference Calibration 



 
FIG: 30.30 Zero Reference 

 
FIG: 30.31 Gain and Offset 

Move the gate in the WVFCAL Signal window to the flat part of the baseline in front of the first positive arrival.  
Select <<Sample on the Reading of Ref Baseline.  The Sample & Average Sensor(s) window will appear. 



 
FIG: 30.32 Signal calibration reference 

 
FIG: 30.33 Calibration  value  

Select Begin the values should be very close to zero.  Select Accept. 
Move the gate in the WVFCAL Signal window to gate the first positive arrival.  Select <<Sample on the 
Reading of Ref Maximum.  The Sample & Average Sensor(s) window will appear. 

 
FIG: 30.34 Signal Reference Maximum value  



 
FIG: 30.35 Reference Maximum value  

Select <<Begin on the Sample & Average Sensor(s).  Select Accept.  A gain and offset value will be shown 
in the SCBL Internal Reference Cal window. The gain should be very close to 1.0 and the offset value will be 
very close to 0. If they are not, redo your calibrations to ensure that the correct voltage is set for the WVFCAL 
and the gate was set in the proper position for each reading.  Select Accept in the SCBL internal Reference 
Cal window. 

 
FIG: 30.36 Reference Maximum value  

Go in the hole monitoring the various waveforms as shown below. Ensure that the gates are over the first 
positive signal and that the relative positions of the gates are correct. The gate for the 5ft receiver should be 
approximately 114 microseconds later in time than the 3ft. The various sector gates should be approximately 
57 microseconds earlier in time than the 3ft (for a 2 foot sector spacing). 



FIG: 30.37 Signals 
 
All waveforms may be shown by selecting Options - Enable from the waveform window. 
After the gates are adjusted, open the Monitor -Outputs Window and monitor the various outputs. 
All the sector gates can be adjusted simultaneously if they are tethered. To tether the sectors, click on a 
sector window and then click on the tethering button.  

  
FIG: 30.38 Tethering Sector Signals 

 



 
FIG: 30.39 Outputs 

The maximum of the 3ft and sector outputs should be approximately those shown in appendix I for a given 
size casing. The minimum values in bonded casing should also match the indicated values. Sector values 
will tend to be slightly above indicated values in bonded pipe.  
 

30.4.3 Setting Travel Time: 
While monitoring the 3ft Waveform, choose Source - Threshold Setup Mode. Using the right hand scroll bar 
to set the Threshold Setting. The Travel Time should read within 10 microseconds of the value listed in 
Appendix I. This threshold should be kept as close to the baseline as possible without the threshold picking 
up baseline noise and triggering early. 
 
 
 
 



30.5 Running the Log:  

1 11/16” CSSM Radial Bond Tool 
CCL Calibrations –  Gain = 0.1       Offset = -12.8 
Temp Calibrations - Gain =1.8  Offset = 32 
3 1/8” CSSM Radial Bond Tool 
CCL Calibrations –  Gain = 0.0005  Offset = -3.7 
Temp Calibrations - Gain =0.02  Offset = 0 
An example Radial Bond presentation is shown below.  

 
FIG: 30.40 Log 

The additional Radial Bond presentation is shown below. This presentation shows the eight sector readings 
and the waveforms of each as a signature presentation. 



 
FIG: 30.41 Log Additional Radial Bond Presentation with Cement Map 

 
FIG: 30.42 Presentation Options 



 

FIG: 30.43 Bond Log with 3D presentation and BH Image 

 

The Presentation may be changed by clicking on Options in the Interactive Plot Window. This brings up the 
window shown below. Either browse to select the presentation required or edit the presentation name to the 
desired presentation. 
Under Plot Job Editor, calling up Single Log pass will bring up a similar window. Editing the Format field will 
allow you to show the same pass, using different presentations. 
Note: This same window allows you to show the same pass with different logging scales. 
Note: Annotations must be made from the Interactive Replay Window for each presentation, as the 
annotations will not be transferred from one presentation to another. 

 
FIG: 30.44 Presentation Options Type 

 
 
 



 
 
 
 
 

APPENDIX A Pipe Weight and Id 

 
 
 
 

PIPE  1 11/16” RCBS 3 1/8” RCBL 

 OD   WEIGHT   ID  RADIAL 3 FT 5 FT RADIAL 3 FT 5 FT 

2.875 6.500 2.441 128 204 318    

 7.900 2.323 126 202 316    

 8.700 2.259 125 201 315    

 9.500 2.195 123 199 313    

 10.700 2.091 121 197 311    

 11.000 2.065 121 197 311    

3.500 9.300 2.992 139 215 329    

 10.300 2.922 138 214 328    

 12.800 2.764 135 211 325    

 12.950 2.750 134 210 324    

 15.800 2.548 130 206 320    

 16.700 2.480 129 205 319    

4.000 11.850 3.476 149 225 339    

 14.000 3.340 146 222 336    

4.500 9.500 4.090 161 237 351 151 208 322 

 10.500 4.052 160 236 350 150 207 321 

 11.600 4.000 159 235 349 149 206 320 

 13.500 3.920 157 233 347 148 205 319 

 15.100 3.826 155 231 345 146 203 317 

5.000 11.500 4.560 170 246 360 160 217 331 

 13.000 4.494 169 245 359 159 216 330 

 15.000 4.408 167 243 357 157 214 328 

 18.000 4.276 164 240 354 155 212 326 

 20.300 4.184 162 238 352 153 210 324 

 23.200 4.044 160 236 350 150 207 321 

 24.200 4.000 159 235 349 149 206 320 

5.500 13.000 5.044 179 255 369 170 227 341 

 14.000 5.012 179 255 369 169 226 340 

 15.500 4.950 177 253 367 168 225 339 

 17.000 4.892 176 252 366 167 224 338 



 20.000 4.778 174 250 364 165 222 336 

 23.000 4.670 172 248 362 163 220 334 

 26.000 4.548 170 246 360 160 217 331 

6.000 15.000 5.524 189 265 379 179 236 350 

 18.000 5.424 187 263 377 177 234 348 

 20.000 5.352 185 261 375 176 233 347 

 23.000 5.240 183 259 373 174 231 345 

 26.000 5.132 181 257 371 172 229 343 

6.625 17.000 6.135 201 277 391 191 248 362 

 20.000 6.047 199 275 389 190 247 361 

 24.000 5.921 197 273 387 187 244 358 

 28.000 5.791 194 270 384 185 242 356 

 32.000 5.675 192 268 382 182 239 353 

7.000 17.000 6.538 209 285 399 199 256 370 

 20.000 6.456 207 283 397 198 255 369 

 23.000 6.366 205 281 395 196 253 367 

 26.000 6.276 203 279 393 194 251 365 

 29.000 6.184 202 278 392 192 249 363 

 32.000 6.094 200 276 390 190 247 361 

 35.000 6.004 198 274 388 189 246 360 

 38.000 5.920 196 272 386 187 244 358 

7.625 20.000 7.125    211 268 382 

 24.000 7.025    209 266 380 

 26.400 6.969    208 265 379 

 29.700 6.875    206 263 377 

 33.700 6.765    204 261 375 

 39.000 6.625    201 258 372 

 45.300 6.435    197 254 368 

8.625 24.000 8.097    230 287 401 

 28.000 8.017    228 285 399 

 32.000 7.921    226 283 397 

 36.000 7.825    224 281 395 

 40.000 7.725    222 279 393 

 44.000 7.625    220 277 391 

 49.000 7.511    218 275 389 

9.625 29.300 9.063    249 306 420 

 32.300 9.001    247 304 418 

 36.000 8.921    246 303 417 

 40.000 8.835    244 301 415 

 43.500 8.755    243 300 414 

 47.000 8.681    241 298 412 

 53.500 8.535    238 295 409 

 58.400 8.435    236 293 407 

 61.100 8.375    235 292 406 

 71.800 8.125    230 287 401 



 

APPENDIX B-Sector Map 

30.6 Map 

30.6.1 Introduction 
The heart of the Radial Bond Tool is the segmented crystal found below the transmitter. This crystal is 
cylindrical in shape. It is divided into 6 or 8 segments, each of which covers a section of the well bore.  

 
FIG: 30.39 Sector Map 

30.6.2 The Calibration Procedure 
When the Radial Bond Tool is calibrated, the sonde section is rigidly centralized in a 5-1/2” calibration 
chamber and the chamber is pressured up to 500 lbs. of water pressure. The tool is powered up and the 
calibration signal is set to a reference voltage, using pots within the electronics section of the tool. Gates are 
then set over E1 of the 3ft, 5ft,  and each of the segmented crystals. Each of these signals is then set to 1 
Volt, again using pots within the electronics section. 
Using the SCBL Shop/Free Pipe Calibration routine, the tool is then calibrated so that each of the signals 
reads 100 millivolts within the test chamber. Then, the test chamber is depressurized, and the tool is rotated 
180 degrees. The test chamber is again pressurized, and the calibrations are checked again to assure that 
the tool was properly centralized during the calibration procedure. 
NOTE: While it is true that the expected amplitude reading for the 3ft receiver in 5-1/2” casing is 72 millivolts, 
that is the expected reading with pressurized water on the backside of the casing. The presence of air on the 
backside allows the test chamber to vibrate more freely than 5-1/2” casing. The expected readings of the 3ft 
in various sizes of pipe, are based upon a tool calibrated to 100 millivolts in a 5-1/2” test chamber with air on 
the backside. 
 

30.6.3 The Radial Readings 

 



FIG: 30.43 Radial Readings 

With the Shop Calibration recorded in the Tools.ini file, all that is left for the Engineer to do at the well site, is 
to perform the SCBL Wellsite Internal Reference Cal and the SCBL Air Zero Cal. These calibrations generate 
a secondary Gain and Offset that are applied to readings from the SCBL outputs before they are plotted and 
recorded. These secondary calibrations are identified by WS_ and are listed directly under the curve to which 
they are applied. 
When the SCBL Internal Reference Calibration is performed, the High and Lo Read of the AMPCAL from 
the Shop Calibration are used as the Hi and Lo Ref for the WS_CAL and the Calibration Signal is calibrated 
back to the readings taken during the Shop Calibration. The Gain derived from this calibration is then applied 
to ALL the Bond curves. This calibration adjusts the Warrior Logging System for differences in line length 
and variations in CBL/BHC Signal gains. 
When the SCBL Air Zero Cal is performed, the gates of all the bond signals are set to their approximate 
values for the casing size anticipated by choosing the appropriate Setup (under Load Setup), while to tool is 
in air. This calibration generates the secondary calibration offset, which is applied to each of the Bond curves 
individually.  
When using Shop Calibrations for logging, both calibrations must be done before going in the hole. If, for 
some reason a Wellsite Calibration is performed, there is no need to perform these two additional calibrations. 
Wellsite calibrations are not recommended except under unusual situations. 
 

30.6.4 The Cement Map 
The Cement Map is a graphical representation of the response of the sector measurements. The shading of 
the cement map is purely representative of the recorded amplitude readings from the various sectors. Look 
back to the representation of the segmented crystal shown at the beginning of this bulletin, and visualize the 
sectors laid out horizontally. 

 
FIG: 30.44 Cement Map 

Each of the individual sectors is represented by a section of the cement map, as shown below. The shade 
applied to each section of the map is a function of the amplitude of that sector as recorded. 
The Warrior Logging System uses an algorithm to determine the shading associated with the amplitude 
recorded, based on several factors. These factors include: 
The number of grayscales and the density of the grayscales in the Cement Map, as applied in the screen 
and printer setup within the Warrior.ini file. 
The Filter level associated with each of the Sector Curves. 
The amplitude reading of adjacent sectors. 
The High Reference recorded in the Shop Calibration associated with each Sector Curve. 
The Black and White values set in the presentation file. 



 
FIG: 30.45 Sectors 

The only factor under control of the engineer is the Black and White values within the presentation file. The 
purpose of the Cement Map is to graphically illustrate small channels that may pose a problem. With that end 
in mind, the following is the proscribed setup for the Cement Map. 
With the Black and White Levels set as above, the grays scales of the Cement Map will change as follows: 
1. Amplitudes less than 10mv     Black 
2. Amplitudes greater than 10.0mv and less than 26.7mv  Dark Gray 
3. Amplitudes greater than 26.7mv and less than 43.3mv  Medium Gray 
4. Amplitudes greater than 43.3mv and less than 60.0mv  Light Gray 
5. Amplitudes greater than 60.0mv     White 
If different gray scales are needed for an application, contact Technical Support. 
 

30.6.5 Logging Conditions 
The Cement Map is a visual representation of the cement conditions behind the pipe. The Sector Crystal is 
not free to rotate within the tool, and the cement and casing are not free to rotate. However, the tool itself is 
free to rotate with the well, and it is expected that it will. For this reason, apparent “channels” may rotate within 
the cement map while running repeats, and that the Cement Map may not repeat exactly. 
The Cement Map also becomes an important aid to quickly identify problems in tool setup or logging 
procedures. 
 



 

 

31 Ultrawire Memlog Chart 

31.1 Updating Warrior V7.00 

Run the self-extracting Warrior Updates executable. 
Add the following entry to Warrior.ini (found in the Warrior Config directory or use the shortcut in Sondex 
Utilities). 
In the Device Alias section add UWD=UWMEMORY 
[Device Alias] 
UWD=UWMEMORY 
Next import the new UW memory tools using the Warrior tool editor (found in Utilities). 
In the Calibration select Restore and select MBH025.wcf, UMT003.wcf, MITUW.wcf, PRC034.wcf, 
PRC057.wcf in turn. This imports the Memory Battery Holder, Ultrawire memory tool, Ultrawire MIT and 2 
new centralizers. 
Now add the new Ultrawire memory services. In the Service Editor (Utilities) import UMT Services.wsv which 
contains all 4 memory services. 

31.2 Update MCU driver 

Uninstall the current MCU device driver (using the Device Manager) and reinstall the latest MCU driver 
(SXMCULDR.SYS). The version required is V1,0,0,6 or greater. 

31.3  Update UMT firmware 

Open Ultrawire Memlog, select the Diagnostic menu and click on Upload new firmware. Select the latest 
firmware file (XXXX.bin) and if the UMT is connected to the MCU the new firmware is uploaded. 

31.4 Using Ultrawire Memlog 

Setting up the Service (tool string). 
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All service information is set up in Warrior. In Warrior Acquisition select the required Memory Service (i.e. 
Ultrawire Memory MIT). Make up the tool string, and at this point it is possible to perform all the calibrations 
using an XTU. 
Next, if required set up the zoned variables in Warrior. 
Once the service information is complete then UW Memlog can be used. 
 

LEAVE WARRIOR RUNNING, DO NOT CLOSE UNTIL YOU HAVE FINISHED USING 
UW MEMLOG! 
 

31.4.1 Open UW Memlog  
The first thing that must be done is to set up the DPT Settings. In the Edit menu select Edit DPT Settings, the 
options in this window must match those on the DTR or UW Memlog will not output the correct depth units! 
Create a new project (File menu, or toolbar), the user is then prompted to create the project files. Only do this 
if the service has been completely set up in Warrior. 
UW Memlog takes all the service information from Warrior (tool string, telemetry information etc.) and creates 
the Project.ini and the Service.ini in the project directory. It also copies any calibration files in Warrior to the 
Project directory. They are not used by UW Memlog but are a useful archive. 
Next import the zoned variables from Warrior. In the UW Memlog File menu select Create Variables 
database. This takes the zoned variable information and places it in the Project directory (vars.db). 
 

31.4.2 Create the Profile 
The profile editor is slightly modified from the previous version of Memlog. It is now possible to sample any 
tool, at any rate (within reason). For each profile line a tool can be sampled at a different rate. 
The first difference is that a start time for the profile line is NOT entered; this has been changed to the length 
of the profile in seconds. 
The second major change is the profile type. There are 4 options, LOG, OPEN, CLOSE and SLEEP. 
LOG is the default and will record all the tools at the selected sample rates. 
OPEN and CLOSE can only be used on tools with motorized arms. (i.e. MIT). It is recommended that each 
OPEN and CLOSE profile be 3 minutes in length to allow the tool to fully open and close. 
Note when an OPEN or CLOSE profile type is selected the tool to be opened\closed must also be selected 
in the rate window. The drop down list will now contain OPEN or CLOSE rather than sample rates. 
NOTE: Only one tool can be opened or closed in a single profile! 
NOTE: During an open or close no other tools can be sampled. 
I recommend that a LOG profile precedes each open or close profile type. 
The amount of memory being used can be seen at the bottom of the window. Make sure this does NOT 
exceed your memory limit. 
If an MIT is in the service, there will be two memory usage values. Click on the Details… button and select 
the MIT compression rate to view the true memory used. 
Save the profile. 
 

31.4.3 Programming the tool 
Assemble the tool string and attach to the MCU etc. 
If an MIT is in the tool string, then before programming the tool, the COMPRESSION MODE must be set. 
Enter Command mode in UW Memlog (toolbar option), once the Command window is loaded, using Warrior 
select the MIT Tool Configuration window and select the Sample Options button. 
The following options should selected and sent to the MIT. 
Compression Mode = Absolute (12 bit), although this is a user choice. 
Sample Type= On Demand 
Sample Rate = 20 or 50 ms (again a user choice). 
Send the command to the MIT, if the command is sent successfully the Command window will increment the 
command and response counters. 
NOTE: If testing in the shop it might be worth changing the Memory size to 2MB prior to programming the 

tool (Edit menu). This will save time but REMEMBER TO CORRECT IT BEFORE GOING ON A JOB. 
Program the tool using the toolbar option. 
Monitoring the tool, or run the job 



To monitor the tool, select the Monitor toolbar option (Warrior MUST be open with the correct service). The 
Monitor window outputs the MCU voltage, but the tool readings are sent directly to Warrior and can be view 
in Warrior in the View Outputs window. 
As UW Memlog is transmitting the data directly to Warrior, the calibrations can be performed if required. Use 
the standard Warrior calibration routines. 
Remember if you perform a new calibration it is recommended that you recreate the UW Memlog project 
files. 
 

31.4.4 Download the tool 
Download the tool using the toolbar option. It is recommended that all the errors are viewed, and the user 
look at the UWstats text file. It will report any errors on each of the UW addresses and is a useful diagnostic 
tool. 
 

31.4.5 Visual Merge the depth and tool data 
Note: I have not gone into the DTR download and setup as this is identical to the old Memlog. 
Visual Merge is also pretty much the same as the previous version, although UW Memlog only uses raw 
memory data, so the plotted data is all raw values. 
The depth and tool data should be tied-in as usual and all passes picked and saved to file. 
 

31.4.6 Output passes 
UW Memlog now only outputs directly to Warrior. Select the passes to output to Warrior and select the options 
for time based outputs (i.e. fast or slow sampling). 
Output the passes, you are prompted for a Warrior database name. Make sure you do not attempt to over 
write a previously created database. You can append to an existing database, but the pass names must be 
different. 
 

31.4.7 Recalculating the raw UW Memlog data and creating the curves 
UW Memlog outputs a raw data dump into the Warrior database. To extract the curves and apply the 
calibrations Warrior Recalculation must be used. 
Open Warrior Recalculation and select the database you have just output from UW Memlog. Enter a name 
for the recalculated pass and select OK. 
At this point, if an MIT or CAT is in the tool string the user is prompted to use either current or embedded 
calibration files. I recommend using the current files (taken from the Warrior database). 
Next it is possible to configure the tools, i.e. for the MIT the user can select whether to centralize or 
temperature-compensate the data. The zoned variables can also be altered at this point. 
Now select the maximum speed option and the calibrated curve data is plotted and is ready to use. 
It is possible to recalculate the raw data as often as necessary should any changes need to be made. 
 

31.4.8 Extras 
There is a Calibration Pass option in UW Memlog; this can be found on the tool bar. This looks like the Visual 
Merge window and you select a calibration pass in the same way you would pick a log pass. Once a 
calibration pass is selected it can be sent to Warrior using the option in the File menu. 
If calibration data has been recorded to memory this is the way to pass it to Warrior. 
When the data is being passed to Warrior a cursor scrolls across the screen to show which data is being 
sent. In the Warrior Output Monitors the user can view the data, and the calibrations can be performed in the 
standard way. 
Remember after performing calibrations it is recommended the service information in the UW Memlog project 
be updated. 
 
 
 
 
 
 
 



 
 
 
 



32 Noise Log 

32.1 Services - Noise Survey 

The signals from the noise tool are conditioned by filters and amplifiers on the ANASW board and routed to 
the AUDIO board. The AUDIO board produces 4 separate signals that are then sent to the DSPAUX and 
DSP for digitizing. The signal is amplified by the 4 stages of the Audio board so that each output is gained 
up by a factor of ten from the previous stage. The Warrior software examines the 4 signals and chooses the 
signal that is not saturated and with enough signal strength to analyze.  This signal is digitally filtered in the 
computer and divided into the conventional frequency components. The frequency spectrum and raw and 
filtered signals may be monitored on the computer screen. Several samples may be averaged to produce a 
station reading for a given depth. The averaged frequency spectrum may be monitored on the computer 
screen. 
 
Start the service from Services in the normal manner and power the downhole tool. A raw data monitor 
window is presented which has four signal displays corresponding to the conventional four peak to peak 
voltage ranges. 
 

 
FIG: 32.1 Range Signals 
 
The usual range of options associated with waveform monitors is available for this display. During operation 
the system automatically selects the most appropriate range for data collection. 
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The system also displays a window displaying the processed waveforms and frequency spectra. The survey 
is also controlled from this window. The settings that are used for sampling stations are controlled by clicking 
the [Settings] button. There is also a “Record Soundfile” checkbox that when checked will make a WAV 
recording after the data has been sampled. 
 

  
 
 
FIG: 32.2 Noise Logging Control 

32.2 To run the survey 

Click on the [Start Sampling] button and signals should appear in the various windows. To record a station, 
click on the [Record Station] button. With the parameters shown the system will take ten one second samples, 
average the results and record them as a depth station in a survey table.  



To view the survey table, click on the [Survey Manager] button. As each depth station is recorded the results 
are entered the survey table as shown. 
 

 
FIG: 32.3 Survey Manager 

After all stations have been recorded the survey may be output as log curves and/or tabular results. If there 
are stations which need to be excluded from the results this may be achieved by selecting the station in the 
survey table (by clicking anywhere in its line) and then clicking the Disabled box as shown below. 
 

 
FIG: 32.4 Edit Survey Station 



Clicking on the Generate button and Depth Log displays the window shown below. 
 

 
 
 
FIG: 32.5 Depth Log Format 

The cryptic Dataset entry simply indicates what the resulting merged and interpolated log will be called. If a 
logarithmic display of the data is required, then the Logarithmic Interpolation box must be checked. In this 
case the log presentation used must specify a logarithmic grid and a logarithmic curve. 
Note that other curves e.g. CCL, may be easily merged with the noise curves using the Auto Merge feature. 
Clicking the Add button displays a list of the other curves present in the current database. At present it is not 
possible to merge curves from other databases by this method. Aliasing may be used to achieve this if 
required. 

 
FIG: 32.6 Select Data set Auto merge 



 
Fig. 32.7 Curves added to Depth pass to be generated 
 
Double click on the curve(s) to be merged with the noise data. To generate the merged presentation, click 
on the OK button and the merged log will be displayed on the screen. With long log intervals this may take 
several seconds.  
Note that a merged presentation may be generated at any time in order to monitor the progress of the survey, 
e.g. after each depth station if required. 
For final presentation a tabular output of the survey table may be added to log grid presentation when 
assembling the final plot using the Plot Job Editor. 
 

 
Fig. 32.8 Example Noise Log output 



 



 

 

33 Pulse Interface Panel 

 
Pulse Interface Panel  
(PIP System) Operating Procedures 
 The Pulse Interface panel has much of the same functionality of a standard panel but is limited to 
being able to process one positive pulse, one negative pulse, and an analog CCL. While the standard 
interface panel has a digital signal processor capable of digitizing and displaying line signals for visually 
adjusting pulse discriminators, the PIP does not have these capabilities.  
 The Pulse Interface Panel has peak detection circuitry. What is shown in the CYPIP Configuration 
Pulse Control window is a representation of the positive and negative peaks that are being detected, not the 
actual pulses. The Pulse Gain in the Panel Controls window should be adjusted so that the peaks of the 
pulses are in the window, but large enough to allow easy discrimination. The peak detection circuitry has a 
very long time constant. Thus, when adjusting the panel controls Pulse Gain to set the pulse height in the 
“pulse” window, allow enough time for the detected pulse peaks to respond. 
Fig 33.1 Panel Controls 
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Discrimination of pulse is accomplished through hardware comparators and counters. Since the peak signal 
levels have been detected by the hardware, the software can set the discrimination levels for the pulses to 
be a percentage of the peak level. This is accomplished by checking the “Auto” box in the Pulse Control 
window and setting the percentage in the “%” box.  
The alternative method of setting the discriminator levels is by manual control. If the “Auto” box is not checked, 
then the slider bars to each side of the “pulse” window control the discrimination levels that are sent to the 
comparators. 
Another difference in the Pulse Interface Panel and a standard panel is the way that periodic pulses are 
handled. Periodic pulses are pulse that have essentially the same time between pulses though the time 
between pulses may vary. If only pulses are counted there is always a variance of + 1 count per second. 
These are tools such as temperatures and calipers.  
In the standard panel with the appropriate DSP script, essentially the time between pulses is measured. This 
time is then converted to counts per second with fractional accuracy. The pulse interface panel has phase 
locked loop voltage controled oscillator circuits to multiple the number of counts by a scalar set in the 
hardware and confirmed in the software. After the pulses are counted, the software divides the scalar back 
out to give fractional counts per second to increase accuracy. 
To implement whether the raw counts or the counts from the PLL are used, the services.ini file needs to be 
modified through the Service Editor. Go to the Service Editor and click on the service that will have periodic 
pulses. In the Devices section, after the Base device, you can add either multiply+, multiply-, or both as shown 
below to choose which pulse or pulses you wish to process as a periodic measurement. DO NOT use this 
method with random or non-periodic pulses as this will cause drastically incorrects counts for that sensor. 
 

 
Fig 33.2 Service Editor for Periodic Pulse 

 
 



34 SERMON and ASCTEL 

 The Warrior software can send any data output through a COM Port as serial ASCII data so that the 
information that can then be made available to external computers or displays by use of the SERMON device 
module. ASCII data may also be imported through the ASCTEL device module to use as any sensor data 
input. 

34.1 Sermon Device 

 To export serial data through Sermon, in the Database Utilities, click on [Edit Logging Service 
Details] to bring up the Service Editor. The current software supports two Sermon outputs, Sermon and 
Sermon2. In any service that the User desires, a new device can be added. 
The example shown in Fig. 34.1 shows a typical Sermon device setup. Note that the 10 that would usually 
be the maximum rate of the device, is only a place holder. The output rate is set up in the Device configuration. 
 

 
Fig 34.1 Sermon Device outputting Depth, Tool Voltage, and Elapsed Time 

 Often when the service with the Sermon outputs is first loaded, an error message will appear that 
indicates that Sermon failed to open a COM port. The COM port first must be configured by clicking on Edit 
-> Device Configuration -> Sermon from the Acquisition window. There are drop down lists to choose from 
the available Com Ports that the software has found on the computer and to select the transmission baud 
rate. There are several different types of serial outputs that can be chosen with standard being the most 
commonly used. Normally the continuous box is checked to have data continuously sent out. The rate is 
determined by the Repeat setting with 100 being 10 times per second and 10000 being once every 10 
seconds. 

  
 
Fig 34.2 Sermon port failed to initialize and Sermon COM port settings. 
 



34.2 ASCTEL Device 

 
 The ASCTEL device allows the User to bring in serial ASCII data and assign it as a sensor data 
source. Up to 10 sensors may be brought in through the ASCTEL device. The current software supports 
two ASTEL inputs, ASCTEL and ASCTEL2. The ASCTEL device has several additional parameters in the 
declaration. The third parameter in the declaration is the format of the data coming from the COM port (ifs is 
shown in fig. 43.3). The fourth parameter allows the User to specify the number of data inputs received by 
the ASCTEL device (shown as “n=8” for 8 inputs). You can send receive depth via ASCTEL by adding 
depth to the command line. 

 
Fig. 34.3 ASCTEL entered as a device in the Service Editor 
 

Like Sermon, the ASCTEL device can be configured by entering the service and Edit -> Device 
Configuration -> ASCTEL. The User can select from a dropdown list of available import types, select the 
COM Port, and a timeout period  
 

 
Fig. 34.4 ASCTEL COM Port settings and Monitor -> Device -> ASCTEL 
 

Any tool sensor may now use the ASCTEL inputs as sensor data. The sensor references the device 
and the device channel in the normal manner. The sensor must be a valid sensor from a tool in the tool 
string to be available. 

 
Fig. 34.5 WHP1 sensor from ASCTEL Device channel 1 
 
 
 
 
 



 
 
 
 
 
For CPFF panels there are two 9 pin RS232 ports on the rear plate and two RS485 ports “ both of 

these are on the same 9 pin connector.  
The ports appear as: 

  WWSA_STIP_A  Bottom RS232 
    WWSA_STIP_B  1st RS485 pins 1&2 

WWSA_STIP_C  Top RS232 
    WWSA_STIP_D  2nd RS485 pins 6&7 
 

  



 

Appendix 
 

Appendix 1 Requirements for Addressable Switches 
 

 

Required wiring for TELA HR5 

CC1-11 to CC14-35 

If wire present from CC13-36 to CC14-35 it may be removed. 

CC1-16 to CC6-16 

CC1-17 to CC6-17 

Recommended ANASW R15 or R16 Mod 

 

Apendix  1.0.1 ANASW R15 or R16 
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